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Introduction to Policy Commander 

Welcome to Policy Commander 

Welcome to Policy Commander® — your command center for managing computer security 
policies. 

Policy Commander improves organizational accountability and helps you secure your enterprise 
network by automating implementation and enforcement of security policies on Windows 
computers. It continuously monitors the state of computers on the network, delivering detailed, 
real-time insight into the state of security policy compliance. Policy Commander remediates non-
compliant computers to ensure continuous security policy enforcement, and significantly reduces 
the time and resources needed to create, test, and implement any security policy for any 
Windows-based server or workstation. 

With Policy Commander, security policy compliance information can be summarized in a 
dashboard view, or presented in detail for system administrators. Policy Commander 
automatically alerts users via email when a computer is out of compliance, and can automatically 
remediate non-compliant systems. 

Policy Commander lets administrators define the role and security level of a computer and 
automatically applies the appropriate security policies for its role and security level. Policy 
Commander maintains security policies in a central location and provides a browser-based 
console for centralized administration. Policy Commander delivers a library of security policies 
based on templates from Microsoft and leading IT security organizations. With Policy 
Commander, you can also add your own policies and customize existing ones to accommodate 
your network infrastructure and organizational security needs. 
  

Components of Policy Commander 

An administrator uses Policy Commander to enforce security policies on managed computers. 
Policy Commander is made up of the following components: 

 Console - The Console is your command center for monitoring compliance and for 
setting up, enforcing, and managing policies and computers. Open the Console by 
running PComConsole.exe from your Policy Commander installation folder or from the 
Start menu. 

 Policy Editor - The Policy Editor enhances the effectiveness of your policies by adding 
rules, security templates, and Packages to target specific configurations, compliance, and 
settings on the managed computer. 

 Channel Server - The Channel Server manages the communication between the 
Console, database, and client computers.  A channel is a logical collection of managed 
computers and policies. After you install Policy Commander, the Server works in the 
background, providing information to the Console and applying changes to Client 
computers according to your settings. 

 Database - The Database serves as the repository for storing information like Client 
status, computer compliance, and policy settings. 

 Client - The Client is the software run on managed computers that executes policies, 
reports information to the Server about its current status, and alters the group 
membership as needed. 

 Knowledge Base - The Knowledge Base provides you with security policies written by 
New Boundary Technologies. 
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The image below provides an overview of how these components work together: 

 

How Policy Commander Is Licensed 

Policy Commander is licensed per computer. Each workstation or server managed through a 
Channel must have a Policy Commander license.  
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Notes on the Documentation 

The documentation includes online Help, a Tutorial, and a user guide. To gain the most from your 
documentation, please review the following comments: 

Tutorial 

Please review the Tutorial to gain a basic understanding of Policy Commander and to complete 
an exercise that leads you through the major features available with Policy Commander. The 
Tutorial is available through the Windows Start menu and through the Help menu in the software. 

Online Help 

When you select Help | Policy Commander Help or click the Help button on a dialog box, the 
online help is displayed. 

Conventions Used in the Help and User Guides 

Buttons, fields,  
and options 

The names of individual fields or options on a pane or dialog box are in 
bold text. For example, Save button. 

Menus A vertical line (|) is used to designate an item on a menu. For example, 
File | Open refers to the Open option on the File menu. 

Tabs on a dialog box A vertical line (|) is used to designate specific tab on a dialog box. For 
example, Channel Properties | Licenses tab refers to the Licenses tab 
on the Channel Properties dialog box. 

Tabs on the main 
window 

The Console window is divided into two main panes—the tree view on 
the left and details pane on the right. A vertical line (|) is used to 
designate the combination of a specific tab in the tree view and a 
specific tab in the details pane. 

For example, Managed | Members tab refers to the Members tab in the 
details pane when the Managed tab is selected in the tree view. 
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Contacting Technical Support 

If you are unable to locate answers to your questions within this help file, please use the following 
resources to receive assistance: 

Web site:       http://www.newboundary.com 
 
Here you will find the online New Boundary Technologies Support Forum, knowledge 
base articles, and responses to frequently asked questions. The Support Forum is an 
interactive discussion tool that will bring you in touch with other users of New 
Boundary Technologies software. 

Phone:          612-379-1851 
or 800-747-4487 
 
Available 8:30 A.M. to 5:00 P.M. Central Time, Monday through Friday 

System Requirements 

For detailed information on system requirements, please refer to the New Boundary Technologies 
support site: 
  

http://www.nbtnet.newboundary.com/supportkb/article.aspx?id=10718&cNode=8J0M6D 

  

Note: You must be an administrator-equivalent user to install the New Boundary Server, Console, 
or Package Builder. 
 
If you are going to use an instance of SQL Server running on a remote machine, you 
must have rights to create a domain account that can access that machine. You must 
also have the rights to add a login in SQL Server. 
 
Microsoft IIS 6.0 or later must be installed on a Web server if you intend to use the NBT 
Web Proxy to enable HTTP/HTTPS communication from Prism clients or Prism Console 
outside the network perimeter, to a Prism Server inside the network perimeter. IIS 
installation and configuration is not part of the Prism Suite installation. 
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Getting Started in the Console 

Overview of the Console and Channels 

The Console is the administrator’s program for managing Channels and computers. Through the 
Console the administrator: 

 Adds computers from the network 

 Groups computers based on role 

 Automatically groups computers based on configuration 

 Views detailed reports 

 Manages Channel security and settings 

Populating Channels and Managing Computers 

The steps to setting up Channels and managing target computers are simple. The following steps 
give a brief overview of the process. See the topics listed at the bottom of this page for more 
detailed information. 

1. Name the Channel and select the computer where the Channel Server is installed. 

2. Populate the Channel with computers and groups that you want to manage. (You can 
also create configuration groups to precisely identify targets for a variety of operations.) 

3. Define Policies and assign them to  computers 

4. Read reports on the outcome, including a summary or detailed information on 
administrator actions and information about each target. 

Opening the Console 

To open and use the Policy Commander console: 

1. Open Policy Commander from the Windows Start menu. 

2. The first time you open the console, the Select the Channel you wish to manage dialog 
box opens. 
 
After your first use, by default the console opens to the main window and displays the last 
Channel you opened. 

3. If you are new to the console, select the Evaluation Channel in the Select the Channel 
you wish to manage dialog box. (See the Tutorial for more information on this pre-
installed Channel.) If you are at the main window, the Channel you worked on most 
recently is displayed. 

4. Begin work (see Overview of the Console Main Window) 

5. Open a different Channel (see Opening a Channel) 

6. Create a new Channel (see Setting Up a New Channel) 

7. All Policy Commander Channels are secured. After selecting a channel, enter your 
credentials to load the channel. 
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Overview of the Console Main Window 

When you start the Policy Commander console, it opens to the main window as shown below. 
Through the main window, you manage the computers that subscribe to the Channel, create 
groups to organize the computers, enforce security policies, and monitor their compliance. 

The Console's main window includes the following features: 

 Menu bar - This provides access to all main functions.  

 Tool bar - This provides quick access to various functions. You can open channels, 
refresh the console, perform actions, and run reports.  

 Tree view - The left hand pane contains a tree view perspective relative to the currently 
selected tab. Use this pane to navigate and select items (such as individual computers) 
and groups. Tabs at the top of the pane provide access to various areas of functionality.  

 Network: The Network tab allows you to select computers to manage. 

 Managed: The Managed tab shows the currently managed computers and 

groups. 

 Configuration Groups: The Configuration Groups tab shows the configuration 

groups. These are automatically populated with managed computers. 

 Policies: The Policies tab is where you manage your policies. 

 Details pane - This pane to the right of the tree view shows detailed information relative 
to the currently selected item in the tree view. The specific contents are controlled 
through tabs at the bottom of the window. Right-click on an item to choose from a variety 
of actions. Use the column headings to sort and group the data. 

 Docking and Auto-Hide - Change the location of panes to suit your preferences.  

 

Menu Bar 

Console Menus 

Use the menus to manage Channels and computers, and access features for the various 
applications that are used through the Console. 
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 File: Open Channels or work with Console and Client settings. 

 Edit: Create, edit and delete groups, manage licences, reinstall clients, add computers to 
a group or view properties of the selected item. 

 View: Open a specific tab or application by selecting the name on the View menu. 

Reload the default layout or your custom layout for the Console main window. 

 Computers: View properties for the selected item, add computers, and set up groups. 

 Policies: Assign and enforce policies, view compliance status, and import and export 
policies. 

 Reports: Select from administrative, computer, and other reports. You can customize 
reports with filters, sort order, and grouping, then save the new report for regular viewing. 
Individual reports, including your custom reports, are available through the submenus. 

 Security: Create and assign roles to control access to the Channel and its data. 

 Tools: You can add any application to the Tools menu for easy access from the Console. 
For some applications, you can also add a menu item to the right-click options for a 
computer in the tree view. See Launching External Applications from the Console. 

 Help: View the online help, Tutorial, or Users Guide. 

File menu 

Options on the File menu include: 

 New Channel: Set up a new Channel. 

 Open Channel: Opens a new console. 

 Find Channel: Opens the Find Channel dialog, allowing you to connect to a channel on a 
particular server. 

 Import: Allows you to import Configuration Groups and policies. 

 Channel Properties: View and adjust the properties for the Channel, including auto-
population settings. 

 Console Settings: View and adjust the settings that control the communication between 
the Console and the Channel Server. 

 Client Settings: View and adjust the default values used when installing the Client 
directly or with a subscription file. The Client settings can also be set to automatically 
apply to managed computers. 

 Load Last Channel: With this option selected the Channel that is active when you exit 
from the Console is automatically selected and opened the next time you start the 
Console. Clear this option to select the Channel by name each time. 

 Exit: Close the Administrator’s Console. 

Edit menu 

The Edit menu options include: 

 Create Group: Create a new group. 

 Edit Group: Edit the selected configuration group. 

 Add To Group: Add an item to a group. 

 Remove From Group: Remove selected item from a group. 

 Rename: Rename the selected item. 

 Delete: Delete the selected item. 
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 Properties: View the properties for the selected item. 

View menu 

Options included on the View menu include: 

 Toolbar: Display the toolbar at the top of the Console main window. 

 Status bar: View the status bar at the bottom of the Console main window. 

 Save My Desktop: Save the current layout of the Console main window. The next time 

you open the Console, this layout will be used. (See Customizing the Console View.) 

 Restore My Desktop: Returns the Console layout to the configuration saved as My 
Desktop. Use this option if you have made changes, such as hiding the tabs, that you 
want to undo. 

 Restore Original Desktop: Returns the Console layout to the default layout. Use this 

option if you have made changes, such as hiding the tabs, that you want to undo. 

 Refresh: Refresh the data displayed in the Console if you have not made other changes 

recently. 

Computers Menu 

The Computer menu options include: 

 Manage Computer: Opens the Manage Computer Expert dialog, which allows you to add 
one or more computers to the channel by name. The list of computers to add is pre-
populated with any computers selected on the Network tab. Policy Commanderlets you 
install the Client directly or via a subscription file when the computer is added. 

 Manage Licenses: Displays license information for a managed computer. If auto-
licensing is disabled, allows you to change licenses (assign or unassign) for a managed 
computer. 

 Reinstall Client: Reinstall the Client on the highlighted computer. If you have the auto-
update option turned off through the Polling tab, use this option to update the Client 
settings. 

 Create Subscription File: Subscription files install the Client on a remote computer or 
other computer that cannot receive the Client directly through the Console. A subscription 
file can also be used to reconfigure Client settings on a managed computer. 

Policies menu 

The Policies menu offers the following options: 

 Assign Policy: Assign a policy to a computer or group. 

 Enforce Policy: Enforce a non-compliance policy. 

 Export Policy to File: Export a policy to a file. 

 Import Policy from File: Import a policy from a file. 

 Import Policy from Policy Server: Import a policy from an external server. 

 Policy Editor: Launch the Policy Editor. 

Security menu 

Options on the Security menu include: 

 Change User Password: If security is set up, change the password for the account you 
specified when logging in to the Channel. 

 Configure Security: Set up security, add users, and assign roles. 
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Tools menu 

The Tools menu is a special feature that provides access to other applications that you may 
which to launch from the Console. 

 Edit Tools Menu: Add external applications to the Tools menu. For more information, 

see Launching External Applications from the Console. 

Console Toolbar 

Use these toolbar icons in the Console main window to open Channels and run reports. 

Create a new Channel. The Expert leads you through the steps to set up a new 
Channel. 

Open an existing Channel. The Console displays a list of Channels you have used 
recently. You can also use the Find feature to locate a Channel. (See Finding an Existing 
Channel.) 

Refresh the display. 

Select an administrator report that captures information about actions taken by 
administrators and other users through the Console. 

Select a computer or group report to capture information about the current status of 
computers or groups. 

Select a policy commander report to capture information about policy compliance. 

View the online help. 

Note: In addition to the extensive default reports, you can create custom reports to display the 
information you use most often. 

Tabs in the Console 

By default, the tree view pane on the left side of the Console window lets you navigate through 
your network, view managed computers and groups, and perform actions on them. When you 
select a tab or an item in this pane, the details pane on the right changes to reflect your choice. 

 Network: The tree view left opens to the Network the first time you use Policy 
Commander. This tab displays the structure of your network and a hierarchical list of all 
the computers on your network. Use it as your starting point for managing new 
computers. 
 
With the Network tab active, the details pane on the right side lists all of the computers, in 
order. Use this information to quickly identify managed computers and whether the Client 
has been installed. Policy Commander lets you quickly add computers and install the 
Client from this pane through the right-click options. 

 Managed: The Managed tab lists all of the computers that you are managing through the 
Console. This tab also groups the computers into organizational groups that reflect the 
Active Directory structure of your network. You can also set up your own organizational 
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groups to reflect departments, locations, or other useful categories. 
 
Use the details pane on the right to sort the computers by their status, view the inventory, 
or check the status of Tasks—by computer or by group. 

 Configuration Groups: On the Configuration Groups tab you can create configuration 
groups to group computers by shared characteristics. These groups provide a powerful 
tool, letting you identify and target computers based on predefined or user-defined 
characteristics. 

 Policies: The Policies tab shows the policies and policy groups, including local policies 

and those imported by date. 

Network tab 

 

The Network tab reflects your network structure and lists all of the computers detected on the 
network. On this tab, you can navigate the network structure to find individual computers. When 
you highlight a branch or a computer on this tab, the Members panel in the details pane displays 
information about their status as members of the Channel. 

Use the right-click options on this tab to quickly add computers to the Channel and install the 
Client. To perform actions on the computer(s), they must be added to the Channel and have the 
Client installed. 

Icons 

Identify managed computers by their icons: 

This icon in the network structure indicates that the computer has been added to the Channel 
and is listed on the Managed tab. These computers can be inventoried or receive changes. 

This icon in the network structure indicates that the computer is not currently in the Channel 
and is not managed through Policy Commander. To add this computer, right-click on the 
computer name and select Manage Computer from the pop-up menu. (See Adding and 
Managing Computers.) 
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Right Click Options - Network Tree Node 

When you right-click on the root of any tree node, such as Directory or Microsoft Windows 
Network or a specific domain or organizational unit, the following action is available: 

 Show All: This will display all of the computers in the node and in any of its subtrees. 
This provides a "flattened" few of the network starting at the selected node. The details 
pane then includes a Location column showing where the computer is located. 

Right Click Options - Computer 

One of these actions is available when you right-click on a computer listed on the Network tab or 
in the Details pane.. 

 Manage Computer: Add the highlighted computer to the current Channel. (This option is 
available only for unmanaged computers.) 

 Reinstall Client: Reinstall the Client on the managed computer. (This option is available 
only for managed computers.) 

Details pane 

The details pane on the right displays a list of computers for the selected node in the tree. The 
information displayed includes: 

 Name: Name of the computer. 

 Managed: Indicates if the computer is currently managed in the Channel. 

 Installation Status: Shows the installation status, if any. Each computer for which an 
installation was attempted will have a value in this column. 

 Location: Indicates the location (domain) of the computer. This is displayed only when 
using Show All (see above).  If you group by this field, a computer count will be shown 

next to the name of the Location. 

Managed tab 

 

The Managed tab lists all of the computers and organizational groups that you are managing 
within the Channel. Computers listed here have been added to the Channel. To perform other 
actions on these computers, they must also have the Client installed. 
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 Computers may be assigned to organizational groups listed on this tab. These groups 
reflect your network structure (if you are using Active Directory) or may include custom 
organizational groups. 

 Computers are always listed in the Managed Computers branch. They can also be listed 
within one or more groups. 

This tab is available in the tree view on the left side of the Console main window. 

Right Click Options — Managed Computers Branch 

This option is available when you right click on the Organizational Groups node on the Managed 
tab. 

 Add Computers: Create a new Organizational Group. 

Right Click Options — Computer 

These options are available when you right click on a computer on the Managed tab. 

 Assign Policy: Assign policies to the computer. 

 Request Poll: Issues a request to the Client on this computer to poll the Channel Server 

as soon as possible, independent of its defined polling interval. 

 Add to Group: Select an organizational group to add this computer as a member. 
(Configuration groups are populated automatically—they cannot be populated through 
this option.) 

 Remove from Group: Remove the highlighted computer from the current group. This 
option is available only when you highlight a computer listed under an organizational 
group. 

 Delete: Remove the computer from the Channel. The computer will be listed on the 
Network tab but excluded from the Managed tab and all reports. 

Note: The Client is not un-installed from the computer, the computer is only removed from 
the Channel. See Deleting a Computer from the Channel. 

 Manage Licenses: Displays license information for a managed computer. If auto-
licensing is disabled, allows you to change licenses (assign or unassign) for a managed 
computer. 

 Reinstall Client: Reinstall the Client on the highlighted computer. If you have the auto-
update option turned off through the Polling tab, use this option to update the Client 
settings. 

 Reports: Generate a report for the selected computer. 

 Properties: View the properties for the computer. (See Viewing the Computer General 

Properties.) 

Note: These options are available any time you right click on a computer. 

Right Click Options — Organizational Groups Branch 

This option is available when you right click on the Organizational Groups node on the Managed 
tab. 

 Create Group: Create a new Organizational Group. 

Right Click Options — Organizational Group 

These options are available when you right click on an Organizational group on the Managed tab. 

 Assign Policy: Allows you to assign policies to the group. 
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 Create Group: Create a new organizational group. 

 Add to Group: Add a computer to the highlighted group. The Assign Computer dialog 

opens. 

 Delete: Remove the highlighted group from the Channel. 

 Rename: Rename the group. 

 Reports: Generate a report for the selected group. 

 Properties: View the properties for the group. (See Viewing General Group Properties.) 

Policies Tab 

 

The Policies tab lists all of the policies and policy groups that are in the Channel. 

 Every policy in the channel is listed under the All Policies branch. They can also appear 
within any number of policy groups. 

 Policies may be assigned to policy groups listed on this tab. These groups are user-
defined, and may reflect any structure you choose. Also, policies imported from an 
external server retain their structure under the Imported Policies (under Policy Groups). 

This tab is available in the tree view on the left side of the Console main window. 

Right Click Options — Policy 

These options are available when you right click on a policy on the Policies tab. 

 Assign Policy: Invokes the Assign Policy wizard to assign the policy to a computer or 
group of computers. 

 Add To Group: Allows you to add the policy to a policy group. 

 Delete: Deletes the policy from the channel. 

 Export Policy to File: Allows you to export the policy to a file. 

 Properties: Opens the Policy Properties dialog. 

Right Click Options — Policy Group 

These options are available when you right-click on a policy group listed on the All Policies tab. 
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 Assign Policy: Invokes the Assign Policy wizard to assign the policy group to a 
computer or group of computers. 

 Create Group: Creates a new sub-group. 

 Add To Group: Allows you to add the policy to a policy group. 

 Delete: Deletes the policy group from the channel. 

 

Note:  These options are available any time you right click on a policy or policy group. For 
example, you can select from the same options by right-clicking on a policy on the 
Managed | All Policies tab. 

Details Pane 

Members tab (Managed) 

The Members tab in the details pane lists information about the computer or groups of computers 
highlighted in the tree view. Details include information about the type of computer (workstation or 
server), status of the client, whether the computer is attended, last time the Client polled the 
Channel, and so on. 

This tab is displayed in the details pane on the right side of the Console window when the either 
the Managed or Configuration Groups tab is selected. 

Right Click Options — Computer 

 These options are available when you right click on a computer on the Members tab. 

 Assign Policy: Assign policies to the computer. 

 Add to Group: Select an organizational group to add this computer as a 
member. (Configuration groups are populated automatically—they cannot be 
populated through this option.) 

 Remove from Group: Remove the highlighted computer from the current group. 
This option is available only when you highlight a computer listed under an 
organizational group. 

 Delete: Remove the computer from the Channel. The computer will be listed on 

the Network tab but excluded from the Managed tab and all reports. 

Note: The Client is not un-installed from the computer, the computer is only removed 
from the Channel. See Deleting a Computer from the Channel. 

 Request Poll: Issues a request to the Client on this computer to poll the Channel 
Server as soon as possible, independent of its defined polling interval. 

 Manage Licenses: Displays license information for a managed computer. If 
auto-licensing is disabled, allows you to change licenses (assign or unassign) for 
a managed computer. 

 Reinstall Client: Reinstall the Client on the highlighted computer. If you have the 
auto-update option turned off through the Polling tab, use this option to update 
the Client settings. 

 Reports: Generate a report for the selected computer. 

 Properties: View the properties for the computer. (See Viewing the Computer 

General Properties.) 
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Members tab (Policies) 

The Members tab lists the policies in the group or the policy currently highlighted on the Policies 
tab. 

This tab is displayed in the details pane on the right side of the Console window when the 
Policies tab is selected. 

Details 

These columns are shown in the details pane: 

 Icon: Folder (group) or policy. 

 Name: Name of the policy. 

The following fields can be added using More Fields (right-click on the column headings): 

 Description: Description of the policy. 

 Email Notify: Indicates whether or not email notification is enabled for the policy. 

 Auto Enforce: Indicates whether or not Auto Enforce is enabled for the policy. 

Right Click Options 

These actions are available when you right-click on a policy listed on the Members tab. 

 Assign Policy: Invokes the Assign Policy wizard to assign the policy to a computer or 
group of computers. 

 Add To Group: Allows you to add the policy to a policy group. 

 Rename: Allows you to rename the policy. 

 Delete: Deletes the policy from the channel. 

 Export Policy to File: Allows you to export the policy to a file. 

 Properties: Opens the Policy Properties dialog. 

Policy Assignments tab 

The Policy Assignments tab lists the policy assignments associated with the selected computer, 
computer group, or policy. 

This tab is displayed in the details pane on the right side of the Console window when the 
Managed, Configuration Groups, or Policies tab is selected. 

Details 

These columns are shown in the details pane: 

 [Target] Icon: Indicates whether the target is a computer or computer group. 

 [Policy] Icon: Policy icon. 

 Policy: Name of the policy. 

 Assigned Through: The name of the computer or group through which the policy is 
assigned. 

Right Click Options 

These actions are available when you right-click on a policy assignment listed on the Policy 
Assignments tab. 

 Delete Policy Assignment: Deletes the assignment. Note that this does not delete the 
policy, just its assignment to the target computer or computer group. 
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Compliance Summary tab 

The Compliance Summary tab conveys a summary view of compliance that the administrator can 
use to quickly determine the current level of compliance in the system. It also allows the 
administrator to drill down to a specific computer or policy, and to a specific policy assignment of 
interest. 

This tab is displayed in the details pane on the right side of the Console window when the 
Managed, Configuration Groups, or Policies tab is selected. 

Compliance Summary - upper panel 

The table in the summary panel shows how many computers (for the Managed and Configuration 
Groups tabs) or policies (for the Policies tab) are in each compliance state. The pie chart displays 
this same data graphically. 

Computer and Policy Compliance 

The notion of compliance displayed in the summary is different than the compliance states that 
apply to a specific policy assignment. 

A computer's compliance state is: 

Compliant - if all policies assigned to that computer are either Compliant or Not 
Applicable. 

Not Compliant - if any policy assigned to that computer is Not Compliant. 

Enforced - if any policy assigned to that computer is Enforced and none are Not 
Compliant or Error. 

Pending - if any policy assigned to that computer is Pending and none are Not 
Compliant, Error, or Enforced. 

Not applicable - if all policies assigned to that computer are Not Applicable. 

Error - if any policy assigned to that computer is in an Error state and none are Not 
Compliant. 

A policy's compliance state is: 

Compliant - if all assignments of that policy are either Compliant or Not Applicable. 

Not Compliant - if any assignment of that policy is Not Compliant. 

Enforced - if any assignment of that policy is Enforced and none are Not Compliant 
or Error. 

Pending - if any assignment of that policy is Pending and none are Not Compliant, 
Error, or Enforced. 

Not applicable - if all assignments of that policy are Not Applicable. 

Error - if any assignment of that policy is in an Error state and none are Not 
Compliant. 

Examples 

Example 1: If a computer has 4 policies assigned to it, and one of the assignments is Not 
Compliant, that computer is Not Compliant. 

Example 2: If a computer has 2 policies assigned and both are Compliant, the computer is 
Compliant. 

Example 3: If a policy has been assigned to 12 computers, and 11 of those assignments 
are Compliant and one is Pending, the policy is Pending. 
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Example 4: If a policy has been assigned to 3 computers and all three assignments are 
Compliant, the policy is Compliant. 

Example 5: If a computer group's compliance summary pie chart shows that 25% of the 
computers are Not Compliant, that means 25% of the computers in that group 
have at least one policy assignment that is Not Compliant. 

Example 6: If a policy group's compliance summary pie chart is solid green, that means all 
assignments of that policy are Compliant. 

Details 

These values are shown in the upper panel: 

 Policy Count: The number of policies that are in the corresponding compliance state.. 

 Computer Count: The number of computers that are in the corresponding compliance 

state. 

 Percent: The percent of all computers or policies that the count represents. 

Compliance Summary - middle panel 

This panel displays the details corresponding to the computers or policies represented in the 
upper panel. There is one row per computer or policy. 

Details 

These columns are shown in the middle panel of the details pane: 

 Icon: The computer or policy icon. 

 Computer: The name of a computer associated with the selection (computer or computer 

group) in the tree view to the left. 

 Policy: The name of a policy associated with the selection (policy or policy group) in the 
tree view to the left. 

 [Compliance] Icon: The compliance icon indicates compliance state for the computer or 

policy 

 Compliance: The current compliance state for the computer or policy, as defined above. 

Right Click Options 

These actions are available when you right-click on a computer or policy listed on the middle 
panel. 

 Enforce Policy: Enabled only for Not Compliant policies/computers, this will enforce the 
policy for all assignments that are Not Compliant. 

 Acknowledge Enforcement: Enabled only for Enforced computers or policies, this 
acknowledges the enforcement for all the assignments that are Enforced. 

Compliance Details - lower panel 

The compliance details displayed in this panel is specific to the policy or computer selected in the 
middle panel. For any non-compliant policy assignments, a summary of the cause of the non-
compliance is also shown. This panel is very similar to the Policy Compliance tab. It displays 
specific assignments of policies to computers. 

For example, when you select a computer in the middle panel that is Not Compliant, the lower 
panel displays all of that computer's policy assignments. By the definition of computer compliance 
defined previously, at least one of those assignments - and possibly more - are Not Compliant. 
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Details 

These columns are shown in the lower panel of the details pane. 

 [Compliance] Icon: The compliance icon indicates compliance status. 

 Compliance: The current compliance state of the policy. 

 Computer: The name of the computer to which the policy is assigned. 

 Policy: Name of the policy. 

 Summary: Text describing the reason why the policy is not compliant. If no failure 
description is defined for the policy, the detailed error results will be shown. 

The following fields can be added using More Fields: 

 Last Update: Shows the last time the compliance state was updated. 

 Error Code: A code indicating the error. A 0 means the policy is compliant. 

Right Click Options 

These actions are available when you right-click on a policy assignment listed on the compliance 
details panel. 

 Enforce Policy: Enabled only for Not Compliant policies, this will enforce the policy. 

 Acknowledge Enforcement: Enabled only for Enforced policies, this acknowledges the 
enforcement. After this, the policy will become Compliant. 

 Policy Properties: Opens the Policy Properties dialog for that policy. 

 Computer Properties: Opens the Properties dialog for that computer. 

All Policies tab 

The All Policies tab lists all the policies in a tree view. 

This tab is displayed in the details pane on the right side of the Console window when the 
Managed or Configuration Groups tab is selected. 

Details 

These columns are shown in the details pane: 

 Icon: Folder (group) or policy. 

 Name: Name of the policy. 

Right Click Options 

The available actions vary depending on whether you are clicking on a policy or a policy group. 

These actions are available when you right-click on a policy listed on the All Policies tab. 

 Assign Policy: Invokes the Assign Policy wizard to assign the policy to a computer or 
group of computers. 

 Add To Group: Allows you to add the policy to a policy group. 

 Delete: Deletes the policy from the channel. 

 Export Policy to File: Allows you to export the policy to a file. 

 Properties: Opens the Policy Properties dialog. 

These actions are available when you right-click on a policy group listed on the All Policies tab. 

 Assign Policy: Invokes the Assign Policy wizard to assign the policy group to a computer 
or group of computers. 
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 Create Group: Creates a new sub-group. 

 Add To Group: Allows you to add the policy to a policy group. 

 Delete: Deletes the policy group from the channel. 

All Targets tab 

The All Targets tab lists all the computers and computer groups in a tree view. 

This tab is displayed in the details pane on the right side of the Console window when the 
Policies tab is selected. 

Details 

These columns are shown in the details pane: 

 Icon: Folder (group) or computer. 

 Name: Name of the group or computer. 

Right Click Options 

These actions are available when you right-click on a computer or group listed on the All Targets 
tab. 

 Assign Policy: Invokes the Assign Policy wizard to assign policies to the selected 
computer or group. 

 Delete: [For Computers only] Deletes the computer from the channel. 

 Reports: Allows you to generate a computer report. 

 Properties: Opens the Properties dialog for the computer or group. 

Using the Console 

Customizing the Main Window View 

You have various options for customizing the Policy Commander main window to suit your needs. 

Sorting Data in the Details Pane 

 Position of the columns - Arrange the columns in a different order by clicking on a 
column heading and dragging it to a new location. 

 Sort order of the data - Click the column heading to sort all of the data by that column. 
To change from ascending to descending order, click the column heading a second time. 

 Add More Fields - Right-click in the column heading area and choose More Fields from 
the pop-up menu. A floating dialog lists the additional fields that you can add to the 
details pane. 

Grouping Data in the Details Pane 

You can group or categorize the data in the details pane by dragging a column heading into the 
shaded area at the top of the pane. All of the data is grouped by the values currently in that 
column. 

Views 

Switch to a different layout by selecting a view from the Views menu. 

After making changes, you can return to the default view by selecting Restore My Desktop or 
Restore Default Desktop on the Views menu. For example, after rearranging the panes, return 
to the default view. 
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Docking and Hiding Panes 

Each of the main panes in the Policy Commander main window can be moved to a new location 
or temporarily hidden behind the tree view. See Docking and Hiding Panes. 
 
Each time you open Policy Commander, the view will reflect your new layout. 

Save the View 

The current desktop is automatically saved when the console is closed. You can also save the 
current view at anytime: 

 Select View | Save my desktop to save this new view. 
 
The new layout is applied the next time you open the Channel. 

  

Docking and Hiding Panes 

You can customize the layout of the Console main window through dockable panes and auto-hide 
options. 

Repositioning a Pane 

The tree view and details pane can be moved into a horizontal or vertical arrangement by docking 
the panes in a new location. 

1. Click in the title bar at the top of the pane and drag the pane to a new location. 
 
A dark gray bar surrounds the pane and changes shape when you get close to a docking 
position on the window. 

2. Release the mouse button to set the pane in the new location. 

3. Select View | Save my desktop to save this new view. 

The new layout is applied the next time you open the Channel. 

Hiding a Pane 

The Auto-Hide option lets you hide a pane and use the entire Console window for the contents of 
a specific pane. For example, hide the details pane while focusing on the Network tree view. 

1. Click the  in the upper-right corner of the pane. 
 
The pane slips out of sight. A tab available on the left side of the window gives quick 
access to the hidden pane. 
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2. Click on the tab on the left side of the window to display the hidden pane. 

 
 
The pane scrolls into view when you move the cursor over it or over its tab. The pane 
slips out of sight when you move the cursor off of the pane. 

Turning Off Auto-Hide 

If you used Auto-Hide to change your display and want to return to the default view or your saved 
view, select one of these options from the View menu: 

 Restore my desktop: Returns the layout to your saved view. 

 Restore default desktop: Returns the layout to the one used when Policy Commander 
was installed. 

Console Features and Shortcuts 

The Policy Commander console offers a number of features to help you work more quickly. See 
the following topics for more information: 

 Use Shift and Ctrl keys to select two or more computers for management 

 Drag and drop to assign group members and manage computers 

 Right-click pop-up menus of common functions 

 Double-click an item for the default function 

 Use shortcuts and function keys 

Shift and Ctrl 

To select two or more computers in the details pane, hold the Shift key or Ctrl key down as you 
click on your selections. This shortcut is especially useful for installing the Client on a large 
number of computers at once. 

 Shift: Hold the Shift key as you click on the first and last name to select all of the items 
in-between. 

 Ctrl: Hold the Ctrl key as you click on individual names. 

Drag and Drop 

The Console main window is designed to help you work quickly. You can easily move computers 
into organizational groups or perform other management functions by dragging and dropping. 

For example, to assign a computer to one or more Organizational groups, drag the computer from 
the list in the Members onto each of the groups. 

Right-Click Pop-Up Menus 

Most of the actions you can choose through the toolbar and menus are also available with a click 
of your mouse. 
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Right-click on an item to open a pop-up menu that displays the actions for that item. Use the 
right-click to set properties, delete items, perform functions, and so on. 

Double-Click for Default Function 

Double-click on a target to initiate the default action. For example, double-click on a group to 
open the Group Properties dialog box. 

Shortcuts and Function Keys 

The following shortcut keys can be used in the Console main window: 

To Do This Use this Shortcut 

Open help F1 

Refresh and update the view F5 

Open the Properties dialog box <Alt><Return> 

Delete the current item <Del> 

Open the pop-up menu of actions you can 
take for the current item 

<Shift><F10> 

Console Settings 

Adjusting the Console Settings 

The Console Settings options govern how the Console communicates with the Channel Server. 

Open the Console Settings dialog box with one of these actions: 

 Select File | Console Settings. 

 Click the Settings button on the Select the Channel you wish to manage dialog box, 
which opens when you create a new Channel. 

Console Settings Tabs 

The Console Settings dialog box includes three tabs: Server, Web Proxy Server, and Reports. 

The Console Settings | Server tab defines how the Console should connect to the Server. For 
more information on this tab, refer to the Server tab section in the Managing Computers chapter 
of this document. 

The Console Settings | Web Proxy Server tab provides the option of using HTTP for 
communication between the Console and the Server. For more information on this tab, refer to 
the Web Proxy Server tab section in the Managing Computers chapter of this document. 

The Console Settings | Report tab lets you set the timeout interval for generating reports. 

This tab is available when you select File | Console Settings to change the connection settings for 
the Console. 

 Time out the report connection after seconds: Set the number of seconds that 
the Console maintains contact with the database server when generating reports. 

Since reports can be large, we recommend using the default setting (30 seconds) or setting a 
longer interval. 
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Using System Policies to Fine-Tune the Client and Console 

Prism supports use of system policy templates to provide fine control over the behavior of the 
Client and the Console. For example, you may use a policy to hide the Client icon that appears in 
the system tray. Until you change the policies, the Client icon is visible in the system tray and the 
only thing a user can do with the Client is to view the About box. 

Distributing System Policies with a Prism Package 

The Prism installation includes a Prism Package that can be used to modify any of these settings. 
Using this Package as the basis for creating your own Packages is the easiest way to make 
changes to the Client and Console settings. 

To edit and distribute changes: 

1. Open the Prism Client Policies Package file in the Editor. Look for this file in the Prism 
folder. 

Note: If the Editor is not installed on your computer, you may need to open the Editor on the 

computer where it is installed and browse to the Prism file used for this Task. 

2. In the Editor, select File | Save As to save the Prism file under a new name to reflect its 
function. 
 
Save the file to shared location where each of the Client computers can access the file. 

3. In the Editor, browse to the policy that you want to change. 

4. Right-click on the Registry Value in the pane on the right side of the Editor window. 
Choose Modify from the pop-up list. 

5. On the Registry Value window, change the value to 01 to turn the option on or 00 to turn 
the option off. Click OK. 

6. If the Prism file includes other policy settings that you do not want to change, highlight 

each and click the  in the toolbar to delete them. 

Note: There are two policies that have dependencies. 
 
• If you enable the UseOnlyApprovedCertificates policy, you must also define at least 
one thumbprint. 
 
• If you enable the UseOnlyApprovedServers policy, you must also define at least 
one computer in the Server List. 

7. Deploy the Prism file as a Task through the Console. 

Alternate Methods for Editing and Distributing the Policy Template 

Though the Editor and Console provide quick and easy access to these system policies for 
editing or distribution, you may choose to use other tools. 

The template for Prism (PRISM.ADM) is in C:\PROGRAM FILES\PRISM SUITE\GROUPPOLICY\ADM. It can be 
edited using a policy editing tool, such as MMC (Microsoft Management Console) for Windows 
2000 or a policy editing tool from the operating system resource kit. 

The changes can be distributed to target computers using Active Directory. You can apply the 
updated template to a Domain, Organizational Unit (OU), or users on the network. 
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Integrating External Applications into the Console 

Policy Commander lets you run external applications directly from the console. These 
applications can be generic - in which case they appear under the top level Tools menu in the 
Console - or they can apply specifically to individual computers and computer groups via right-
click menu options. 

For example, you can create a right-click menu command on computers that launches a 
Shutdown command directly against the selected computer. 

These applications are added to the Console by creating a special EXTERNALTOOLSCONFIG.INI file in 
the Console directory. This file defines, for each command, its name, the application to run, any 
desired arguments, and arguments that identify the specific comptuer(s) or group(s), being 
manipulated. 

To help organize the commands, you can create submenus so you can put your external 
applications into logical groups. 

The external application is launched as a separate process. The console does not wait for it to 
complete nor does it report a final execution status. If the actual launch of the application fails (for 
example, because the path specified in the .INI file is wrong and the executable cannot be found), 
a simple error message box is displayed. 

Note: The .INI file contents are not filtered against user permissions in any way. If an entry is 
defined in the .INI file, it will be visible to any user of the Console on that machine. 

  

Caution: Do not use this feature unless you fully understand the implications of launching the 
external application and fully understand the syntax used in the .INI file. 

Tools menu 

An application is added to the Console Tools menu by adding a line in the Tools section of the 
EXTERNALTOOLSCONFIG.INI file. If the .INI file does not exist, or if there are no entries in the Tools 
section, the Tools menu does not appear. 

 

Computer right-click menu 

Add an application to the list of options on the right-click menu for a computer or multi-selected 
set of computers by adding a line to the SingleComputerApps section of the 
EXTERNALTOOLSCONFIG.INI file. The identity of the computer (name, IP, or MAC address) is passed to 
the application through the use of variables. If multiple computers are selected, the application is 
invoked independently for each computer. 

For example, you could define a menu item called Remote Desktop Connection in the 
SingleComputerApps section that runs mstsc.exe: 

Remote Desktop Connection=mstsc.exe /v:%computername% 

Selecting this from the right-click menu on a computer will launch a remote desktop session on 
the selected computer. 
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Note   The applications specified in this section must be able to accept, in their command line, 
either the name, IP, or MAC address of a computer. See Format of the 
EXTERNALTOOLSCONFIG.INI File for more information. 

 

The external applications are not listed under the following circumstances: 

 SingleComputerApps section is empty; 

 A group is selected. 

Computer Group right-click menu 

Add an application to the list of options on the right-click menu for a computer group, multi-
selected computers, and single computers by adding a line to the MultipleComputerApps section 
of the EXTERNALTOOLSCONFIG.INI file. The identity of the selected computers is passed to the 
application through a single file that contains information about each computer (specifically, each 
computer's name, IP, and MAC address, with one computer per row). 

For example, you could define a menu item called View Computer Info in the 
MultipleComputerApps section that invokes Notepad. Selecting this from the right-click menu on a 
group invokes notepad.exe on the file containing information about each computer in the group, 
including the computer's name, IP, and MAC address. 

Note   The applications specified in this section must be able to accept, as input, an argument 
that specifies a file containing computer information in a specific format. Generally, these 
will need to be custom applications, or scripts that invoke generic applications. See 
Format of the EXTERNALTOOLSCONFIG.INI File for more information. 
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The external applications are not listed if there are no applications defined in the 
MultipleComputerApps section. 

Sub-menus 

You can organize your external applications into submenus, both in the Tools menu and in the 
right-click menus (computer and group options). This allows you to group related commands 
together, and makes it easier for the user to navigate through the available tools. 

For example, you can put shutdown-related commands together into a submenu called Shutdown 
Commands. 



Getting Started in the Console 

27 

 

Format of the EXTERNALTOOLSCONFIG.INI File 

The EXTERNALTOOLSCONFIG.INI file is automatically installed in the same directory as the Console 
executable. 

Note   Any line in the file beginning with a single quote is taken as a comment line. 

Sections 

The .INI file may have several sections, each of which must be contiguous (i.e., can appear only 
once). The section title is enclosed in brackets [ ] and is followed by the individual menu items, 
one per line: 

[Tools] - Menu items that are added to the Tools menu. The commands in this section can 
be used to launch applications independent of any selected computers or groups. 

[SingleComputerApps] - Menu items that will appear in the context menu when one or 
more computers are selected. This includes all Assets that are of type "Computer" and are 
manageable. When multiple computers are selected, the command is executed against 
each computer, sequentially. These commands can use computer name, IP, and/or MAC 
address in the command line. 

[MultipleComputerApps] - Menu items that will appear in the context menu of a selected 
computer group or multiple selected computers. These commands take a file as input. The 
file contains names, IP addresses, and MAC addresses for all selected computers. 
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Command Syntax 

Each line in the file that denotes a specific menu item has the following syntax: 

<Menu item label> = <commandline>[, <start in directory>] 

Menu item label 

This label is displayed in the menu. It should be relatively short but may contain spaces or 
underscores to increase readability. For example, any of the following labels could be used: 

Remote Control 
Remote_Control 
RemoteControl 

Commandline 

The commandline identifies the executable file that launches the external application. 
Commandlines may contain spaces, quotation marks, and backslashes, as needed for the syntax 
of the application to be executed. Double quotation marks (") may be used to enclose the 
command line but are not required. Spaces separate commands from arguments, so put double 
quotes (") around the command portion if it contains spaces. 

The Commandline can include environment variables enclosed in '%' signs. 

SingleComputerApps Sections 

The SingleComputerApps commandlines may contain variables to be substituted with actual data 
at run time. Variables are case insensitive. The variables available are: 

%name% - the computer name (%computername% can also be used) 

%ipaddress% - the IP address of the computer 

%macaddress% - the MAC address of the computer  

For example, the following line in the SingleComputerApps section defines a menu item called 
"Shutdown" that launches shutdown.exe against the selected target: 

Shutdown="shutdown.exe" -m \\%name% -t 30 -s 

MultipleComputerApps Sections 

Commandlines for MultipleComputerApps may contain a file name parameter enclosed in (#) 
delimiters. The filename is not a variable, but an actual file. Prior to executing the command, the 
named file is populated with information about the selected computers. After populating the file, 
the command line is launched with the (#) delimiters replaced with double quotes ("). 

Each row in the file contains computer name, IP address, and MAC address, each separated by 
commas. The file name parameter may contain environment variables. For example, %TEMP% 
can be used to specify the temporary folder. 

The following example defines a menu item named "Computer Names" that uses Notepad to 
show name, IP, and MAC address for all the selected computers: 

Computer Names=notepad.exe #C:\compfile.csv# 

The next example defines a menu item named "Sample App" that invokes a custom application - 
FileReader.exe - that can take as input the file containing the names, IP, and MAC address of the 
selected computers. This file will be created in the %TEMP% folder, so its actual location varies 
by operating system. 

Sample App="C:\Program Files\Foo\FileReader.exe" 

#%TEMP%\computersFile.csv# 
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Start in directory 

A start-in directory may be included for the executable. The start-in directory is optional unless 
the commandline contains commas. 

Start-in directory paths may contain spaces, quotation marks, and backslashes, as needed for the 
syntax of the application to be executed. Double quotation marks (") may be required to enclose 
the directory. 

If a start-in directory is not specified, the working directory for the launched application is the 
same as the Console’s current directory (unless the application sets its own working directory at 
startup). 

Using the "." syntax to specify the current directory as the start-in directory is sufficient. The 
following two commandlines are equivalent: 

Some App="C:\Program Files\Some App\someapp.exe" 

Some App="C:\Program Files\Some App\someapp.exe", "." 

However, if the commandline contains a comma-delimited list, the following two lines are not 
equivalent: 

Some App="C:\Program Files\Some App\someapp.exe" /settings=1,2,3 

Some App="C:\Program Files\Some App\someapp.exe" /settings=1,2,3, 

"." 

Only the second line will work correctly. The first line will result in an error when the Console tries 
to launch the Some App program with a start-in directory of "3". (Enclosing the commandline in 
double-quotes would not eliminate the need for a start-in directory.) 

Submenus 

Submenus can be defined in any section to help organize applications. Multiple submenus can be 
used in any section, and submenus can be nested. Submenus must be contained within a 
section. 

Syntax 

[SubMenuBegin] 

<Submenu label> = <submenu name> 

-- Zero or more commands & submenus -- 

[SubMenuEnd] 

Example 

The following example defines a submenu whose label is "Shutdown Commands" and whose 
contents consist of  3 menu items. 

[SubMenuBegin] 

Name=Shutdown Commands 

Shutdown="shutdown.exe" -m \\%computername% -t 30 -s 

Restart="shutdown.exe" -m \\%computername% -t 30 -r 

Abort Shutdown="shutdown.exe" -m \\%computername% -a 

[SubMenuEnd] 
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Example ExternalToolsConfig.ini File 

The following ExternalToolsConfig file defines 3 menu items on the Tools menu, 2 items (one of 
which is a submenu containing 3 menu items) on the menu for single computer applications, and 
1 menu item on the menu for multiple computer applications. 

[Tools] 

Remote Desktop Connection=mstsc.exe 

Edit Tools Menu=notepad.exe "ExternalToolsConfig.ini" 

  

[SingleComputerApps] 

Remote Desktop Connection=mstsc.exe /v:%name% 

[SubMenuBegin] 

Name=Shutdown Commands 

Shutdown="shutdown.exe" -m \\%name% -t 30 -s 

Restart="shutdown.exe" -m \\%name% -t 30 -r 

Abort Shutdown="shutdown.exe" -m \\%name% -a 

[SubMenuEnd] 

  

[MultipleComputerApps] 

View Computer Info=notepad.exe 

#C:\Dev\PrismMain\PrismConsole\Output\Release\compfiles.csv# 
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Channels 

Setting up a New Channel 

The Channel lets you manage a set of resources through the Console. In many cases, you need 
only one Channel to maintain the computers under your responsibility. However, you can create 
as many Channels as desired. 

To create a new Channel: 

1. Open the Console. 

2. Click  on the toolbar or choose File | New Channel from the Console main window. 

3. In the New Channel - Server Name dialog box, select the computer where the Channel 
Server is located. Click Next. 

4. In the New Channel - Enter a name for the new Channel dialog box, type a descriptive 
name for the Channel. Click Next. 
 
The name of each Channel must be unique. 

5. In the New Channel - Use Port Number dialog box, identify a TCP/IP port for the Console 
to use for connecting to the Channel Server. 

Important: The port setting for the Console and the Client on each target computer must 
be the same. The port for the Client is set by installing the Client directly from the 
Console or adjusting the Client settings through the Console. 

6. In the New Channel - Polling Interval dialog box, set the default value to use for Clients to 
contact the Channel Server. 

7. In the Secure Channel dialog box, indicate whether the Channel should be secured with 
a password. 
 
If you do not secure the Channel at this time, you can secure it later by selecting 
Security | Manage in the Console main window. 

Note: This option secures only the Channel you are creating. You must use the Channel 
Manager application to control permission to create new Channels. By default, 
anyone who has access to the Console can create a Channel. 

8. Click Finish. 

Note: If Channel creation has been secured through the Channel Manager, Policy 
Commander displays a dialog box for entering a user name and password for 
creating a Channel. Only users added through the Channel Manager can create new 
Channels. 

9. Policy Commander displays a dialog box while it creates the new Channel. The new 
Channel is displayed in the Console main window. 

In the main window, you can add computers, create groups, and manage both. 
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New Channel - Server Name dialog 

On this dialog box, enter the name of the computer where the Channel Server is installed. This 
dialog box opens when you are creating a new Channel. 

Options include: 

 Server: Type the name of the computer where the Channel Server is located or use the 

 to browse for the name. 
  

 Use this computer as the server: With this option selected, the Channel Server is 
located on the computer where you are currently working. This computer must be turned 
on and available at all times for proper operation. Policy Commander automatically enters 
the name in the Server text box. 
 

Use this computer as the server: With this option turned off, you enter the name of 
the computer where the Channel Server is installed. The computer where you are 
currently working is not used as the server. 

Note: The Channel Server and SQL Server [or MSDE (Microsoft Desktop Engine)] can be 
installed on the same computer or on different computers. 

New Channel - Use Port Number dialog 

 

Identify a TCP/IP port the Console and Clients can use to connect to the Channel Server. In most 
cases, you can use the default value shown on the dialog box when it opens. 

Important: The port setting for the Console and the Client on each managed computer must be 
the same. The port for the Client is set by installing the Client directly from the Console 
or adjusting the Client settings with a subscription file. 

On this dialog box, do one of the following: 

 Click Next to accept the value in the Use Port Number field. 

 Click  to scroll to a port number in the Use Port Number field. 

 Type the number of the port in the Use Port Number field. 

We recommend using one of the following port numbers: 

 User Port (port 3133) 
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 World Wide Web HTTP Port (port 80) 

 Dynamic or private port (ports 49152 to 65535) 

Note: By default, Policy Commander Channels use port 3133 for the Console and Clients to 
communicate with the Channel Server. This port is an official assignment made by the 
IANA [Internet Assigned Numbers Authority (www.iana.org)]. 
 
If the Client must communicate with the Channel through a firewall, you may need to 
open port 3133 on the firewall. Otherwise, we recommend using port 80, since that port is 
typically already open for web browsing. 

  

New Channel - Polling Interval dialog 

 

Set the default polling interval to be used for the Client computers to contact the Channel Server. 
The value you set here is used when computers are installed directly from the Console and for 
subscription files generated from this Channel. The values you set on this dialog box can be 
changed later by selecting File | Client Settings, and selecting the Polling tab. 

This dialog box opens when you create a new Channel. 

Set how often to poll the Server 

Choose one of these four Polling options that define how often the Client should check with the 
Channel Server for new updates: 

 Poll Continuously: The Client contacts the Channel Server constantly. This option 
requires more processor time and bandwidth than the following options. It is used only for 
a small number of computers in a test lab. 

Caution: Do not use this setting for your production environment. 

 Poll once every   minute(s): The Client contacts the Channel Server at the 
interval you set. The interval is a number of minutes. 
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The Client requires very little bandwidth, so the default value is 10 minutes. The polling 
interval may need to be adjusted up or down, depending on these factors: 

 the number of computers in the Channel 

 the number of groups in the Channel 

 how frequently you assign policies from the Channel 

 Poll once every hour(s): The Client contacts the Channel Server at the interval 
you set. The interval is a number of hours. 

 Poll once every day: With this setting, the Client contacts the Channel Server for 
updates at the start of each session. A session begins when a user logs on to the 
computer. There is also an unattended session when the computer is turned on but there 
is not a user logged on. 

Notes  Please contact Technical Support for recommendations on the optimal polling interval 
for your situation. 
 
The default polling interval is 10 minutes. The default polling interval is set when you 
create the Channel. 

Configure the Client to Automatically Apply New Settings for this Channel 

 Automatically apply settings to all clients: With this option selected, all clients will 
inherit the settings made in this tab. This will occur automatically for existing clients 
the next time they poll the Channel Server as well as for new clients. Each client will 
automatically be updated whenever client settings are changed for the channel. 

 Automatically apply settings to all clients: With this option cleared, the client 
settings are set individually for each managed computer. The settings on this tab 
become the default values. They are established (and can be modified) when the 
Client is installed directly or through a subscription file. To change the settings for an 
existing Client, you must reinstall the Client with the new settings. 

Secure Channel dialog 

Secure the Channel you are creating with password protection. After completing the Channel 
setup, you can further secure the Channel by adding roles, permissions, and user accounts. 

This dialog box opens when you are creating a new Channel. 

Caution: This option cannot be reversed. If you secure a Channel, it always requires a valid user 
name and password to open. 

Secure this Channel now? 

  No: With this option selected, the Channel is not secured. The Channel can be opened by 
anyone working with the Console. Access to this Channel can be secured later through the 
Console Security menu. 
 
Use the Channel Manager application to control a list of users who can create Channels. 

  Yes: With this option selected, this Channel is secured with a password. When security is 
set for a Channel, the Channel always requires a valid user name and password to open it. 
 
The person who creates the Channel and selects this option is automatically assigned the 
Channel Admin role. The Channel Admin can create other user accounts, set up 
passwords, and set permissions within the Channel. 
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Note:     Policy Commander requires that all channels be secured. 

Define Administrator 

 User Name: Enter a unique user name for the Channel Admin.  
The Channel Admin must log in to the Channel with the user name and password 
entered here. 

 Password: Type the password that the Channel Admin will use to open this Channel. 

 Retype: Verify the password by retyping it in this text box. 

Opening a Channel 

To open a Channel that you want to work with: 

1. Click  on the toolbar or choose File | Open from the Console main window.  
PrismPolicy Commander displays the Select the Channel you wish to manage dialog box. 

2. Highlight the name of the Channel you want to open. Click OK. The Channel is displayed 
in the Console main window. 
 
If the name of the Channel is not in the list, you can find it quickly. See Finding an 
Existing Channel. 

  

Select the Channel you wish to manage dialog 

 

The Select the Channel you wish to manage dialog box opens when you: 

 Open the Policy Commander console for the first time. 

 Choose File | Open Channel. 

 Click  in the main console toolbar. 

On this dialog box, create a new Channel or open an existing Channel. The list in the center pane 
shows the Channels used most recently and the computer where the Channel Server is located. 
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Create a new Channel 

Click the Create button. You will have an opportunity to name the Channel and select a computer 
where the Channel Server is located. The Channel opens in the Console main window. Next, you 
are ready to add computers. 

Work with an existing Channel 

Highlight the name of a Channel in the list then click OK. The Channel is opened in the Console 
main window where you can add and modify the computers, groups, and perform other 
operations. 

Find a Channel 

If the Channel you want to use is not displayed in the list, click the Find button to locate it on the 
network. After you find the Channel, it is displayed in the Console main window. 

Remove a Channel 

Highlight the name of the Channel in the list box, then click Remove. You have the choice of only 
removing the Channel from the list displayed here or removing the connection to the Channel 
Server. 

Change the Console Settings 

Highlight the name of the Channel in the list box then click Settings. These settings govern how 
the Console communicates with the Channel Server and are used as the default value for 
installing the Client on managed computers. In the settings dialog box, adjust the following 
settings for the Channel (refer to Adjusting the Console Settings for more information): 

 Server 

 Web Proxy Server 

 Report timeout period 

Finding an Existing Channel 

Policy Commander conveniently remembers the Channels you have worked on recently and 
displays them in the Select the Channel you wish to manage dialog box. However, there are 
times when you are working from a different computer or need to open a Channel that you have 
not managed before. 

To find a Channel: 

1. Choose File | Find Channel from the Console main window or click the Find button on 
the Select the Channel you wish to manage dialog box. 

2. In the Find Channel Server dialog box, type the name of the computer where the Channel 

Server is located or click  to browse the network. Then click Next. 

 If Policy Commander locates the computer, the Find Channel dialog box lists all of 
the Channels available. Go to step 4 below. 

 However, if the Channel Server cannot be contacted using the known communication 
settings, the Expert displays the Find Channel Connections dialog box. Go to the 
next step. 

3. In the Find Channel Connections dialog box, enter the communication settings for the 
computer you want to find. Policy Commander attempts to locate it based on these new 
settings. 
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4. Highlight the Channel you want to open on the Find Channel dialog box. Click Finish. 
 
The Console displays the Channel in the main window. 

Find Channel Connections dialog 

 

This dialog box is displayed while using the Expert to find a Channel if the computer you 
specified cannot be contacted using the known communication settings. 

Enter the communication settings for the Channel Server you want to find. Policy Commander 
attempts to locate the Channel Server based on these new settings. 

 Port Connect to the Channel Server using Port: Type a number in the text box or use 

the  to scroll to a number. The Port is the one that the Console uses to connect to the 
computer where the Channel Server is located. 
 
We recommend using one of the following port numbers: 

 User Port (port 3133) 

 World Wide Web HTTP Port (port 80) 

 Dynamic or private port (ports 49152 to 65535) 

 Time Out Time out the connection after: Set the number of seconds that the Console 

on your current computer will keep trying to contact the Channel Server. 

If Policy Commander still reports that the Channel Server cannot be found, check for a typo or 
other entry error on the Find Channel Server dialog box. 

Channel Security 

Channel security features encompass authentication and authorization for users: 

1. Authentication: Users can be required to provide credentials to access the channel. 
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2. Authorization: The Role assigned to a user defines their authorization in terms of: 

1. Permissions: Permissions define specific actions a user can take within the 
channel (like assigning policies or removing computers from the Channel). 

2. Access: Access specifies the computers within the channel that the Role is 
allowed to modify. Because access is based on computer groups, it can be as 
flexible and dynamic as necessary. 

Each Channel can be secured with password protection and user roles that control authorization. 
Securing a Channel requires setting up roles that define the permissions or privileges available 
and assigning users to these roles. After adding users and creating roles, individual users must 
log in to the Channel with a password. 

For example, users assigned to the Report User role can view the policy and computer reports 
but they do not have access to other Console features. In contrast, the Report Admin role lets a 
user create and modify reports as well as view them. 

Securing the Channel 

In Policy Commander, all channels are secured. An approved user name and password are 
always required to open the Channel. 

Authentication 

When a Channel is secured, access to the channel requires the user to supply credentials. When 
first secured, credentials for the Channel Administrator (with Role of Channel Admin) must be 
supplied. This Channel Admin user (whose role and permissions cannot be modified) can then 
add and delete users, assign roles to users, and change passwords. Users and passwords are 
set up through the Manage Channel Security dialog box. 

Each user can change their own password or have it changed by the Channel Admin. After 
opening the Channel, an individual user can change their password by selecting Security | 
Change User Password. 

Authorization 

A Role defines the authorization level for a user by specifying what actions a user can take and 
what computers they can modify. Each channel user has a single, designated role, and multiple 
users can have the same role. Roles are created in the Manage Channel Security dialog box, and 
defined through the Role Properties dialog. 

Default roles available in the Channel include Channel Admin, Channel Power User, Policy User, 
Report Admin, and Report User. You can use and modify these roles to suit your needs, and you 
can create new roles. 

Roles consist of two aspects: Permissions (permissible actions such as assigning tasks) and 
Access (the computers the role can manipulate). 

Permissions 

Permissions define the specific actions a user can take in the Channel. For example, by 
customizing the permissions, a role can be given access to all aspects of adding and managing 
computers or limited to only adding computers but not deleting them. 

Permissions include actions such as creating groups, adding computers to groups, adding 
computers to the channel, and assigning policies to computers. If a role does not have permission 
to assign policies to computers, then those actions will be disabled for users in that role. 

Permissions for a role are selected on the Permissions tab of the Role Properties dialog. 
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Access (via Secured Groups) 

By default, a Role's permissions apply to all computers in the Channel. However, a role can be 
restricted such that certain computers cannot be modified by that role regardless of the role's 
permissions. This can be useful in situations where there are individual administrators for 
independent subsets of computers in the channel - for example, for computers in different 
domains: Within a domain, one administrator can assign tasks and take other actions, but in 
another domain they cannot. 

Access is controlled by securing specific computer groups from that role. When a group is 
secured from a role, users in that role cannot modify computers in that group, independent of 
their permissions and even if those computers are in other groups that the user can manipulate. 

Although secured computers cannot be changed (either directly or indirectly) by the associated 
role, those computers can be seen, they can be added to and removed from computer groups, 
and are visible in reports. 

Access control is defined on the Secured Groups tab of the Role Properties dialog, where 
specific groups can be added (alternately, the role can be de-selected on the Role Security tab 
of the Group Properties dialog for a specific group). 

Unlike Permissions, which are fixed for the duration of a console session, Access is dynamic 
because computers can enter and leave secured groups dynamically. This feature can be very 
useful. For example, a configuration group based on time-of-day could be defined and secured 
from a role such that the role can only manipulate computers during non-working hours. 

Managing User Accounts 

Individual users are given access to secured Channels by the Channel Admin. Each user also 
has an assigned role that defines the permissions or privileges they have within the Channel. 

Add a User 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, click the Add User button below the list of 
users in the upper part of the dialog box. 

3. On the Manage User dialog box, enter the person’s name, password, and email address. 
The person will use this name and password each time they log in to the Channel. 

4. Select a role for the person from the drop-down list in the Role field. 

Change a User’s Role 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, highlight the name of a user in the upper 
part of the dialog box. 

3. Click the Edit User button below the list of users. 

4. On the Manage User dialog box, select a role for the person from the drop-down list in 
the Role field. 

Change a User’s Email 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, highlight the name of a user in the upper 
part of the dialog box. 

3. Click the Edit User button below the list of users. 
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4. On the Manage User dialog box, enter the user's email address in the Email Address 
field. 

Manage Channel Security dialog 

 

The Manage Channel Security dialog box lists the users and roles set up to secure the Channel. 
The Channel Admin uses this dialog box to add the users and roles, change individual 
passwords, and set the specific permissions assigned to each role. 

This dialog box opens when you select Security | Configure Security. 

Secure this Channel 

Secure the Channel to limit access to its features and data. 

 Secure this Channel: With this option selected, the Channel is secured. All users must 
be assigned a role and have a valid password to open the Channel. The features 
available to each user are controlled through their assigned Role. This setting cannot be 
undone.  
In Policy Commander, all channels are secured. 
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 Secure this Channel: With this option turned off, the Channel is not secured. Anyone 
using the Console who has access to the computer where the Channel Server is installed 
can open the Channel. 

Users 

The upper section of the dialog box lists the users who have access to the secured Channel and 
the roles assigned to each user. The currently logged-in user is shown in the title bar in 
parentheses. All of the users listed have permission to open the Channel. Other permissions 
available to each user depend on the assigned role. 

 Add User: Add a user who can open the Channel. The actions that this user can take in 
the Channel are determined by their assigned Role. When you click this button, the 
Manage User dialog box opens. 

 Edit User: Assign a different role or email address to the highlighted user. The user’s role 
gives them access to data and options in the Channel. When you click this button, the 
Manage User dialog box opens. 

 Set Password: Set or change the password for the highlighted user. This password is 
required for opening the Channel. When you click this button, the Set User Password 

dialog box opens. 

 Delete: Delete the highlighted user. This person can no longer open the Channel. 

Roles 

The lower section of the dialog box lists the roles available in this Channel. The roles define the 
permissions or privileges available to users assigned to the role. You can assign the predefined 
roles provided with every Channel or set up your own roles. 

Each Channel automatically includes predefined roles, including Channel Admin, Help Desk, 
Report Admin, and so on. These roles are marked with * and cannot be edited. 

 Add Role: Add a new role. When you click this button, the Create New Role dialog box 

opens. 

 Properties: Set each of the features, actions, or parts of the Channel that the role can 
use or view. For example, the role may include permission to add computers or read 
reports. When you click this button, the Role Properties dialog box opens. 

 Delete: Delete the highlighted role. 

 Secured Groups: This opens the Secured Groups dialog, which lists all of the groups 

that have 1 or more roles that are restricted from accessing the member computers. 

You cannot delete the role if any users are assigned to the role. Before deleting the role, assign 
users to a different role. Then use the Delete button to remove the role. 
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Manage User dialog 

 

On the Manage User dialog box, you can add user names and set a user’s role, password, and 
email. 

This dialog box opens when you click the Add User or Edit User button in the Users section of 
the Manage Channel Security dialog box. The fields that are available for editing on this dialog 
box depend on your starting point. 

The options include: 

 User Name: The name or login for the person whose information is being updated. The 
user name is assigned by the Channel Admin. The user enters this name when opening 
the Channel. This field is enabled only when using Add User. 

 Role: The role assigned to the user. The role defines the user’s permission to view data 
and use features in the Channel. Each user is assigned only one role. The roles and 
permissions are set up through the Manage Channel Security dialog box. 

 Password: The user's new password is entered in this text box. The password must be 
used the next time the user logs in to the Channel. This field is enabled only when using 
Add User. 

 Confirm password: Retype the new password to confirm it. 

 Email Address: The user's email address. 

Role Properties dialog 

On the Role Properties dialog box, set or fine-tune the permissions for the selected Role. Users 
can only select items or actions permitted by their role. All other icons, menu items, and items in 
the Console are grayed out. For example, use the permissions to set up a role that is only 
allowed to Add Groups, but not make other changes. 

The Role Properties dialog box opens when you click the Properties button on the Manage 
Channel Security dialog box. Two tabs are available on the Properties dialog: the Permissions tab 
and the Secured Groups tab. 
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Permissions Tab 

On this tab, select the permissions for the role. You can grant access to all actions related to an 
item or limit the permissions to only specific actions. With an action selected, users can perform 
the selected action. For example, use individual check boxes to grant permission to add 
computers but not delete them. With the check box cleared, the action cannot be performed by 
users assigned to the role. 

For example, to let a role add groups, either select the Groups check box to give permission to 
all aspects of working with groups or select the Add Groups option within the Groups branch to 
let the users add groups but not delete them. 

Secured Groups Tab 

 

This tab shows the computer groups that are secured from this role. Computers in these groups 
cannot be modified by this role, even if the role would otherwise have permission. Those 
computers are effectively "read-only" to users belonging to that role. For example, a role with 
permission to assign policies to computers would not be allowed to assign policies to computers 
in the listed groups (either directly or via groups to which those computers belong). 

Groups secured from a role are not visible to that role in the console. However, the member 
computers remain visible. 

Secured groups have a special icon indicating that one or more roles are secured from that 
group. 

Press Add to add a group to the list. To remove a group from the list, select it and press 
Remove. 

Creating and Assigning Roles 

Roles define the permissions or privileges assigned to users in a secured Channel. By default, 
Policy Commander includes several roles that you can assign to individual users. You can also 
create your own roles to match the needs of your organization. 

Note: To create, assign, or edit roles and permissions, you must open the Channel using the 

Channel Admin user name and password. 
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Assign a Role 

Roles are assigned by the Channel Admin: 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, highlight a name in the list of users in the 
upper part of the dialog box. 

3. Click the Edit User button. 

4. On the Manage User dialog box, select a role for the person from the drop-down list in 
the Role field. 

Create a New Role 

Roles and their permissions can be set up by the Channel Admin. 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, click the Add Role button under the list of 
roles in the lower part of the dialog box. 

3. On the Create New Role dialog box, enter a name and description for the role. Press OK. 

4. Select the new role and press Properties. 

5. On the Role Properties dialog box, set the specific permissions or privileges that are 
granted to this role. Press OK. 

6. Assign one or more users to the role on the Manage Channel Security dialog box. 

Edit an Existing Role 

The permissions set for an existing role can be changed by the Channel Admin. 

Note: Roles marked with * cannot be edited. 

1. Select Security | Configure Security. 

2. On the Manage Channel Security dialog box, highlight a role in the list in the lower part of 
the dialog box. 

3. Click the Properties button. 

4. On the Role Properties dialog box, set the specific permissions or privileges that are 
granted to this role. Press OK. 

Changing a Password 

Each user who has permission to open the Channel also has an assigned password. This 
password can be changed by the Channel Admin or by an individual user. 

Caution: If you lose or forget the password, the Channel Admin can assign a new password, but 
not retrieve an existing password. 

Change your own password 

1. Select Security | Change User Password. 

2. On the Change User Password dialog box, enter your new password. 

The next time you open this Channel, use the new password. 

Change the password for another user 

The Channel Admin can set or change the password for each user who has access to the 
Channel. 
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1. Select Security | Configure Securty. 

2. On the Manage Channel Security dialog box, highlight the user’s name. 

3. Click the Set Password button. 

4. On the Set User Password dialog box, enter the user's new password. 

The next time this user opens the Channel, they must use the new password. 

Channel Properties 

Loading the Channel at Startup 

With the Load Last Channel option on the Console's File menu, choose whether to 
automatically open the Console to the Channel you used most recently. 

 Load Last Channel: With this option selected, when you open the Console, the 
Channel you viewed most recently is displayed in the main window. Select this option if 
you frequently use the same Channel. This option is the default. 

 Load Last Channel: With this option turned off, when you open the Console, Policy 
Commander displays the Select the Channel you wish to manage dialog box. You can 
choose a Channel to open, create a new Channel, or find an existing Channel. If you 
maintain and frequently use more than one Channel, you may choose to turn this option 
off. 

Defining Channel Properties 

The Channel Properties dialog box defines the properties for the Channel currently displayed in 
the Console window. The tabs of the Channel Properties dialog box: 

 Display information about the Channel. 

 Control the auto-population and auto-licensing options. 

 Help you manage the licenses assigned to the Channel. 

View and define the Channel properties 

To view and define properties for the Channel, select File | Channel Properties. The 
Properties: <Channel name> dialog box opens. 

Tabs on the Channel Properties dialog box 

The tabs on the Channel Properties dialog box include: 

 General tab 

 Settings tab 

 Licenses tab 

 Maintenace tab 
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General Tab (Channel Properties) 

 

The Channel Properties | General tab displays information about the Channel that is currently 
open in the Console main window. This dialog box is displayed when you choose File | 
Channel Properties. 

The information includes: 

: The name of the Channel 

Server: The name of the computer where the Channel Server is located 

Channel Identifier: A unique number that identifies this Channel. This number is also recorded in 
the registry of computers that subscribe to this Channel and computers used to manage the 
Channel using the Console. 
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Settings Tab (Channel Properties) 

 

Use the Channel Properties | Settings tab to set automatic population and auto-licensing 
options. When enabled, the Auto-Populate and Auto-License options save you time by populating 
the Channel with computers and groups and automatically assigning Policy Commander licenses. 

You can use a subscription file to install the Client software on a computer and subscribe the 
computer to a particular Channel. This causes the computer to contact the Channel Server and 
identify itself. However, the computer will not become actively managed in the Channel until the 
computer has been assigned a Policy Commander license. In this scenario, if you want to 
automatically license and manage the computer, turn on the Auto-Populate and Auto-License 
options. If you want to manually control which computers become managed in the Channel, turn 
these options off. 

This dialog box is displayed when you choose File | Channel Properties then click on the 
Channel Properties | Settings tab. 

Auto-Populate 

 Create new computers: Automatically add computers when they start up or contact the 
Channel Server. To contact the Channel and receive Tasks, a computer must have the 
Client installed and the Client must subscribe to the Channel. 

 Create new groups: Automatically create new organizational groups and sub-groups 
based on Network Containers defined as part of AD (Microsoft's Active Directory) when 
the computers contact the Channel Server. Computers must be identified within the 
Channel by their Active Directory name. 

 Add computers to groups: Automatically add computers to organizational groups if the 
Create new groups option on this tab is selected and the network uses AD (Active 

Directory). 
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Note: For the computers and groups to auto-populate, the Client must be installed on the 
computer and the Client must subscribe to the Channel. 

Auto-License 

 Policy Commander: Automatically assign a Policy Commander license to computers. 

The Channel will not distribute changes to or receive updates from a computer that does not have 
a Policy Commander license. 

Licenses tab (Channel Properties) 

 

Use the Channel Properties | Licenses tab to view information about licenses assigned to the 
Channel, add licenses so they will be available to new computers as they are added to the 
Channel, and remove licenses from the Channel Server. Each computer must have an 
appropriate workstation or server license to receive changes from and respond to the Channel. 

When you add license keys to the Channel Server, they are available for the computers added to 
the current Channel and all other Channels connected to the same Channel Server. 

This dialog box is displayed when you choose File | Channel Properties then click on the 
Licenses tab. 

Views Available 

Summary: List the licenses by type with the total number currently in the Channel. 

Details: Lists each of the license keys added to the Channel, along with the number of licenses 
available in each. 
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Add Licenses with a License Key 

If you received a license key for licenses from New Boundary Technologies: 

1. On the Channel Properties | Licenses tab, click Add. 

2. In the Add License Keys dialog box, either type the license key or browse for the license 
file. 

The Licenses are added to the server and are available in all Channels. 

Add Licenses with a File 

If you received a License Pack file (.SFTCHL) from New Boundary Technologies: 

1. Save the files on your computer or on the network. 

2. On the Channel Properties | Licenses tab, click Add. 

3. In the License keys dialog box, browse to the location of the license pack file you 
received. 

The Licenses are added to the Channel Server and are available in the current Channel. The 
original license files can be stored in their original location, moved, or deleted. 

Remove Licenses 

If you wish to add licenses to a different Channel Server, they can be removed from the computer 
where the Channel Server is located. However, you cannot remove licenses that are in use. 

1. Highlight a license key in the list. 
 
If any of the licenses in the key are in use, the managed computers must be unlicensed 
before removing the license key. 

2. Click Remove. 

The Licenses are no longer assigned to the Channel Server. These Licenses can now be used 
for another Channel Server if you wish. 

Purchase additional License keys 

Contact your reseller or New Boundary Technologies. (To contact New Boundary Technologies, 
visit our Web site at www.newboundary.com or call 800-747-4487 or 612-379-3805.) 
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Maintenance tab (Channel Properties) 

Use the Channel 
Properties | Maintenance tab to administer the channel database. 

This dialog box is displayed when you choose File | Channel Properties then click on the 
Maintenance tab. 

Database Maintenance 

Defragment database indexes: With this option selected, Policy Commander will 
automatically defragment the channel's database indexes. You can select whether this 
should occur Daily, Weekly, or Monthly. This option is selected by default. 

Delete old channel data 

These options allow you to delete older data that can accumulate and eventually degrade 
database performance. 

Delete admin auditing log entries older than: With this option selected, the 
administration log will be purged of entries older than the specified number of days. 

Delete policy compliance history entries older than: With this option selected, the 
compliance history will be purged of entries older than the specified number of days. 

Delete computers that are inactive for over: With this option selected, computers will 
be deleted from the channel if they have not polled the server within the specified 
number of days. This can be used to recover unused Policy Commander licenses. 

Start time 

Specifies the time each day when the database maintenance should occur. 
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Managing Computers 

About Managed Computers 

The Manage Computer Expert dialogs step you through the process of managing a computer. 
The process consists of these steps: 

 Assign a license. 

Policy Commander can automatically assign licenses or you can manually assign 
licenses. Once a computer has been assigned a license, it appears in the Manage tab of 
the console. However, a computer cannot be actively managed until client software is 
installed. 

 Adjust Client Settings for the installation. 

You can accept the Channel's default client settings (recommended) or you can override 
the settings for a specific computer. These settings include the ability to specify alternate 
credentials to use for the client installation. 

 Install the client software. 

You can install the Client directly over the network or by creating a subscription file. When 
you directly install the software,  Policy Commander immediately pushes the client to the 
target computer; when you install via a subscription file, you must first create the 
subscription file and then distribute the file to the target computer where it must be run. 

Note:  A computer can become managed only if it has been assigned a license. If you install the 
client software on a computer via subscription file, the computer does not appear in the 
Managed tab unless the computer has been assigned a license. 

Adding Computers 

Installing the Client Directly over the Network 

For computers on a Microsoft network that are turned on, you can directly install the Client from 
the Console, quickly adding the computers to the Channel. 

Add the Computer to the Channel and Install the Client 

To install the Client and begin managing the computer immediately: 

1. Highlight the name of the computer on the Network tab. 

Note: You can add a number of computers at one time. Select a group of computers in the 
details pane by pressing the Ctrl key as you click on computers or by pressing the 
Shift key as you click on the first and last computer. 

2. Use one of these options: 

 Select Computers | Manage Computer. 

 Right-click on a computer on the Network tab and choose Manage Computer 
from the pop-up menu. 

3. In the Manage Licenses dialog box, make sure that a license is assigned (either 
automatically or manually). 

4. Click Next. 
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5. Choose Now via Direct Client Installation for the Client Installation method. 

6. If you need to override the default settings for this computer, click the Settings button. 

 On the Polling tab, clear the Configure the Client to automatically apply new 
Channel settings check box. 

 On each of the tabs in this dialog box, adjust the settings as required for the Client. 

 When you have finished, click OK. 

7. Click Advanced Options if you need to specify paths and folders for installation options. 
When you have finished specifying Installation Options, click OK. 

8. Select the Use alternate credentials check box if you wish to use alternate credentials 
for the client installation. This can be useful if you are installing across domains or where 
you do not have centralized administration accounts. 

9. Select the Reboot computer after installation check box. 

10. Click Install to install the Client. 

11. Click Finish when the installation is complete. 

Note   The Client Installation dialog and Members tab display client installation status. If the 
Client installation was not successful, remove the obstacle to the installation and try 
again. For example, if the installation was unsuccessful because the managed computer 
was turned off, start up the computer, and then install the Client. 
 
The computer will not communicate with the Channel until the Client is installed and the 
computer subscribes to the Channel. 
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Manage Computers Expert 

The Manage Computers Expert displays the Managed Licenses dialog as the first of two dialogs 
you use to add computers to the Channel. 

Managed Licenses Dialog 

 

This dialog box opens from the Network tab when you select Computers | Manage Computer or 
right-click on a computer name and choose Manage Computer. This dialog also opens from the 
Managed tab when you select Computers | Manage Licenses or right click on a computer name 
and choose Manage Licenses. 

Licenses Tab 

Displays the selected computers along with corresponding license options. Each computer must 
have at least one available license assigned to be a managed computer. Depending on whether 
the Channel has enabled auto-licensing (the default), the display allows either view only or 
editing. 

 Auto-Licensed Enabled - When auto-licensing is enabled, the system automatically 
assigns an appropriate available license and displays the message Auto-licensed in the 
product license column. You cannot manually change license assignments when auto-
licensing is enabled. 

 Auto-License Disabled - When auto-licensing is disabled, use this dialog to assign 
licenses. To assign a license, click on the selection box for the product. To unassign a 
license, clear the box for that product. 

Enter Button 

The Enter button allows you to manually add computers to the channel by name. This button is 
available when managing new computers. To manually add a computer: 



Policy Commander 

54 

1. Click Enter. 

2. Enter the name of the computer, and click OK. 

License Information 

Displays the current status of Policy Commander licenses in the Channel. As you add computers 
to the display and licenses are assigned (either automatically or manually), the following icons 
and messages are displayed to indicate the current license status: 

Icon Description 

 

Indicates that all listed computers have been assigned at 
least one license. Also lists the licenses still available for 
the channel. 

 

Indicates that one or more computers have not been 
assigned licenses and will not be managed. Check the 
display to find the computers that have not been assigned 
licenses. 

 

Indicates that although all listed computers have been 
assigned at least one license, you have attempted to 
assign an additional product license that is not available. 
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Client Installation Dialog 

 

On this dialog, choose the client installation method and options for the computer. 

Install Status 

This panel lists the computer name and, if the Client Installation Method is Now by Direct Client 
Installation, the installation status for each computer being added to the Channel.  If the 
installation fails, the status column shows details about the cause of the failure. 

Note   The status information can be saved to an external file by right-clicking in the Install 
Status panel and selecting the Save Installation Status As menu option. This can be 

useful for later troubleshooting of installation problems. 
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Client Installation Method 

There are two methods by which the client can be installed on target computers: 

Now by Direct 
Client 
Installation 

Install the Client on the computer directly from the Console. The 
Client is installed over the network immediately, if the computer is 
online. 
 
After choosing this option, set your Client Settings and Options 
(below) and click the Install button to install the Client. The results 
of the installation are displayed. Click Finish when the install 
completes successfully. 

Later via 
Subscription 
File 

The computer is assigned a license, but the Client is not installed 
on the computer. Choose this option to add one or more computers 
that cannot be reached by the direct install method, for example, if 
they are not currently connected to the network. 
 
After choosing this option, click Finish to add the computer to the 
Channel. When you are ready to install the Client on this computer, 
create a subscription file. You can distribute this file via e-mail, a 
web page, login script, or any other method. 

Client Settings and Options 

If you choose Now by Direct Client Installation as the installation method, you can modify the 
following settings and options: 

Settings Allows you to override the Channel's default client settings. See 
Applying Unique Settings to a Client. 

Advanced 
Options 

Allows you to specify the location on the managed computer at 
which installation files are stored. 

Use alternate 
network 
credentials 

Checking this allows you to specify an alternate account to use 
for installing the client. This can be very useful when installing 
across domains, or where administration accounts are not 
centrally administered. 

Press the "Credentials" button to enter the user credentials 
(domain, user name, and password) to use for the client 
installation. 

Reboot computer 
after installation 

When selected, automatically reboots the client computer after 
installation. 

   

If you choose Later via Subscription File as the installation method, settings and options can be 
modified when you create the Subscription File. 
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Installation Options dialog 

When installing the Client directly, the installation files are stored temporarily in an administrative 
share on the target computer. By default, this location is on the C: drive. On this dialog box, you 
can specify a different location for storing the Client files during the installation. For example, if 
you are using Citrix, the target computer does not have a C: drive, so you must specify a different 
location. 

Specify a root partition or volume as the drive letter name appended with the $ sign. For example, 
drive letters C and D are shared as C$ and D$. 

This dialog box opens when you click the Advanced Options button on the Client Installation 
dialog or Subscription File dialog. 

Specific Installation Folders 

Either leave these three edit boxes blank to accept the default paths or enter a path to override 
the default path where client files will be installed. This also overrides a current install of the client 
files if they exist on the target computer. 

 Client Executables.  Specify the path where the New Boundary Clients and help files will 
be installed. If left blank, the files are installed to either the current path of an existing 
install of the files or the default path Program Files\New Boundary\Client. 

 Services and DLLs.  Specify the path where the New Boundary Services and shell 
extensions files will be installed. If left blank, the files will be installed to the default path 
Common Files\New Boundary\Client. 

 Temporary Files.  Specify the working directory for Policy Commander temporary files. 
These include rollback files, inventory files, and checkpoint/restart files. If left blank, the 
Client will use the default path Documents and Settings\All Users\Application 
Data\Prism Deploy. 
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Subscription Files 

Creating a Subscription File to Distribute to Users 

For computers that are not on the corporate network or those that do not use Microsoft 
networking, use the Console to create a subscription file you can distribute to these computers. 
The subscription file installs the Client and sets the Client to subscribe to the Channel. If the 
default auto-populate and auto-license options are set for the Channel, the computers are 
automatically assigned licenses when they contact the Channel Server. 

Note: Using a subscription file to install the Client for the first time requires an administrator (a 
user with administrative privileges).  However, an administrator is not required if the 
Client is being upgraded from a previously-installed version. 

Create the subscription file 

To create a subscription file for the current Channel: 

1. Select Computers | Create Subscription File. The Subscription File dialog box 
displays. 

2. Select the Install or Update the Client option. 

3. Click Settings and adjust settings on the following tabs: 

 Polling 

 Server 

 Web Proxy Server 

 Policy Commander 

Note: If you do not want the Channel settings automatically applied to the managed computer, 
you must turn off the automatic update option on the Polling tab. See Applying Unique 
Settings to a Client for more information. 

4. Click Advanced Options if you need to specify paths and folders for installation options. 
When you have finished specifying Installation Options, click OK. 

5. Click OK on the Subscription File dialog to save your changes. 

6. On the Save Subscription File dialog, enter a name for the new subscription file. 

7. Distribute the subscription file to the computers. 
 
For example, distribute the file by attaching it to an e-mail message, placing it on a Web 
site, or including it in a login script. When the Subscription file is executed, it installs the 
Client and subscribes to the Channel. 
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Subscription File dialog 

 

A subscription file can be used to install the Client on a computer and set the Client to subscribe 
to the Channel. Use a subscription file to install the Client on remote computers or computers 
where the Client cannot be installed directly from the Console. A subscription file can also be 
generated that un-installs the Client from a computer. 

The Subscription File dialog box opens when you select Computers | Create Subscription File. 

Option 

Select an option to determine the type of subscription file you are generating: 

 Install or update the Client: Install the Client for the first time or update an existing 
Client to match the settings specified for this subscription file. (See Applying Unique 
Settings to a Client.) 

 un-install the Client: un-install the Client on the target computer. After deleting the 

computer from the Channel, generate this subscription. 

Client Settings and Options 

When you are creating an install or update subscription file, the Client Settings allow you to 
override the default client settings for a channel. 

Settings 

The Settings button allows you to set the following (for more information on these options, please 
refer to the section entitled Working with the Client later in this document): 

 Polling 

 Server 

 Web Proxy Server 

Note: If you do not want the Channel settings automatically applied to the managed 
computer, you must turn off the automatic update option on the Polling tab. See 
Applying Unique Settings to a Client for more information. 
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Advanced Options 

The Advanced Options button allows you to specify paths and folders for installation options. 

By default, the settings in the Subscription file match those set for the Channel through File | 
Client Settings. Click the Settings button to adjust the settings installed with the subscription file. 
Please note: 

 If the Configure the Client to automatically apply new settings for this channel 
option has been cleared on the Client Settings | Polling tab, the values set through this 
dialog box are installed on the Client computer. For example, select this option for remote 
computers or computers on the network that need specific settings, not the default 
settings for the Channel. 

 If the Configure the Client to automatically apply new settings for this channel 
option is selected on the Client Settings | Polling tab, the Channel settings are applied the 
next time the Client contacts the server. (See Automatically Maintaining Client Settings.) 

Save the Subscription File dialog 

Provide a name and location for saving the Subscription file. The file is saved when you click 
Save. 

Enter this information: 

 File name: Type the filename for the new subscription file you are creating. 
 
This file can be saved on a network server, web server, your own computer, or anywhere 
else you choose. From this location, you can distribute the Subscription file via e-mail, 
post it on a web page, place it in a login script, or use another method for distribution. 

 Save as type: The subscription file is an executable file (.EXE), which you can run on the 

managed computer(s). 

Managing Policy Commander Licenses 

Each managed computer must have a Policy Commander license assigned. A License Key 
defines a block of licenses that are assigned or could be assigned to computers in the Channel. 
This block is available from New Boundary Technologies as a license key received via e-mail or 
as a binary, encrypted file. When you installed Policy Commander, a block of licenses were 
installed along with the application. 

Use these evaluation Licenses to get started setting up your Channels and computers. When you 
purchase permanent Licenses, everything you set up while using the Evaluation Licenses 
transfers to the purchased Licenses. To purchase additional Licenses, please contact your 
reseller or New Boundary Technologies. (To contact New Boundary Technologies, visit our Web 
site at www.newboundary.com or call 612-379-3805 or 800-747-4487.) 

Note: ALL computers that receive software, updates, or other changes via a Channel must have 
a valid license. 

  

Assign Licenses to Computers 

Policy Commander licenses can be assigned automatically or manually. 

Auto-Licensing 

By default, auto-licensing is enabled. When you begin managing a computer and a license is 
available, the Channel automatically assigns an appropriate license to each computer. The auto-
license options are set on the Channel Properties | Settings tab. 
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The evaluation licenses assigned to computers initially are automatically replaced by permanent 
licenses when you add them. 

Manual Licensing 

If you disable auto-licensing, you can manually assign licenses when you add a computer to the 
channel. In addition, you can change license assignments for managed computers using the 
Computer | Manage Licenses dialog, as well as the managed computer pop-up menu option 
Manage Licenses. 

Status of the License When You Remove a Computer 

When a managed computer is removed or deleted from the Channel, its license or licenses are 
added to the pool of licenses available to computers in the Channel. 

When a computer is removed from the network but it remains listed within the Channel, the 
licenses remain assigned to that computer. If you want to make the license or licenses available 
to other computers, the computer must be deleted from the Channel. 

  

Client on Target Computers 

Working with the Client 

The Client is the software that runs on target computers and communicates with the Channel 
Server to report information about the managed computer and to act on changes initiated through 
the Console by the administrator. 

The Client can be installed directly on computers from the Console or installed with a subscription 
file generated through the Console. After it is installed, the Client begins polling the Channel 
Server to report information and receive instructions. 

Each time the Client polls the Channel Server, it does the following: 

 Provides detailed information about its status and configuration. 

 Checks for new configuration rules that may apply. 

 Receives and installs updates or other changes based on configuration rules or other 
criteria set by the administrator. 

Note   You cannot edit Policy Commander files using the Client. 

The polling interval and other communication settings for the Client are controlled automatically 
by setting default values for all managed computers in the Channel or can be set for individual 
machines by installing the Client on that computer with specific values. 

Note   An on-demand poll can be initiated by right-clicking on a computer and selecting Request 
Poll. This forces the client to poll independent of its defined polling interval. 

Installing the Client 

The Console gives you the following options for installing the Client: 

 Install the Client directly over the network (See Installing the Client Directly Over the 
Network.) 

 Create a subscription file that you distribute to users for installing the Client. This file can 
be included within a Group Policy Object, downloaded from a web site, enclosed in an e-
mail message, or placed in the login script for computers. (See Creating a Subscription 
File to Distribute to Users.) 
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Client Status Values 

The client installation status displayed on the Members tab and in the Client Installation dialog 
can have many different values. The possible client status values and their meanings are: 

 Invalid Status Code 

 Never contacted - the client has never contacted the server 

 Attended - the client is installed successfully, and at least one user is logged in 

 Unattended - the client is installed successfully, but no user is logged in 

 Attended (suspended) - the client is installed successfully, at least one user is logged 

in, and the machine is in a suspended (sleep) state such as hibernate or standby. 

 Unattended (suspended) - the client is installed successfully, no user is logged in, and 
the machine is in a suspended (sleep) state such as hibernate or standby 

 Offline (known) - the client is installed successfully, the machine is off, and the client 

shutdown gracefully (i.e., was able to send a status to the server before shutting down). 

 Offline (guessed) - the client is installed successfully, the machine is off, but the client 
did not shutdown gracefully. 

 Client stopped 

 Client stopped - Subscription install in progress 

 Client stopped - Install in progress 

 Client stopped - Direct install in progress 

 Uninstalled 

 Unsubscribed 

 Install in progress 

 Uninstall in progress 

 Unsubscribe in progress 

 Install succeeded - a direct install succeeded 

 Install succeeded, needs reboot 

 Install succeeded, launch failed 

 Direct install failed (Access denied) 

 Direct install failed (Computer not found) 

 Direct install failed (Source unsupported) 

 Direct install failed (No RPC) 

 Direct install failed (Target unsupported) 

 Direct install failed (Registry access) 

 Direct install failed (Missing source) 

 Direct install failed (Busy source) 

 Direct install failed (Invalid target folder) 

 Direct install failed (Target folder missing) 

 Direct install failed (Target file busy) 

 Direct install failed (Registry write failed) 

 Direct install failed (Target insufficient) 

 Direct install failed (Client launch failed) 



Managing Computers 

63 

 Direct install failed (Timeout) 

 Direct install failed (Cancelled) 

 Install fail code 

 Install failed (File copy failed) 

 Install failed (Source deleted) 

 Install failed (Service install failed) 

 Install failed (User stopped) 

 Install failed (Insufficient disk space) 

 Install failed (Invalid OS) 

 Install failed (Invalid file) 

 Install failed (Insufficient permissions) 

 Install failed (File access failed) 

 Install failed (File busy) 

 Install failed (File corrupt) 

 Install failed (File missing) 

 Install failed (Duplicate file exists) 

 Install failed (Apply failed) 

 Install failed (Service failed) 

 Install failed (Command failed) 

 Install failed (Reason unknown) 

 Local Install failed (Run console as Administrator) 

 No client installation attempted 

  

Setting the Client Communication Parameters 

By default, the settings that control communication between the Client on a managed computer 
and the Channel server are specified through the Console. Depending on your needs, you can 
establish a single set of values that are applied to all managed computers or you can use 
different settings for a subset of individual Client computers. 

For example, if all of the computers you manage are on your internal LAN, automatically apply 
the same settings to all computers in the Channel. If you have a number of managed computers 
that are remote, you may wish to provide different settings for the WAN systems versus the LAN 
systems. 

Setting the Default Values 

To set the default values for managed computers in the Channel, choose File | Client Settings. 
On the Client Settings dialog box, set values on these tabs: 

 Polling 

 Server 

 Web Proxy Server 

 Policy Commander 

How the Default Values are Used 

Default values set through the Console are used: 
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 As the default values when the Client is installed directly or with a subscription file. (See 
About Managed Computers.) 

 When the Configure the Client to automatically apply new settings option is selected 
on the Polling tab, the default settings are applied to each Client as it contacts the 
Channel Server. 
 
Exclude an individual managed computer from this automatic update by turning off this 
option when you install the Client on that computer 

Setting the Client Values Automatically or Individually 

Policy Commander lets you automatically apply a single set of communication parameters to all 
Clients or adjust the settings independently for specific Clients or selected managed computers. 
For more information, see the following topics: 

 Automatically Maintaining Client Settings 

 Applying Unique Settings to a Client 

Polling tab 

 

On this tab, adjust the interval at which the Client on a managed computer polls or contacts the 
Channel Server for updates. This information is used for the Client that is added directly from the 
Channel and as the default value for subscription files. Your starting point determines how the 
information on this tab is used. 

This dialog box opens when you select one of these options: 

 File | Client Settings: The values on this dialog are used as the default for installing the 
Client and may be used to automatically update the Client on managed computers. See 
Automatically Maintaining Client Settings. 

 Settings button on the Client Installation dialog: Set the communication values used 
when the Client is installed directly from the Console. See Setting the Client 
Communication Parameters. 
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 Settings button on the Subscription File dialog, which is access through the Computers 
| Create Subscription File menu: Set the communication values used when the Client is 
installed using a subscription file. See Creating a Subscription File to Distribute to Users. 

Set the Polling option 

Choose one of these four Polling options that define how often the Client should check with the 
Channel Server for new updates: 

 Poll Continuously: The Client contacts the Channel Server constantly. This option 
requires more processor time and bandwidth than the following options. It is used only for 
a small number of computers in a test lab. 

Caution: Do not use this setting for your production environment. 

 Poll once every   minute(s): The Client contacts the Channel Server at the 
interval you set. The interval is a number of minutes. 
 
The Client requires very little bandwidth, so the default value is 10 minutes. The polling 
interval may need to be adjusted up or down, depending on these factors: 

 the number of computers in the Channel 

 the number of groups in the Channel 

 how frequently you assign policies from the Channel 

 Poll once every hour(s): The Client contacts the Channel Server at the interval 
you set. The interval is a number of hours. 

 Poll once every day: With this setting, the Client contacts the Channel Server for 
updates at the start of each session. A session begins when a user logs on to the 
computer. There is also an unattended session when the computer is turned on but there 
is not a user logged on. 

Notes  Please contact Technical Support for recommendations on the optimal polling interval 
for your situation. 
 
The default polling interval is 10 minutes. The default polling interval is set when you 
create the Channel. 

Set how often to check for poll requests 

This setting defines whether or not the Request Poll capability is enabled for a Client, and, if 
enabled, defines how often the Client should check for a request for a poll. The Request Poll 
feature allows the user to request that the client poll the server independent of the polling interval 
defined above. It is effectively an "on demand" poll. 

This option is not enabled if the polling frequency, above, is set to Poll Continuously. 

 Check for poll request every  minute(s): With this option selected, the client 
contacts the server at the specified interval to determine if a request has been issued 
for the client to make a poll. If it finds a request, it immediately polls the server  to 
obtain all updates. The minimum value is 1 minute. Since the check has very low 
overhead,  this check can be made at a significantly higher frequency than a normal 
poll. 

 Check for poll request every  minute(s): With this option cleared, the client 
will not check to see if a Request Poll has been issued, and the Request Poll context 
menu option will be disabled for that client. 
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Configure the Client to Automatically Apply New Settings for this Channel 

When opened through the File | Client Settings menu, this tab contains an option that controls 
how the settings specified affect Clients. 

 Automatically apply settings to all clients: With this option selected, all clients will 
inherit the settings made in this tab. This will occur automatically for existing clients 
the next time they poll the Channel Server as well as for new clients. Each client will 
automatically be updated whenever client settings are changed for the channel. 

 Automatically apply settings to all clients: With this option cleared, the client 
settings are set individually for each managed computer. The settings on this tab 
become the default values. They are established (and can be modified) when the 
Client is installed directly or through a subscription file. To change the settings for an 
existing Client, you must reinstall the Client with the new settings. 

Configure the Client to Display an icon in the client computer's task tray 

 

When opened through Settings button on either the Client Installation or Subscription File 
dialogs, this tab contains an option that controls whether or not the client icon should appear in 
the managed computer's system tray (notification area) of the taskbar. 

 Display icon in the client's system tray: With this option selected, an icon will appear 
in the managed computer's system tray after the client is installed. In addition to 
providing a visual indication of the presence of the client, enabling this option provides 
a configurable set of administration functions to be performed directly on the managed 
computer. 

 Display icon in the client's system tray: With this option cleared, no icon is displayed 
in the managed computer's system tray. This is the default setting. 



Managing Computers 

67 

Request Poll 

Independent of the polling frequency specified for a client, an "on demand" poll can be initiated at 
any time by right-clicking on a managed computer and selecting Request Poll. This forces the 
client to perform a one-time poll independent of the Client's normal polling interval. 

The Request Poll option can be enabled via the File | Client Settings menu or when direct 
installing or creating a subscription file. On the Polling tab of the Client Settings dialog, select a 
non-continuous polling frequency. Then, select the checkbox labelled Check for poll request 
every, and specify a frequency for the check. Refer to the  Polling tab section for more 
information. 

Note    If Check for poll request every checkbox has not been selected for a client, the 
Request Poll context menu option will be disabled. Furthermore, the user must have Edit 

Computer permission to invoke Request Poll. 

Clients implement the Request Poll capability by pinging the Channel Server periodically to see if 
the user has made a request for a poll. If a request is found, the client will immediately poll the 
server to obtain all updates. You specify the frequency of this check by setting on the Polling tab 
of the Client Settings dialog. 

Server tab 

 

On this tab, change the name of the computer where the Channel Server resides or change the 
format of the name. Your starting point determines how the information on this tab is used. 

 Console Settings: Specifies how the Console will communicate with the Channel Server. 

 Client Settings: Specifies how the Clients will communicate with the Channel Server. 

Computer Name 

Enter the name of the computer where the Channel Server is installed. Enter the name in the 
format that the Console or Client computer can use to contact the Channel Server. For example, 
if the managed computer contacts the Channel Server via the Internet, rather than the corporate 
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network, use an IP address or URL, not the computer name. The name can be entered in any of 
the following formats: 

 Computer name, for example CHANNELSERVER 

 IP (Internet Protocol) Address, for example 127.0.0.1 

 URL (Uniform Resource Locator), for example www.yourcompany.com 

It is critical to identify the correct computer. 

If the name is entered as the computer name (SERVER), you may choose to change the name if 
the resolution of the network name affects performance. In this case, you could specify the IP 
address instead. 

Connect to the Channel Server using port 

The Console and Clients connect to the Channel Server using the specified port. Both the 

Console and the Clients must use the same port. Type a number in the text box or use the  to 
scroll to a number. 
 
We recommend using one of the following port numbers: 

 Policy Commander User Port (port 3133) 

 World Wide Web HTTP Port (port 80) 

 Dynamic or private port (ports 49152 to 65535) 

Note: By default, Policy Commander uses port 3133 for communicating between the Client 
and the Channel Server, and the Console and the Channel Server. This port is an 
official assignment made by the IANA [Internet Assigned Numbers Authority 
(www.iana.org)]. 
 
If the Client must communicate with the Channel through a firewall, you may need to 
open port 3133 on the firewall. Otherwise, we recommend using port 80, since that 
port is typically already open for web browsing, or using the Proxy Server option 
(below). 

Connection times out after 

Set the number of seconds that the Console or the Client on the managed computer will keep 
trying to contact the Channel Server. If the Client fails to make contact during the time out period, 
it waits until the next polling time to try contacting the Channel Server again. 
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Web Proxy Server tab 

 

The Web Proxy Server settings provide the option of having the Console and/or Clients connect 
to the Channel Server over HTTP/HTTPS. This is useful for machines that may be outside a 
corporate firewall, or laptops that are sometimes on the corporate network and sometimes 
outside the corporate network. 

Enabling this feature means that Channel Servers that are behind a firewall can still be accessed 
by the Console and/or Clients without using a VPN. However, it requires that you install the Proxy 
Server on IIS. 

Your starting point determines how the information on this tab is used. 

 Console Settings: Specifies how the Console will communicate with the Channel Server. 

 Client Settings: Specifies how the Clients will communicate with the Channel Server. 

Use Web Proxy Server 

This option specifies when to use the Web Proxy Server. 

o No: Do not use the Web Proxy Server for communication to the Channel Server. 

This is the default setting. 

o Yes: Always use the Web Proxy Server. All communication will occur over HTTP 

through the Proxy Server. 

o Auto: With this setting, the Console/Client will first try the default channel 
communication. If that communication fails, it will use the Web Proxy Server and 
communicate over HTTP. 

Note  Using the Proxy Server option (Yes or Auto) requires that you install the Proxy 
Server on IIS on a machine that can access the Channel Server. 
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Web Proxy Server Host 

This is the address of the Web Proxy Server. It should not include the protocol (http:// or https://). 
It can be a domain name (e.g., www.example.com) or a routable IP address. 

Connect to the Web Proxy Server using port 

This specifies the Web Proxy Server's port number. Typically 80 is used for HTTP and 443 for 
HTTPS. 

Use Secure Sockets Layer 

Check this box to use SSL (HTTPS). 

Policy Commander tab (Client Settings) 

  

On this tab, select the interval at which the Client on a managed computer evaluates its assigned 
policies. The Client will evaluate the current policies at this interval even if it has not polled the 
Channel Server. For example, this setting may be useful for maintaining policies on managed 
laptop computers that connect to the network less frequently. 

For policies assignments that are set to Auto Enforce, this frequency becomes the enforcement 
interval. 

Set the frequency 

Choose from the following options: 

 Continuously: The Client evaluates policy compliance every 5 seconds. This option 
requires more processor time than the following options. It is used only for a small 
number of computers in a test lab. 

Caution: Do not use this setting for your production environment. 
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 Check once every   minute(s): The Client evaluates policy compliance at the 
interval you set. The interval is a number of minutes. The default value is 10 minutes. The 
interval may need to be adjusted up or down, depending on these factors: 

 the number of computers in the Channel 

 the number of groups in the Channel 

 Check once every   hour(s): The Client evaluates policy compliance at the 
interval you set. The interval is a number of hours. 

 Check once every day: With this setting, the Client enforces the policy once per day. 

Note:  Please contact Technical Support for recommendations on the optimal enforcement 

interval for your situation. 

Automatically Maintaining Client Settings 

You can use Policy Commander's automatic update option to maintain a uniform set of 
communication parameters for all managed computers in the Channel. With this option turned on, 
the default communication settings are applied to all of the managed computers in the Channel 
each time they contact the Channel Server. 

To specify settings that are automatically applied to all managed computers in the Channel: 

1. Select File | Client Settings. 

2. On the Client Settings | Polling tab, select the check box for Configure the Client to 
automatically apply new settings for this channel. 

3. Adjust the values on each tab in this dialog box. 

4. Click OK to save the changes. 

Each time a Client polls the Channel, it receives and applies these settings. 

Note: To override the automatic update option, change the setting for an individual client. (See 

Applying Unique Settings to a Client.) 

Applying Unique Settings to a Client 

If you do not want to automatically apply the default client settings on all managed computers, 
you can specify unique settings for one or more computers. The settings are applied to the 
computer when the Client is installed. They can be updated at any time by reinstalling the Client 
directly or with a subscription file. 

Setting up a New Client 

To set unique communications for a new client: 

1. On the Network tab, select the computer(s) to add. 

2. Right-click and select Manage Computer from the pop-up menu. 

3. In the Manage Licenses dialog box, make sure that at least one Policy Commander 
license is assigned (either automatically or manually). 

4. Click Next. 

5. Choose Now via Direct Client Installation for the Client Installation method. 

6. Click the Settings button. 
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 On the Polling tab, clear the Configure the Client to automatically apply new 
settings for this channel check box. 

 On each of the tabs in this dialog box, adjust the settings as required for the Client. 

 When you have finished, click OK. 

7. Click Advanced Options if you need to specify paths and folders for installation options. 
When you have finished specifying Installation Options, click OK. 

8. Select the Use alternate credentials check box if you wish to use alternate credentials 
for the client installation. This can be useful if you are installing across domains or where 
you do not have centralized administration accounts. 

9. Select the Reboot computer after installation check box. 

10. Click Install to install the Client. 

11. Click Finish when the installation is complete. 

The communication settings are applied when the Client is installed. These settings are not 
changed unless you later reinstall the Client with different settings. 

Change Existing Clients 

You can change the communication settings for a managed computer by installing the Client 
directly or with a subscription file. 

Change Settings Directly: 

To install new settings directly: 

1. Highlight the computer(s) on the Managed | Members tab. 

2. Right-click and select Reinstall Client from the pop-up menu. The Direct Client 
Installation dialog appears. 

3. Click the Settings button. 

1. On the Polling tab, clear the Configure the Client to automatically apply new 
settings for this channel check box. 

2. On each of the tabs in this dialog box, adjust the settings as required for the 
Client. 

3. When you have finished, click OK. 

4. Click Advanced Options if you need to specify paths and folders for installation options. 
When you have finished specifying Installation Options, click OK. 

5. Select the Use alternate credentials check box if you wish to use alternate credentials 
for the client installation. This can be useful if you are installing across domains or where 
you do not have centralized administration accounts. 

6. Select the Reboot computer after installation check box. 

7. Click Install to install the Client. 

8. Click Finish when the installation is complete. 

Subscription File: 

To install the new settings through a subscription file: 

1. Select Computers | Create Subscription File. The Subscription File dialog box 
displays. 

2. Select Install or Update the Client option. 
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3. Click the Settings button. 

1. On the Polling tab, clear the Configure the Client to automatically apply new 
settings for this channel check box. 

2. On each of the tabs in this dialog box, adjust the settings as required for the 
client. 

3. When you have finished, click OK. 

4. Click Advanced Options if you need to specify paths and folders for installation options. 
When you have finished specifying Installation Options, click OK. 

5. Click OK on the Subscription File dialog to save your changes. 

6. On the Save Subscription File dialog, enter a name for the new subscription file. 

7. Distribute the subscription file to the managed computers. You can use either of the 
following methods: 

1. If you are using the subscription file to install the Client, distribute the file by 
attaching it to an e-mail message, placing it on a Web site, or including it in a 
login script. 

2. If you are using Prism Deploy, create a Command Task that installs the new 
subscription file that you saved. Assign the new Command Task to one or more 
target computers. 
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Computer Properties 

Viewing the Computer Properties 

 

The Computer Properties | General tab displays detailed information about the computer currently 
highlighted in the main window. The information available on this tab is useful for understanding 
the computer’s environment for troubleshooting. 

The Computer Properties | General tab is displayed when you right-click on the name of a 
managed computer and choose Properties from the pop-up menu. 

The information includes: 

 Name used to identify the computer 

 Description - Automatically includes some information about the computer, such as 
whether it is managed. You can add text by typing directly in the box. 
This description is displayed on the Managed | Members tab in the main Console 
window, along with the computer status and other information. 
 
The contents of this text box depend on your environment. 

 In Active Directory (AD) environments, the description defaults to the AD 
description. You can modify this description or add information. 
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 In all other environments, type a description or other notes directly in the text box. 

 Name/Value - The box in the middle of the tab displays detailed status information for the 
computer. You can capture this information by running the Workstation Status report. 
(See Generating and Viewing Reports.) A portion of the information listed in the status 
box is also available through the main Console window. 

Disable 

Indicates whether the computer is active or inactive. 

Disabled - With this checkbox cleared, the computer is active and can receive changes from 
the Channel or report status and configuration information. 

Disabled - With this checkbox selected, the computer is disabled and cannot receive 
changes or report status and configuration information, but it remains part of the Channel. 
Use this option to take a computer off-line temporarily when there is a problem. 
 

When a computer is disabled, its icon is grayed in the Console main window. 

Policy Commander Tab (Computer Properties) 

 

The Computer Properties | Policy Commander tab displays attributes of the computer that are 
used to determine which policies apply to the computer. Only policies with matching 
characteristics are applied to this computer. 

Note:   Before adding a computer to Policy Commander, the Client must be installed on the 
computer. See Managing Computers. 

Security Level 
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Only policies with a matching security level defined in an applicability step will apply to this 
computer. The Microsoft Windows XP Security Guide defines these levels as: 

 Stand-alone (SA)/Legacy Client: Client computers in this environment are not members 
of an Active Directory domain and may need to communicate with systems that run 
Windows NT® 4.0. 

 Enterprise Client (EC): Client computers in this environment are located in an 
Active Directory® directory service domain and only need to communicate with systems 
running Windows 2000 or later versions of the Windows operating system. 

 Specialized Security - Limited Functionality (SSLF)/High Security: Concern for 
security in this environment is so great that a significant loss of functionality and 
manageability is acceptable. For example, military and intelligence agency computers 
operate in this type of environment. 

Note:  Use the High security setting with care. Higher security settings can interfere with 
software applications on the target computer. 

Roles 

Defines the roles this computer has. Only policies with matching Role settings are enforced on 
this computer. A computer can have more than one role. Roles include: 

 Bastion Host: A secure server that is accessible from the Internet or untrusted public 
network, making it vulnerable to attack. 

 Certificate Services Server: A server used to manage X.509-compatible certificates. 

 Domain Controller: A server that authenticates domain logons and maintains master 

security database for a domain or group of connected computers. 

 File Server: A server that stores files for users and provides access to the files. 

 Infrastructure Server: A server to support Dynamic Host Control Protocol (DHCP) 
server or a Windows Internet Name Service (WINS server). 

 Internet Authentication Service (IAS) Server: Server where Microsoft Internet 
Authentication Service (IAS) is installed. Used for verifying the identity of clients that 
access the network remotely. 

 Internet Information Services (IIS) Server: Server that is running Internet Information 
Services (IIS). Used to deliver content over the Web. 

 Managed Computer: Any computer that is under your control. This role is the default. 

 Print Server: A computer that is dedicated to managing the printers on a network so that 
users can share printers. 

 Server: Any computer being used as a server. Use this option if you do not want to 
choose one of the options above to designate it as a specific type of server. 
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Group Assignments 

 

The Computer Properties | Groups tab displays information about the selected computer's 
membership in organizational and configuration groups. 

Note: Configuration groups are populated automatically. You cannot change the membership of 
configuration groups. 

The Computer Properties dialog box is displayed when you right-click on the name of a managed 
computer and choose Properties from the pop-up menu. Click the Groups tab to view this tab. 

Disabling or Deleting Computers 

Temporarily Disabling Computers 

Computers can be temporarily turned off or taken offline while you diagnose a problem. This 
feature lets you disengage the computer from the Channel without extensive editing. 

You can disable a single computer or multiple computers. Highlight the name of one or more 
computers, then disable them with the Disabled check box on the Properties dialog box: 

  Disabled: With this option cleared, the computer is active. For example, a computer can 
receive changes or report configuration information. This option is the default. 

  Disabled: With this option selected on the Computer Properties | General tab, the 
computer cannot receive changes from the Channel and does not update its configuration 
information. 

Disable a Computer 

To disable a computer: 
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1. Highlight the name in the tree on the Managed tab or in the details pane. 

2. Open the Properties dialog box by right-clicking on the computer name and selecting 
Properties from the pop-up menu. 

3. In the Computer Properties | General tab, select the Disabled check box. 

4. Click OK. 

When you are ready to activate this computer, clear the Disabled check box. 

Deleting a Computer from the Channel 

When a computer is managed, it is added to the Channel and the Client is installed. To remove a 
computer from the Channel, you delete it from the Channel and then uninstall the Client. 

Delete the Computer 

To remove the computer from the current Channel: 

1. With the Managed tab open in the tree view, locate the name of the managed computer. 

2. Right-click on the name of the computer and select Delete from the pop-up menu. 

3. When Policy Commander asks you to confirm the deletion, click OK. 

Note: If you want to remove the computer from the Channel but leave the Client installed on that 
computer, stop at this point. 

Uninstall the Client 

Use a subscription file to uninstall the Client from a computer. 

1. With the Managed tab open in the tree view, select Computers | Create Subscription 
file. 

2. On the Subscription File dialog box, select Uninstall the Client from the Option drop-
down list. 

3. Click Next. 

4. On the Save the Subscription File dialog box, enter a name for the new subscription file. 
 
We recommend using a name that clearly indicates that this file is used for uninstalling 
the Client. 

5. Run the subscription file on the computer to uninstall the Client. 
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Grouping Computers 

Creating Categories of Computers with Groups 

Groups let you categorize computers with similar requirements or environments, and then rapidly 
perform management functions. For example, rather than searching out and applying policies to 
individual computers, set up a group of related members and apply a policy to the group as a 
whole. Or, create groups to track hardware and software at specific locations. 

When you set up groups keep the following factors in mind: 

 Each computer can be assigned to any number of groups with different shared 
characteristics. 

 The record for a computer added to a group remains in the Managed Computers branch 
and its name is duplicated under the group. 

 Subgroups may be added manually to an Organizational group. (For example, you may 
have a group named IT and a subgroup named Programmers within the IT group.) 
Subgroups are added automatically to Configuration groups. 

 A Policy assigned to a group is installed on each new member that joins the group. For 
example, if you apply a policy to a configuration group, when a computer is added to the 
group automatically, the policy is applied on that computer. Even if a member is added 
six months after the policy was originally assigned to the group, it is installed for the new 
member. The policy can be disabled or deleted when it is no longer needed. 

For a preview of Channel groups, add one or more computers to the Evaluation Channel, then, 
watch as the groups populate. (The Evaluation Channel was installed with Policy Commander. 
See the Quick Start Guide for more information.) 

Create Groups of Computers 

Depending on your needs and the setup of your network, you can create groups and add 
members manually or automatically. 

 Create organizational groups manually - You construct organizational groups and add 
members individually. These groups can reflect locations, application use, function, 
department, or any other type of category that suits your needs. 
 
(See Manually Setting Up an Organizational Group and Adding Members ) 

 Populate organizational and configuration groups automatically - Groups can be 
added to the Channel automatically in these ways. In each case, you must have the auto-
populate settings turned on for the Channel Properties. 

 Predefined and User-Defined Configuration Groups - Configuration groups are 
populated automatically, based on configuration queries and rules you set up. 
Configuration groups are dynamic—as the configuration of managed computers 
change, they are automatically placed in or removed from the appropriate groups. 
 
See Building Predefined Configuration Groups with a Shared Characteristic. 
 
See User-defined Configuration Groups for Complex or Customized Groups. 

 Organizational Groups based on AD Structure - If the network uses AD (Active 
Directory), the network structure is duplicated in the Channel when computers 
subscribe to the Channel. 
 
See Automatically Adding Organizational Groups from the Network Structure. 
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Organizational Groups 

Automatically Adding Organizational Groups from the Network Structure 

If your network uses Active Directory (AD), the Client identifies the computer using its Active 
Directory name (as opposed to NetBios name). As long as the Channel is set to auto-populate, 
the AD structure is duplicated in the Console when computers subscribe to the Channel. 
Organizational groups are created automatically in the Channel on the Managed Computers tab 
to match the containers set up on the network. 

 Groups are created to match the containers set up on the network. 

 Computers are added to the Managed tab and to the applicable subgroup in the 
Organizational Groups branch. 

Note: For these groups to be created and populated: 
• After installing the Client, the managed computer must be rebooted. 
 
• The auto-populate setting must be turned on through the Channel Properties. (See 
Channel Properties Settings.) 

Example 

When the computer E3465.Engineering.YourCompany.local contacts the Channel Server and is 
added to the Channel, Policy Commander automatically creates the group .local with subgroups 
YourCompany.local, and Engineering.YourCompany.local. It adds the computer to the new group 
Engineering.YourCompany.local. 

Manually Setting Up an Organizational Group and Adding Members 

Organizational groups let you create a group and assign individual members to the group from 
the pool of managed computers in the Channel. Organizational groups may reflect functional 
groups or roles within your organization or group computers by location. Since they are 
maintained manually, these groups are most useful for smaller numbers of managed computers 
or populations that remain constant. 

To manually set up an organizational group in the Channel and add members: 

1. From the Managed tab, right-click on the Organizational Groups branch, then choose 
Create Group from the pop-up menu. Alternately, you may choose Create Group from 
the Edit menu. 

 Subgroups can be created by selecting an existing Organizational Group. 

2. In the New Group dialog box, type a descriptive name for the group in the text box. Click 
OK. 

3. In the Console main window, assign members to the group by doing one of the following: 

 Drag and drop the names of computers onto the group in the Console main window. 

 Add members to the group by selecting the group and using the Add To Group menu 
option (via right-click or Edit menu). Alternately, members can be added from the 
Group properties | Members tab. 

 Add an individual computer by selecting the computer and using the Add To Group 
menu option (via right-click or Edit menu). 

Removing a Computer from a Group 

To remove a computer from an organizational group: 

1. On the Managed tab, expand the group in the tree view. 
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2. Within that group, select the computer to be removed. 

3. Right-click on the computer name (or use the Edit menu) and select Remove from 
Group. 

4. A confirmation dialog appears. Press OK to proceed with the removal. 

The computer is removed from the current group. Its membership in other groups is not changed. 

You can also remove a computer from an organizational group though the Group properties | 
Members tab. 

Configuration Groups 

Building Predefined Configuration Groups with a Shared Characteristic 

Predefined configuration groups update automatically, adding and removing members based on a 
shared characteristic, such as operating system or local time zone. When setting up a predefined 
group, you choose a single variable as the basis for identifying group members. Computers in the 
Channel automatically create and populate a subgroup for each unique classification within the 
group. 

For example, if you choose OSVersion for the group value, the subgroups might include: 

OSVersion=OS.Version.Win2000 

OSVersion=OS.Version.WinXP 

  

Note: For these subgroups to be created and populated, the auto-populate setting must be turned 
on through the Channel Properties. (See Channel Properties Settings.) 

Add a Predefined Configuration Group 

To set up a predefined group in the Channel: 

1. With the Configuration Groups tab open in the tree view, right-click on the Configuration 
Groups branch in the tree view, then choose Create Group from the pop-up menu. 

2. In the Create Configuration Group dialog box, select the option button for Predefined 
Group. Click Next. 

3. In the New Group: Choose a value dialog box, choose a value to serve as a basis for 
identifying managed computers for the group. Click Next. 

4. In the New Group dialog box, type a descriptive name for the group in the text box. Click 
Finish. 

Subgroups are populated in the Channel when a managed computer contacts the Channel 
Server. The computers are placed in subgroups automatically based on the value you selected. 

Importing Configuration Groups 

The Policy Commander Console makes it easy to import pre-tested configuration groups into your 
channel by downloading them from a New Boundary Technologies server. By default, there is 
one server from which you can import configuration groups. In the future, other servers may be 
configured. 

To import a configuration group from the New Boundary Technologies server: 

1. Open the Select Configuration Group Server dialog in one of the following ways: 

1. From the File menu, select Import -> Configuration Groups 
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2. On the Configuration Groups tab, select the Configuration Groups root node, 
right-click, and select Import. 

2. Select a source from the list, then press Next. to open the configuration group selection 
dialog. 

3. In this dialog, select the configuration groups you wish to import, and press Add groups 
to add them to your channel. 

4. Press Close to terminate the connection. 

The configuration groups you downloaded can be seen on the Configuration Groups tab. 

  

Create Configuration Group dialog 

 

Configuration Groups are dynamic and populate automatically based on the value or rule you set 
as criteria for membership. 

Choose the type of configuration group to create: 

 Predefined Group: Select the type of value (operating system, domain, CPU, and so on) 
used to determine which computers are included in the group. The Console automatically 
creates and populates subgroups based on the value. 

 User-defined Group: Create simple to complex rules to define the group and subgroups. 
The rules for each subgroup can contain different combinations of values, so that 
computers with very specific criteria can be combined into functionally equivalent units. 

This dialog box opens when you select the Create Group menu option the Configuration 
Groups branch (or a User-Defined group) on the Configuration Groups tab. 
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New Group: Choose a Value dialog 

 

Choose the value that defines the population for this predefined configuration group. For 
example, choose RAM to automatically create and populate subgroups based on the amount of 
RAM on the managed computers in the Channel. A predefined group based on the variable RAM 
might contain these subgroups: 

RAM="128MB" (Computers with 128 megabytes of RAM) 
RAM="256MB" (Computers with 256 megabytes of RAM) 

This dialog box opens when you select Predefined Group on the Create Configuration Group 
dialog box. 

Note: You can type an environment variable directly in the Value field, rather than choosing an 
item from the drop-down list. For example, you could type in "%SYSTEMROOT%", and 
subgroups corresponding to each unique system root directory would be automatically 
created and populated by computers with that same system root directory. The typed 
value must be enclosed in quotes (" "). 

Options include: 

 Computer Domain: The Windows domain or workgroup of the computer. For example, 
use this option to create subgroups of computers that receive their Tasks from a specific 
server. 

 CPUFamily: The generation or family of the computer’s primary processor (Pentium, 

Pentium Pro/II/III or Athlon, Pentium 4, and so on). 

 CPUMaker: The manufacturer of the computer’s primary processor (Intel, AMD, and so 

on). 

 CPUModel: The specific model of the computer’s primary processor (Intel_486DX, AMD 

K6-3, and so on). 

 NumCPUs: The number of CPUs installed and supported on the managed computer. For 
example, use this option to install an update that differs for a single processor versus 
multiple processors. 

 OSFamily: The family of the operating system on the managed computer. For example, 
create subgroups for Windows 9x or Windows NT. Use this option to create subgroups 
based on common features of the operating system, rather than individual versions of the 
operating system. 

 OSComponents: The extra components installed on the client operating system. For 

example, Windows XP Home Edition or Terminal Services. 
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 OSRevision: The service-pack or revision of the computer’s operating system (Windows 

2000 Service Pack 2, Windows XP Second Edition, and so on). 

 OSRole: Identifies the managed computer as a server, workstation, or domain controller. 

(By definition, all Windows 9x computers are workstations.) 

 OSVersion: The version of the operating system running on the managed computer 

(Windows 2000, Windows XP, and so on). 

 RAM: The amount of RAM on the managed computer, in megabytes (MB). 

 SystemBaseLanguage: The base language identifier (LANGID) for the managed 
computer. The base language identifiers, both SystemBaseLanguage and 
UserBaseLanguage, identify a family of languages—English, French, and so on. 

 SystemFullLanguage: The base language identifier (LANGID) for the managed 
computer. The base language identifiers, both SystemBaseLanguage and 
UserBaseLanguage, identify a family of languages—English, French, and so on. 

 TimeZone: The time zone on the managed computer. This value is determined by the 

time zone selected in the Date and Time settings on the managed computer. 

 UserBaseLanguage: The base language identifier (LANGID) for the current user. 

 UserDomain: The Windows NT domain or workgroup of the user. 

 UserFullLanguage: The full language identifier (LANGID) for the current user. 

Receiving Notifications when Group Membership Changes 

You can receive an email notification when a Configuration group's membership changes. Simply 
select the desired group, open the Group Properties dialog, and click on the Notifications tab. You 
can choose to receive emails when a computer joins or leaves the group. 

All users associated with the channel (Manage Channel Security dialog) and that have valid email 
addresses are notified. 

User-defined Configuration Groups for Complex or Customized Groups 

User-defined groups let you create customized rules to identify groups based on very specific 
criteria and let you specify multiple values for evaluating and adding group members. The 
Console provides an Expert to help you with each step of the group set up or lets you type rules 
directly into an editor. User-defined groups can be as simple as matching a file name or as 
complex as identifying computers based on the presence or absence of multiple characteristics. 

User-defined groups are dynamic. If a computer no longer meets the criteria for group 
membership, it removes itself from the group. Likewise, if a new computer meeting the criteria for 
group membership is added to the Channel, it automatically adds itself to the user-defined group. 
This new member also receives any Tasks that were assigned to the group. 

Add User-defined Group 

To set up a user-defined group in the Channel: 

1. With the Configuration Groups tab open in the tree view, right-click on the Configuration 
Groups branch in the tree view, then choose Create Group from the pop-up menu. 

2. In the Create Configuration Group dialog box, select the option button for User-
defined Group. Click Next. 

3. In the Rule Expert: Assemble a Rule Clause dialog box, define the rule by setting the 
value type, operator, and value. Click Next. 

Note: As you select options on this dialog box, the text of the rule is displayed in the Rule 
Text field. Use this information to confirm the content of the rule and learn how to 

type rules directly in the Rules Editor. 
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4. In the Rule Expert: Rule Name dialog box, type a name for the group that will be defined 
by the rule you just created. Click Next. 

5. In the Edit Rule dialog box, check the syntax of the rule or add logical operators to 
expand the rule. Click Finish. 

Subgroups are populated in the Channel when a managed computer contacts the Channel 
Server. 

Rule Expert: Assemble a Rule Clause dialog 

 

Use the fields on this dialog box to define the rule for selecting members of a user-defined 
configuration group. 

This dialog box opens when you either select User-defined Group and click the Next button on 
the Create Configuration Group dialog box, while creating a group in the Console. 

Options on this dialog box include: 

 Value Types: Sets the basis for the evaluating managed computers or members of the 
group. This type of value on managed computers is compared to the rule. For a complete 
list of the options available, see User-Defined Variables. 

 When used for a user-defined group, this type of value on all managed computers in 
the Channel is compared to the rule to determine their membership. 

 When used for an installation rule, this type of value on all managed computers is 
compared to the rule before installing the Prism file. 

 Value type identifier: If you choose a Value Type enclosed in < >, a text box is 
displayed for the value itself. For example, if you choose <File Version>, type  
C:\PROGRAM FILES\ACME SOFTWARE\ACME.EXE in the Value text box to compare the version of 
this file on the managed computer with the value in the last field on this dialog box. 
 
All strings must be enclosed in quotes (" "), which the Console adds for you automatically 
in the Rule Expert. If you type a rule directly in the Rule Editor, remember to add the 
quotes. (See Notes on Rule Syntax.) 

 Comparison Operator: The comparison operator determines how the value on the 
managed computer is compared to the rule. 
 
For a complete list and descriptions of the Comparison Operators available in the drop-
down list, see Comparison Operators). 

 Value: Type the variable value or select an item from the drop-down list. The items 
available in the drop-down list depend on the selection you made in the Value Types 
field. For example, if you choose firstcdletter in the Value Types field, the Value field 
lists the drive letters A, B, C, D, E, and so on. 
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If you type a value directly in this field or directly in the Rule Editor, it must match the 
values created by New Boundary Technologies for the Value Type. 
 
For a complete list of the values, see: 

 Predefined Variables 

 User-defined Variables 

 Go To Editor button: Open the Rule Editor. If you are familiar with the syntax and 
variables for creating rules, you can type the rule directly in the editor rather than using 
the drop-down lists in the Rule Expert. 

Edit Rule dialog 

 

This dialog box shows the rule or subgroup name and the text of the rule itself. Depending on 
your starting point, use this dialog box to verify the text of the rule and its syntax or type a rule 
directly into the editor. 

This dialog box opens when you do one of the following: 

 Click the Next button on the Rule Expert: Rule Name dialog box. 

 Click the Go to Editor button on the Rule Expert: Assemble a Rule Clause dialog box. 

 Click the Edit Rule button on the on the Group Properties | General tab for a user-defined 
subgroup. 

Options on this dialog box include: 

 Rule Name: A descriptive name for the installation rule or the subgroup that is created 

and populated based on the rule. 

 Rule Text: The text of the rule is displayed in this box. You can change the rule by typing 

directly in the box. 

 Rule Expert: Add logical operators and expand the rule. Through the Rule Expert, use 

logical operators (AND or OR) to append another rule and create a more complex rule. 

 Save Rule: Save the rule as a Ruleset file (.RULESET). Saving and importing rules can 
offer a convenient way to transfer rules to another Policy Commander file or between 
Policy Commander files and configuration groups in the Console. 
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 Load Rule: Load a Ruleset file (.RULESET) to define the group or installation requirements. 
Saving and loading rules can offer a convenient way to transfer rules to another Policy 
Commander file or between Policy Commander files and configuration groups in the 
Console. 

Caution: When you load a Ruleset file through the Rules Editor, it replaces the existing 
rule text and name. 

Choose a Joining Method for the Clause 

Choose a conjunction for joining the rules that define a single subgroup. The following example 
shows two rules joined with the conjunction OR: 

(CPU = "PENTIUM 5" AND OSVERSION = W2K) OR (CPU = "PENTIUM 4" AND OSVERSION = W95) 

This dialog box opens when you click the Rule Expert button on the Edit Rule. 

Choose from these conjunctions: 

 AND: Only the computers that meet both or all sets of criteria are selected for the group. 

 OR: Computers that meet either or any of the criteria are selected for the group. 

Creating an All Others Group 

An All Others group includes all of the computers in the Channel that are not members of another 
.  

1. With the Managed tab open in the tree view, right-click on the PwrGroups branch in the 
tree view, then choose Create Group from the pop-up menu. 

2. In the Rule Expert: Choose a Type of PwrGroup dialog, select the option button for All 
Others Group. Click Next. 

3. In the Rule Expert: Rule Name dialog box, enter a name for the new group or leave the 
default name—All Others. Click Next/Finish. 

Rule Expert: Choose a Type of dialog 

Create one of the following types of : 

 Subgroup Based on Rule: Set up a rule that defines the variables and values used to 

identify computers in the Channel as group members. 

 All Others Group: Create a subgroup that includes all computers in the Channel that are 

not members of another subgroup within the Group. 

Editing an Existing Rule 

After creating a user-defined group, you can edit the rule to make changes in the value type, 
values, or operators. When you edit a rule, the group members are removed from the group and 
the group is re-populated, based on the new criteria. You can edit an existing user-defined group 
through the Group properties or through the Rule Editor. (Only user-defined groups can be edited 
in this way.) 

Edit a User-defined Subgroup Directly 

To edit a user-defined subgroup: 

1. Right click on the subgroup name in the tree view on the Configuration Groups tab. 

Note: Editing is not available for the parent group, only for subgroups based on individual 

rules. 

2. Select Edit Group from the pop-up menu. 
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3. In the Edit Rule dialog box, edit the rule directly in the Rule Text field. Or, click the 
Add Rule Expert button to add additional qualifiers to the rule. 

4. Click the Finish button to save your changes. 

Edit a User-defined Group through the Group Properties 

The Viewing General Group Properties tab for a user-defined subgroup displays an Edit button. 
To edit the rule that defines this subgroup: 

1. Right click on the subgroup name in the tree view on the Configuration Groups tab. 

2. Select Properties from the pop-up menu. 

3. In the Group Properties | General tab, click the Edit button. 

4. In the Edit Rule dialog box, edit the rule directly in the Rule Text field. Or, click the 
Add Rule Expert button to add additional qualifiers to the rule. 

5. Click the Finish button to save your changes. 

Rules for User-Defined Groups 

Rule Variables and Operators for User-Defined Configuration Groups 

Rules can be built using the drop-down lists in the Rule Expert or typed directly in the Rules 
Editor.  

Whether it is created with the Rule Expert or typed directly in the Rules Editor, each rule is 
composed of some or all of these parts in the following order: 

1. Variable type: Identifies the type of item you are evaluating—variable, registry key or 
value, INI value, file, file version, file name, folder name, and so on. 

2. Item: If the Value Type requires an identifier (those value types enclosed in brackets, for 
example <File>), identify the item here. For example, with the Value Type <File>, enter 
the path and name of the file. For example: 
 
<File> "C:\Program Files\Acme Software\Acme.exe" 

3. Comparison Operator or Logical Operator: Defines how the value on the target 
computer is compared to the rule. For example: =, Exists, Matches, and so on. 

4. Value or Constant: The value to compare with the resolved variable’s value on the target 
computer. 

Notes on Rule Syntax 

When typing rules and their values: 

 Variables are usually followed by a comparison operator and additional information. In 
this appendix: 

 Values and other parts of the rule are shown in brackets [ ]. 

 Do not type the bracket symbols ([ ]) when using variables. 

 A list of options that you can choose from are shown with a vertical bar | to separate 
them. For example: [Name1 | Name2] 

 Variables support registry value names containing back-slashes (\). In a registry value 
path, any characters following the first double-backslash (\\) are interpreted as part of the 
registry’s name. 
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If a registry value type is used and there is not a double-backslash, then the default value 
for the registry key is used. For example: 

"HKLM\Software\Foobar\\Some Value" : the registry value name is "Some Value" 

"HKLM\Software\Foobar\Another Value" : the registry value name is "Default" 
  

 Rules are not case sensitive, except for size value abbreviations ("500 MB" is acceptable, 
but "500 mb" is not). They can be typed in all caps, lower case, or a combination of the 
two. 

 A value must be enclosed in quotes (" ") in these cases: 

 the value contains spaces (for example, "C:\PROGRAM FILES\ANY COMPANY\ANY_EXE.EXE") 

 the value is a string (for example, "computername") 

 Constants are not enclosed in quotes (" "). 

 Quotes can be embedded by typing two quotes for every embedded quote. 
For example, the following rule evaluates to true if there is a registry value "Genuine" 
Intel in the key HKLM\hardware\description\system\centralprocessor: 

Exists <Registry Value> "HKLM\hardware\description\system\centralprocessor\\""Genuine"" Intel" 

Constants 

For your convenience, several of the variables have constants assigned. When using the Rule 
Expert, the constants are available in a drop-down list after you choose the variable type. If you 
are typing the rule directly, the constants must match the values set up by New Boundary 
Technologies. 

See the discussion under each variable for information on the constants. 

Comparison Operators 

The following comparison operators are supported when creating installation rules on the 
File Properties | Requirements tab in the Editor, setting up user-defined configuration groups in 
the Console, or creating scripts with the /ScriptVer command: 

 All comparison operators must be followed by a value. 

 All comparisons are case sensitive 

Comparison Operators 

= The value on the computer is equal to or matches the stated value exactly. 
(See note below.) 

<> The value on the computer is not equal to or does not match the stated value 
exactly. 
(See note below.) 

< The value on the computer is less than the stated value. 

<= The value on the computer is less than or equal to the stated value. 

> The value on the computer is greater than the stated value. 

>= The value on the computer is greater than or equal to the stated value. 

exists The item exists. Use this option for identifying whether a specific file, folder, 
registry key, registry value, and so on exists on the computer. For example, use 
this option to determine whether an application is installed on the computer 
before sending it an update. 

not Reverses or inverts the meaning of the clause that follows it. For example: 
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 NOT EXISTS <file> "C:\Oracle\DB.BIN" 

matches The matches operator uses wild-card characters to determine whether or not an 
item matches the corresponding value. The portion of the statement that 
contains wild-cards must be surrounded by quotes. The DOS wild-card system 
is used: 

? represents one character of any value 

* represents 0 or more characters of any value. For example: 

 IP MATCHES "*.183.*.*" 

grepmatches Use a GrepMatch to identify a more complex pattern than those available with 
the other operators. 

  

Note: The operators = = and ! = (used with previous versions of Prism) are equivalent to = and < 
> respectively:


 If you use = = in a rule or script, Prism translates it to =. 


 If you use ! = in a rule or script, Prism translates it to < >. 

  

Examples Using the Comparison Operators 

The following examples show the operator for a rule that identifies computers with less than 64MB 
of RAM and the operator that identifies computers that use any language other than U.S. English. 

RAM < 64MB 

SYSTEMFULLLANGUAGE <> "Language.Full.English.UnitedStates" 

Examples Using Grepmatches 

The following examples demonstrate the use of GrepMatch for the operator. For more 
information, visit the support area of the New Boundary Technologies Web site 
(www.newboundary.com/support/support.htm) for links to additional resources. 

The group created with this match contains computers that have an IP Address within the range 
192.168.1.*, 192.168.2.*, and 192.168.3.*: 

IPAddress GREPMATCHES "192\.168\.[1-3].*" 

The group created with this match contains computers with any of these letters as the first letter 
of their CD-ROM drive—A:, B: C:, or D: 

FirstCDLetter GREPMATCHES "[A-D]" 

The group created with this match contains computers where the registry value FileFilter contains 
*.olb as its first delimited value. 

<Registry Value> "HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\DbgClr\7.0\Object 
Libraries\{18E32C04-58BA-4a1e-80DE-1C291634166A}\Filters\1\\FileFilter" GREPMATCHES 

"\*\.olb.*" 

Conjunction 

You can add additional or contrasting criteria to a rule with the following operators: 

 AND: Computers that meet both or all sets of criteria defined by the rule. 

 OR: Computers that meet either or any of the criteria defined by the rule. 

Conjunctions are evaluated left to right, except if precedence operators—parentheses ( )—are 
used in the statement. 
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Note on Parentheses 

Use parentheses to override the normal left-to-right evaluation of a rule. In some cases, use of 
parentheses changes the outcome of the evaluation. For example: 

(CPU = "Pentium 5" AND OSVERSION = W2K) OR (CPU = "Pentium 4" AND OSVERSION = W95) 

Values 

The values are the sequences of text or numeric characters that are compared with the items on 
the target computers. Values must be enclosed in quotation marks if they contain spaces or are 
any current or future logical operator. For example, "here OR there". 

Note: Comparison of values is not case sensitive, except for size abbreviations. The size 

abbreviations KB, MB, GB, and so on must be capitalized. 

Policy Commander rules support these types of values: 

 Number: When a value must be compared against an item, the comparison is numeric if 

both the item and the value are numeric. 

 Size: A size is the same as a number but it is followed by the abbreviation for a unit. For 
example 2.5MB for 2.5 megabytes. 
 
Unit abbreviations include: 
 
KB: kilobytes 
MB: megabytes 
GB: gigabytes 
TB: terabytes 

 Text: Text values are characters, strings, or other values that do not fit the definition for 
Number or Size value. 

 Version Number: The expected format for version numbers is 0.0.0.0. For example: 
 
<file version> "%WINDIR%\FILE.DLL" <= 3.1.0.0 
 
A file version can also be specified in these formats: 

1 

1.0 

1.0.0 

Quotes may be used around the version number, if you want the number to be evaluated as a 
string value or if you wish to use the wild-card characters "?" or "*". Quotes and wild-card 
characters should only be used with the logical operators MATCHES or GREPMATCHES. 

Example 

In both of the following examples, the rule evaluates to TRUE if PTCLIENT.EXE is greater than or equal 
to version 5 and less than version 6. 

(<file version> "C:\Program Files\Prism\Client\ptclient.exe" >= 5.0) AND 
(<file version> "C:\Program Files\ Prism\Client\ptclient.exe " < 6.0) 
<file version> "C:\Program Files\ Prism\Client\ptclient.exe " MATCHES "5.*" 
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User-Defined Variables 

User-Defined Variables 

The user-defined variables are enclosed in angle brackets (< >) in the Value type field of the 
Rule Expert. These values can be used with any appropriate value. Unlike the predefined 
variables, you are not limited to the values defined by Policy Commander. 

Custom 

<Custom> ["ProgID"] ["Parameter string"] [comparison operator] ["Value"] 

String value supplied by a custom plug-in. To indicate an empty parameter string use empty 
quotes (""). For more detailed information, see www.newboundary.com/support/support.htm. 

Variable Type 

String 

Environment Variable 

<Env Var> [%variable name%] [comparison operator] [Value] 

Identifies a specific environment variable in the user's session. Environment variable items must 
specify an environment variable, a comparison operator, and a value. For example: 

<Env Var> "%SESSIONNAME%" = "Console" 

Variable Type 

String 

Prism Variables 

In addition to user-session environment variables, such as %USERNAME%, Prism provides the 
following variables: 

PT_YEAR the current year in four characters (2004, 2005, …) 

PT_YEAR4 the current year in four characters (2004, 2005, …) 

PT_YEAR2 the current year using two characters (04, 05, …) 

PT_MONTH the number of the current month (01 12) 

PT_DATE the day of the current month (01 31) 

PT_DAY the number of the day of the week (Sunday = 01) 

PT_HOUR the current hour in military time (00 23) 

PT_HOUR12 the current hour (01 12) followed by either AM or PM 

PT_MINUTE the current number of minutes past the hour (01 59) 

PT_SECOND the current seconds (01 59) 

PT_CD the first drive letter of your CD-ROM drive (D:, E:, and so on) 

PT_OS the operating system family of your computer ( WinNT) 

PT_MAJOROS the operating system family of your computer ( WinNT) 

PT_MINOROS the operating system of your computer ( Win2K, ...) 
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File 

[logical operator] <File> ["File Path"] 

The name of a file on the target computer, for example: 

NOT EXISTS <File> "C:\DATA\STUFF.DAT" 

Variable Type 

String 

File Version 

<File Version> [File Path] [comparison operator] [Version_number] 

The version of a file on the target computer, for example: 

<File Version> "%WINDIR%\MS.DLL" >= 6.1.0.0 

The "File Version" item type is a version number, and is considered "0.0.0.0" if the given file does 
not exist, or if it has no version information. (See Values.) 

Variable Type 

Version 

Folder 

[logical operator] <Folder> ["Folder Path"] 

The path and folder name for a folder on the target computer, for example: 

EXISTS <Folder> "C:\Program Files\Acme Software\Acme App" 

Variable Type 

String 

Free Space 

<FreeSpace> ["File Path"] [comparison operator] ["Number of TB/GB/MB/KB"] 

The amount of free space available on the specified drive. Specify the unit of measure. 

For example: 

<FreeSpace> "C:\" > 500MB 

Variable Type 

Size/Number 

INI Value 

<INI Value> ["Filepath\\section\\key"] [comparison operator] [Value] 

INI Value items must have three double-backslash-separated items: the file path, the section 
name, and the key name. For example: 

<INI Value> "%WINDIR%\Acme.ini\\Audio Section\\Sample Rate" = "InetProtocol file" 

Variable Type 

String 
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Registry Key 

[logical operator] <Registry Key> ["Registry Key Path"] 

Identifies a specific registry key on the target computer. For example: 

EXISTS <Registry key> "HKEY_CLASSES_ROOT\exefile" 

Variable Type 

String 

Registry Value 

<Registry Value> ["Registry Key Path\\Value"] [comparison operator] [Value] 

Identifies a specific registry value on the target computer. Two items, one for the key and one for 
the value name, must be provided and separated by two backslashes (both parts within the same 
set of quotes, not separately quoted). For example: 

<Registry Value> 
"HKEY_LOCAL_MACHINE\SOFTWARE\Adobe\Acrobat\Reader\5.0\AdobeViewer\\Trusted 
Mode" = 2 

To query default registry values, use this syntax: 

<Registry Value> "HKLM\Software\\" = <value> 

Variable Type 

String 

Total Space on Path 

<TotalSpace> ["File Path"] [comparison operator] ["Number of TB/GB/MB/KB"] 

Total disk space on the drive where "path" is located. Specify the unit of measure. 

<TotalSpace> "C:\" > 500MB 

Variable Type 

Size/Number 

WMI 

<WMI> ["WMI Class"] [comparison operator] [Value] 

WMI items must specify a WMI class, a comparison operator, and a value. For example: 

<WMI> "Win32_OSRecoveryConfiguration.WriteToSystemLog" = "True" 

Variable Type 

Depends on the WMI variable. 

Predefined Variables 

Predefined Variables 

Predefined variables include those that are part of Policy Commander like PT_CD, and those 
defined as part of the Policy Commander file installation rules. For some predefined variables, the 
possible values are provided by Policy Commander, not the environment—these values are 
called constants. For example, Policy Commander includes a list of potential values for the 
CPUFamily variable—486, PentiumPro/II/III-Athlon, Pentium4, and so on. 
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Predefined variables are used without special punctuation or text. For example, a rule to evaluate 
the amount of RAM on the target computer: 

RAM >= 128MB 

If the name of a predefined variable is enclosed in quotes, it is interpreted as a string value—not 
considered to be a predefined variable. For example, "CPUMaker" is a string with the value 
CPUMaker. CPUMaker is a predefined variable containing the CPU type. 

Computer Active Directory (AD) Name 

ComputerADName [comparison operator] ["Domain/Organizational Unit/Name"] 

Active Directory (AD) name of the computer. The name must be written in canonical format, for 
example: 

ComputerADName = "NewBoundary.local/Computers/pc1" 

Variable Type 

String 

Computer DNS Name 

ComputerDNSName [comparison operator] ["DNS Name"] 

DNS name of the computer 

Variable Type 

String 

Computer Domain 

ComputerDomain [comparison operator] ["Domain"] 

The domain or workgroup of the computer. 

Variable Type 

String 

Computer Name 

ComputerName [comparison operator] ["Computer Name"] 

Host name of the computer. This variable resolves to %computername%. 

Variable Type 

String 

CPU Family 

CPUFamily [comparison operator] [Constant] 

Family of the computer’s primary processor. 

Variable Type 

String 

Constants 

 Pre486 
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 486 

 Pentium_K5/K6 

 PentiumPro/II/III_Athlon 

 Pentium4 

 Other 

CPU Maker 

CPUMaker [comparison operator] [Constant] 

Manufacturer of the computer’s primary processor. 

Variable Type 

String 

Constants 

 AMD 

 Centaur 

 Cyrix 

 Intel 

 Unknown 

CPU Model 

CPUModel [comparison operator] [Constant] 

Model of the computer’s primary processor. 

Variable Type 

String 

Constants 

 AMD_AM486 

 AMD_K5_Model_0 

 AMD_K5_Model_1 

 AMD_K5_Model_2 

 AMD_K5_Model_3 

 AMD_K6_Model_6 

 AMD_K6_Model_7 

 AMD_K6-2_Model_8 

 AMD_K6-3_Model_9 

 AMD_K6-3_Model_10 

 AMD_K6-3_Model_11 

 AMD_K6-3_Model_12 

 Intel_486DX2_Model_3 

 Intel_486SL_Model_4 

 Intel_486SX2_Model_5 

 Intel_486DX2E_Model_7 

 Intel_486DX4_Model_8 

 Intel_Other_486_CPU 

 Intel_Pentium_Model_1 

 Intel_Pentium_Model_2 

 Intel_Pentium_Model_3 

 Intel_Pentium_MMX_Model_4 

 Intel_Other_Pentium(P5)_CPU 

 Intel_Pentium-Pro_Model_1 
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 AMD_K6-3_Model_13 

 AMD_K6-3_Model_14 

 AMD_K6-3_Model_15 

 AMD_Other_K5/K6_CPU 

 AMD_ATHLON 

 AMD_Other_CPU 

 Cyrix_CPU 

 Centaur_CPU 

 Intel_486DX_Model_0 

 Intel_486DX_Model_1 

 Intel_486SX_Model_2 

 Intel_Pentium-II_Model_3 

 Intel_Pentium-II_Model_5 

 Intel_Celeron_Model_6 

 Intel_Pentium-III_Model_7 

 Intel_Pentium-III_Model_8 

 Intel_Pentium-III_Model_10 

 Intel_Pentium-III_Mobile_Model_11 

 Intel_Other_Pentium(P6)_CPU 

 Intel_Pentium-4_Model_0 

 Intel_Other_Pentium(P15)_CPU 

 Intel_Other_CPU 

First CD Letter 

FirstCDLetter [comparison operator] [Constant] 

Drive letter of the first CD-ROM drive on the computer. 

Variable Type 

String 

Constants 

A, B, C, ... Z 

IP Address 

IPAddress [comparison operator] ["Value"] 

The IP address of the primary network card in the computer. If the target computer has multiple 
IP addresses, this value actually contains multiple IP addresses—so you can compare to any of 
its IP addresses. 

Variable Type 

String 

NIC Address 

NICAddress [comparison operator] ["Value"] 

The NIC address of the primary network card in the computer. If the target computer has multiple 
network cards, this value actually contains multiple NIC addresses—so you can compare to any 
of its NIC addresses. 

Variable Type 

String 

Number of CPUs 

NumCPUs [comparison operator] [Number] 

The number of CPUs installed and supported on the computer. 
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Variable Type 

Number 

Operating System Bits 

OSBits [comparison operator] [Constant] 

Indicates if the operating system is 32-bits or 64-bits. 

Variable Type 

String 

Constants 

 32-Bit 

 64-Bit 

Operating System Components 

OSComponent [comparison operator] [Constant] 

The extra components installed on the client operating system. For example, Windows XP Home 
Edition or Terminal Services. 

Variable Type 

String 

Constants 

 Windows Small Business Server 

 Windows 2000 Advanced Server or Windows .NET Enterprise Server 

 Microsoft Backoffice 

 Terminal Services 

 Microsoft Small Business Server (restrictive client license) 

 Windows 2000 or Windows .NET Datacenter Server 

 Non-application server mode running one interactive session 

 Windows XP Home Edition 

 Windows .NET Web Server 

 Windows Storage Server 2003 

 Windows Server 2003 Compute Cluster Edition 

 Windows Home Server 

Operating System Edition 

OSEdition [comparison operator] [Constant] 

The edition of the operating system. 

Variable Type 

String 

Constants 
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 Edition Undefined 

 Ultimate Edition 

 Home Basic Edition 

 Home Premium Edition 

 Enterprise Edition 

 Home Basic Edition N 

 Business Edition 

 Server Standard Edition (full installation) 

 Server Datacenter Edition (full installation) 

 Small Business Server 

 Server Enterprise Edition (full installation) 

 Starter Edition 

 Server Datacenter Edition (core installation) 

 Server Standard Edition (core installation) 

 Server Enterprise Edition (core installation) 

 Server Enterprise Edition for Itanium-based Systems 

 Business Edition N 

 Web Server Edition 

 Cluster Server Edition 

 Home Server Edition 

 Storage Server Express Edition 

 Storage Server Standard Edition 

 Storage Server Workgroup Edition 

 Storage Server Enterprise Edition 

 Server for Small Business Edition 

 Small Business Server Premium Edition 

 Home Premium Edition N 

 Enterprise Edition N 

 Ultimate Edition N 

 Windows Server 2003 R2 

 Unlicensed 

Operating System Family 

OSFamily [comparison operator] [Constant] 

The operating system family on the computer. 

Variable Type 
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String 

Constants 

 Windows NT Family 

Operating System Revision 

OSRevision [comparison operator] [Constant] 

The service-pack revision of the operating system. 

Variable Type 

String 

Constants 

 Windows 2000, Initial Release 

 Windows 2000, Service Pack 1 

 Windows 2000, Service Pack 2 

 Windows 2000, Service Pack 3 

 Windows 2000, Service Pack 4 

 Windows Server 2000, Initial Release 

 Windows Server 2000, Service Pack 1 

 Windows Server 2000, Service Pack 2 

 Windows Server 2000, Service Pack 3 

 Windows Server 2000, Service Pack 4 

 Windows XP, Initial Release 

 Windows XP, Service Pack 1 

 Windows XP, Service Pack 2 

 Windows XP, Service Pack 3 

 Windows XP x64, Initial Release 

 Windows XP x64, Service Pack 1 

 Windows XP x64, Service Pack 2 

 Windows Server 2003, Initial Release 

 Windows Server 2003, Service Pack 1 

 Windows Server 2003, Service Pack 2 

 Windows Vista, Initial Release 

 Windows Vista, Service Pack 1 

 Windows Vista, Service Pack 2 

 Windows Server 2008, Initial Release 

 Windows Server 2008, Service Pack 2 

 Windows Server 2008 R2, Initial Release 



Grouping Computers 

101 

 Windows Server 2008 R2, Service Pack 1 

 Windows 7, Initial Release 

 Windows 7, Service Pack 1 

Operating System Role 

OSRole [comparison operator] [Constant] 

Role in which the computer’s operating system operates. For example, Workstation, Server, or 
Domain Controller. 

Variable Type 

String 

Constants 

 Domain Controller 

 Workstation 

 Server 

Operating System Version 

OSVersion [comparison operator] [Constant] 

The specific operating system on the computer. 

Variable Type 

String 

Constants 

 Windows 2000 

 Windows Server 2000 

 Windows XP 

 Windows XP x64 

 Windows Server 2003 

 Windows Vista 

 Windows Server 2008 

 Windows Server 2008 R2 

 Windows 7 

RAM 

RAM [comparison operator] [Number] 

Amount of ram on the computer, in bytes 

Variable Type 

Size / Number 
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System Base Language 

SystemBaseLanguage [comparison operator] [Constant] 

The base language identifier (LANGID) for the managed computer. The base language 
identifiers, both SystemBaseLanguage and UserBaseLanguage, identify a family of languages—
English, French, and so on. 

Variable Type 

String 

Constants 

Value* Descriptive Name** 

Language.Base.Arabic Arabic 

Language.Base.Bulgarian Bulgarian 

Language.Base.Catalan Catalan 

Language.Base.Chinese Chinese 

Language.Base.Czech Czech 

Language.Base.Danish Danish 

Language.Base.German German 

Language.Base.Greek Greek 

Language.Base.English English 

Language.Base.Spanish Spanish 

Language.Base.Finnish Finnish 

Language.Base.French French 

Language.Base.Hebrew Hebrew 

Language.Base.Hungarian Hungarian 

Language.Base.Icelandic Icelandic 

Language.Base.Italian Italian 

Language.Base.Japanese Japanese 

Language.Base.Korean Korean 

Language.Base.Dutch Dutch 

Language.Base.Norwegian Norwegian 

Language.Base.Polish Polish 

Language.Base.Portuguese Portuguese 

Language.Base.Romanian Romanian 

Language.Base.Russian Russian 

Language.Base.Croatian Croatian 

Language.Base.Serbian Serbian 

Language.Base.Slovak Slovak 

Language.Base.Albanian Albanian 
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Language.Base.Swedish Swedish 

Language.Base.Thai Thai 

Language.Base.Turkish Turkish 

Language.Base.Urdu Urdu 

Language.Base.Indonesian Indonesian 

Language.Base.Ukrainian Ukrainian 

Language.Base.Belarusian Belarusian 

Language.Base.Slovenian Slovenian 

Language.Base.Estonian Estonian 

Language.Base.Latvian Latvian 

Language.Base.Lithuanian Lithuanian 

Language.Base.Farsi Farsi 

Language.Base.Vietnamese Vietnamese 

Language.Base.Armenian Armenian 

Language.Base.Azeri Azeri 

Language.Base.Basque Basque 

Language.Base.FYROMacedonian FYRO Macedonian 

Language.Base.Afrikaans Afrikaans 

Language.Base.Georgian Georgian 

Language.Base.Faeroese Faeroese 

Language.Base.Hindi Hindi 

Language.Base.Malay Malay 

Language.Base.Kazak Kazak 

Language.Base.Kyrgyz Kyrgyz 

Language.Base.Swahili Swahili 

Language.Base.Uzbek Uzbek 

Language.Base.Tatar Tatar 

Language.Base.Punjabi Punjabi 

Language.Base.Gujarati Gujarati 

Language.Base.Tamil Tamil 

Language.Base.Telugu Telugu 

Language.Base.Kannada Kannada 

Language.Base.Marathi Marathi 

Language.Base.Sanskrit Sanskrit 

Language.Base.Mongolian Mongolian 

Language.Base.Galician Galician 

Language.Base.Konkani Konkani 
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Language.Base.Syriac Syriac 

Language.Base.Divehi Divehi 

Language.Base.Catalan Catalan 

Language.Base.Chinese Chinese 

Language.Base.Czech Czech 

Language.Base.Danish Danish 

Language.Base.German German 

Language.Base.Greek Greek 

Language.Base.English English 

Language.Base.Spanish Spanish 

Language.Base.Finnish Finnish 

Language.Base.French French 

Language.Base.Hebrew Hebrew 

Language.Base.Hungarian Hungarian 

Language.Base.Icelandic Icelandic 

Language.Base.Italian Italian 

Language.Base.Japanese Japanese 

Language.Base.Korean Korean 

Language.Base.Dutch Dutch 

Language.Base.Norwegian Norwegian 

Language.Base.Polish Polish 

Language.Base.Portuguese Portuguese 

Language.Base.Romanian Romanian 

Language.Base.Russian Russian 

Language.Base.Croatian Croatian 

Language.Base.Serbian Serbian 

Language.Base.Slovak Slovak 

Language.Base.Albanian Albanian 

Language.Base.Swedish Swedish 

Language.Base.Thai Thai 

Language.Base.Turkish Turkish 

Language.Base.Urdu Urdu 

Language.Base.Indonesian Indonesian 

Language.Base.Ukrainian Ukrainian 

Language.Base.Belarusian Belarusian 

Language.Base.Slovenian Slovenian 

Language.Base.Estonian Estonian 
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Language.Base.Latvian Latvian 

Language.Base.Lithuanian Lithuanian 

Language.Base.Farsi Farsi 

Language.Base.Vietnamese Vietnamese 

Language.Base.Armenian Armenian 

Language.Base.Azeri Azeri 

Language.Base.Basque Basque 

Language.Base.FYROMacedonian FYRO Macedonian 

Language.Base.Afrikaans Afrikaans 

Language.Base.Georgian Georgian 

Language.Base.Faeroese Faeroese 

Language.Base.Hindi Hindi 

Language.Base.Malay Malay 

Language.Base.Kazak Kazak 

Language.Base.Kyrgyz Kyrgyz 

Language.Base.Swahili Swahili 

Language.Base.Uzbek Uzbek 

Language.Base.Tatar Tatar 

Language.Base.Punjabi Punjabi 

Language.Base.Gujarati Gujarati 

Language.Base.Tamil Tamil 

Language.Base.Telugu Telugu 

Language.Base.Kannada Kannada 

Language.Base.Marathi Marathi 

Language.Base.Sanskrit Sanskrit 

Language.Base.Mongolian Mongolian 

Language.Base.Galician Galician 

Language.Base.Konkani Konkani 

Language.Base.Syriac Syriac 

Language.Base.Divehi Divehi 

  

*  If you are typing a constant directly in the Rules Editor, use the constant as it is given in the first 
column. 

**  The descriptive name is displayed in the drop-down list in the Rules Editor. 

System Full Language 

SystemFullLanguage [comparison operator] [Constant] 
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The full language identifier (LANGID) for the managed computer. The full language identifiers, 
both SystemFullLanguage and UserFullLanguage, identify a specific language variant—English 
(United Kingdom), German (Germany), German (Austria), and so on. 

Variable Type 

String 

Constants 

Value* Descriptive Name** 

Language.Full.Afrikaans Afrikaans 

Language.Full.Albanian Albanian 

Language.Full.Arabic.SaudiArabia Arabic (Saudi Arabia) 

Language.Full.Arabic.Iraq Arabic (Iraq) 

Language.Full.Arabic.Egypt Arabic (Egypt) 

Language.Full.Arabic.Libya Arabic (Libya) 

Language.Full.Arabic.Algeria Arabic (Algeria) 

Language.Full.Arabic.Morocco Arabic (Morocco) 

Language.Full.Arabic.Tunisia Arabic (Tunisia) 

Language.Full.Arabic.Oman Arabic (Oman) 

Language.Full.Arabic.Yemen Arabic (Yemen) 

Language.Full.Arabic.Syria Arabic (Syria) 

Language.Full.Arabic.Jordan Arabic (Jordan) 

Language.Full.Arabic.Lebanon Arabic (Lebanon) 

Language.Full.Arabic.Kuwait Arabic (Kuwait) 

Language.Full.Arabic.UAE Arabic (U.A.E.) 

Language.Full.Arabic.Bahrain Arabic (Bahrain) 

Language.Full.Arabic.Qatar Arabic (Qatar) 

Language.Full.Armenian Armenian 

Language.Full.Azeri.Latin Azeri (Latin) 

Language.Full.Azeri.Cyrillic Azeri (Cyrillic) 

Language.Full.Basque Basque 

Language.Full.Belarusian Belarusian 

Language.Full.Bulgarian Bulgarian 

Language.Full.Burmese Burmese 

Language.Full.Catalan Catalan 

Language.Full.Chinese.Taiwan Chinese (Taiwan) 

Language.Full.Chinese.PRC Chinese (PRC) 

Language.Full.Chinese.HongKong Chinese (Hong Kong SAR, PRC) 

Language.Full.Chinese.Singapore Chinese (Singapore) 
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Language.Full.Chinese.Macau Chinese (Macau SAR) 

Language.Full.Croatian Croatian 

Language.Full.Czech Czech 

Language.Full.Danish Danish 

Language.Full.Divehi Divehi 

Language.Full.Dutch.Netherlands Dutch (Netherlands) 

Language.Full.Dutch.Belgium Dutch (Belgium) 

Language.Full.English.UnitedStates English (United States) 

Language.Full.English.UnitedKingdom English (United Kingdom) 

Language.Full.English.Australian English (Australian) 

Language.Full.English.Canadian English (Canadian) 

Language.Full.English.NewZealand English (New Zealand) 

Language.Full.English.Ireland English (Ireland) 

Language.Full.English.SouthAfrica English (South Africa) 

Language.Full.English.Jamaica English (Jamaica) 

Language.Full.English.Caribbean English (Caribbean) 

Language.Full.English.Belize English (Belize) 

Language.Full.English.Trinidad English (Trinidad) 

Language.Full.English.Zimbabwe English (Zimbabwe) 

Language.Full.English.Philippines English (Philippines) 

Language.Full.Estonian Estonian 

Language.Full.Faeroese Faeroese 

Language.Full.Farsi Farsi 

Language.Full.Finnish Finnish 

Language.Full.French.Standard French (Standard) 

Language.Full.French.Belgian French (Belgian) 

Language.Full.French.Canadian French (Canadian) 

Language.Full.French.Switzerland French (Switzerland) 

Language.Full.French.Luxembourg French (Luxembourg) 

Language.Full.French.Monaco French (Monaco) 

Language.Full.Galician Galician 

Language.Full.Georgian Georgian 

Language.Full.German.Standard German (Germany) 

Language.Full.German.Switzerland German (Switzerland) 

Language.Full.German.Austria German (Austria) 

Language.Full.German.Luxembourg German (Luxembourg) 

Language.Full.German.Liechtenstein German (Liechtenstein) 
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Language.Full.Greek Greek 

Language.Full.Gujarati Gujarati 

Language.Full.Hebrew Hebrew 

Language.Full.Hindi Hindi 

Language.Full.Hungarian Hungarian 

Language.Full.Icelandic Icelandic 

Language.Full.Indonesian Indonesian 

Language.Full.Italian.Standard Italian (Standard) 

Language.Full.Italian.Switzerland Italian (Switzerland) 

Language.Full.Japanese Japanese 

Language.Full.Kannada Kannada 

Language.Full.Konkani Konkani 

Language.Full.Korean Korean 

Language.Full.Korean.Johab Korean.Johab 

Language.Full.Kyrgyz Kyrgyz 

Language.Full.Latvian Latvian 

Language.Full.Lithuanian Lithuanian 

Language.Full.Lithuanian.Classic Lithuanian (Classic) 

Language.Full.FYROMacedonian FYRO Macedonian 

Language.Full.Malay.Malaysian Malay (Malaysian) 

Language.Full.Malay.BruneiDarussalam Malay (Brunei Darussalam) 

Language.Full.Marathi Marathi 

Language.Full.Mongolian Mongolian 

Language.Full.Norwegian.Bokmal Norwegian (Bokmal) 

Language.Full.Norwegian.Nynorsk Norwegian (Nynorsk) 

Language.Full.Polish Polish 

Language.Full.Portuguese.Brazil Portuguese (Brazil) 

Language.Full.Portuguese.Portugal Portuguese (Portugal) 

Language.Full.Punjabi Punjabi 

Language.Full.Romanian Romanian 

Language.Full.Russian Russian 

Language.Full.Sanskrit Sanskrit 

Language.Full.Serbian.Cyrillic Serbian (Cyrillic) 

Language.Full.Serbian.Latin Serbian (Latin) 

Language.Full.Slovak Slovak 

Language.Full.Slovenian Slovenian 

Language.Full.Spanish.Spain.TraditionalSort  Spanish (Spain, Traditional Sort) 
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Language.Full.Spanish.Mexican Spanish (Mexican) 

Language.Full.Spanish.Spain.ModernSort Spanish (Spain, Modern Sort) 

Language.Full.Spanish.Guatemala Spanish (Guatemala) 

Language.Full.Spanish.CostaRica Spanish (Costa Rica) 

Language.Full.Spanish.Panama Spanish (Panama) 

Language.Full.Spanish.DominicanRepublic  Spanish (Dominican Republic) 

Language.Full.Spanish.Venezuela Spanish (Venezuela) 

Language.Full.Spanish.Colombia Spanish (Colombia) 

Language.Full.Spanish.Peru Spanish (Peru) 

Language.Full.Spanish.Argentina Spanish (Argentina) 

Language.Full.Spanish.Ecuador Spanish (Ecuador) 

Language.Full.Spanish.Chile Spanish (Chile) 

Language.Full.Spanish.Uruguay Spanish (Uruguay) 

Language.Full.Spanish.Paraguay Spanish (Paraguay) 

Language.Full.Spanish.Bolivia Spanish (Bolivia) 

Language.Full.Spanish.ElSalvador Spanish (El Salvador) 

Language.Full.Spanish.Honduras Spanish (Honduras) 

Language.Full.Spanish.Nicaragua Spanish (Nicaragua) 

Language.Full.Spanish.PuertoRico Spanish (Puerto Rico) 

Language.Full.Sutu Sutu 

Language.Full.Swahili.Kenya Swahili (Kenya) 

Language.Full.Swedish Swedish 

Language.Full.Swedish.Finland Swedish (Finland) 

Language.Full.Syriac Syriac 

Language.Full.Tamil Tamil 

Language.Full.Tatar.Tatarstan Tatar (Tatarstan) 

Language.Full.Telugu Telugu 

Language.Full.Thai Thai 

Language.Full.Turkish Turkish 

Language.Full.Ukrainian Ukrainian 

Language.Full.Urdu.Pakistan Urdu (Pakistan) 

Language.Full.Urdu.India Urdu (India) 

Language.Full.Uzbek.Latin Uzbek (Latin) 

Language.Full.Uzbek.Cyrillic Uzbek (Cyrillic) 

Language.Full.Vietnamese Vietnamese 
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*  If you are typing a constant directly in the Rules Editor, use the constant as it is given in the first 
column. 

**  The descriptive name is displayed in the drop-down list in the Rules Editor. 

Time Zone 

TimeZone [comparison operator] [Constant] 

The Current Time Zone specified in the computer’s date and time properties. For example 
Central Standard Time. 

Variable Type 

String 

Constants 

Value* Descriptive Name** 

TimeZone.DatelineStandardTime (GMT-12:00) International Date Line West 

TimeZone.SamoaStandardTime (GMT-11:00) Midway Island, Samoa 

TimeZone.HawaiianStandardTime (GMT-10:00) Hawaii 

TimeZone.AlaskanStandardTime (GMT-09:00) Alaska 

TimeZone.PacificStandardTime (GMT-08:00) Pacific Time (US & Canada); 
Tijuana 

TimeZone.MountainStandardTime (GMT-07:00) Mountain Time (US & Canada) 

TimeZone.MexicoStandardTime2 (GMT-07:00) Chihuahua, La Paz, Mazatlan 

TimeZone.USMountainStandardTime (GMT-07:00) Arizona 

TimeZone.CentralStandardTime (GMT-06:00) CentralTime (US & Canada) 

TimeZone.CanadaCentralStandardTime (GMT-06:00) Saskatchewan 

TimeZone.MexicoStandardTime (GMT-06:00) Guadalajara, Mexico City, 
Monterrey 

TimeZone.CentralAmericaStandardTime (GMT-06:00) CentralAmerica 

TimeZone.EasternStandardTime (GMT-05:00) Eastern Time (US & Canada) 

TimeZone.USEasternStandardTime (GMT-05:00) Indiana (East) 

TimeZone.SAPacificStandardTime (GMT-05:00) Bogota, Lima, Quito 

TimeZone.AtlanticStandardTime (GMT-04:00) Atlantic Time (Canada) 

TimeZone.PacificSAStandardTime (GMT-04:00) Santiago 

TimeZone.SAWesternStandardTime (GMT-04:00) Caracas, La Paz 

TimeZone.NewfoundlandStandardTime (GMT-03:30) Newfoundland 

TimeZone.GreenlandStandardTime (GMT-03:00) Greenland 

TimeZone.SAEasternStandardTime (GMT-03:00) Buenos Aires, Georgetown 

TimeZone.E.SouthAmericaStandardTime (GMT-03:00) Brasilia 
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TimeZone.Mid-AtlanticStandardTime (GMT-02:00) Mid-Atlantic 

TimeZone.CapeVerdeStandardTime (GMT-01:00) Cape Verde Is. 

TimeZone.AzoresStandardTime (GMT-01:00) Azores 

TimeZone.GMTStandardTime (GMT) Greenwich Mean Time : Dublin, 
Edinburgh, Lisbon, London 

TimeZone.GreenwichStandardTime (GMT) Casablanca, Monrovia 

TimeZone.RomanceStandardTime (GMT+01:00) Brussels, Copenhagen, Madrid, 
Paris 

TimeZone.W.EuropeStandardTime (GMT+01:00) Amsterdam, Berlin, Bern, 
Rome, Stockholm, Vienna 

TimeZone.CentralEuropeStandardTime (GMT+01:00) Belgrade, Bratislava, Budapest, 
Ljubljana,Prague 

TimeZone.CentralEuropeanStandardTime (GMT+01:00) Sarajevo, Skopje, Warsaw, 
Zagreb 

TimeZone.W.CentralAfricaStandardTime (GMT+01:00) West Central Africa 

TimeZone.GTBStandardTime (GMT+02:00) Athens, Istanbul, Minsk 

TimeZone.SouthAfricaStandardTime (GMT+02:00) Harare, Pretoria 

TimeZone.E.EuropeStandardTime (GMT+02:00) Bucharest 

TimeZone.EgyptStandardTime (GMT+02:00) Cairo 

TimeZone.FLEStandardTime (GMT+02:00) Helsinki, Kyiv, Riga, Sofia, 
Tallinn, Vilnius 

TimeZone.IsraelStandardTime (GMT+02:00) Jerusalem 

TimeZone.ArabicStandardTime (GMT+03:00) Baghdad 

TimeZone.ArabStandardTime (GMT+03:00) Kuwait, Riyadh 

TimeZone.RussianStandardTime (GMT+03:00) Moscow, St. Petersburg, 
Volgograd 

TimeZone.E.AfricaStandardTime (GMT+03:00) Nairobi 

TimeZone.IranStandardTime (GMT+03:30) Tehran 

TimeZone.ArabianStandardTime (GMT+04:00) Abu Dhabi, Muscat 

TimeZone.CaucasusStandardTime (GMT+04:00) Baku, Tbilisi, Yerevan 

TimeZone.AfghanistanStandardTime (GMT+04:30) Kabul 

TimeZone.EkaterinburgStandardTime (GMT+05:00) Ekaterinburg 

TimeZone.WestAsiaStandardTime (GMT+05:00) Islamabad, Karachi, Tashkent 

TimeZone.IndiaStandardTime (GMT+05:30) Chennai, Kolkata, Mumbai, New 
Delhi 

TimeZone.NepalStandardTime (GMT+05:45) Kathmandu 

TimeZone.N.CentralAsiaStandardTime (GMT+06:00) Almaty, Novosibirsk 
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TimeZone.CentralAsiaStandardTime (GMT+06:00) Astana, Dhaka 

TimeZone.SriLankaStandardTime (GMT+06:00) Sri Jayawardenepura 

TimeZone.MyanmarStandardTime (GMT+06:30) Rangoon 

TimeZone.SEAsiaStandardTime (GMT+07:00) Bangkok, Hanoi, Jakarta 

TimeZone.NorthAsiaStandardTime (GMT+07:00) Krasnoyarsk 

TimeZone.ChinaStandardTime (GMT+08:00) Beijing, Chongqing, Hong Kong, 
Urumqi 

TimeZone.NorthAsiaEastStandardTime (GMT+08:00) Irkutsk, Ulaan Bataar 

TimeZone.SingaporeStandardTime (GMT+08:00) Kuala Lumpur, Singapore 

TimeZone.W.AustraliaStandardTime (GMT+08:00) Perth 

TimeZone.TaipeiStandardTime (GMT+08:00) Taipei 

TimeZone.TokyoStandardTime (GMT+09:00) Osaka, Sapporo, Tokyo 

TimeZone.KoreaStandardTime (GMT+09:00) Seoul 

TimeZone.YakutskStandardTime (GMT+09:00) Yakutsk 

TimeZone.Cen.AustraliaStandardTime (GMT+09:30) Adelaide 

TimeZone.AUSCentralStandardTime (GMT+09:30) Darwin 

TimeZone.AUSEasternStandardTime (GMT+10:00) Canberra, Melbourne, Sydney 

TimeZone.E.AustraliaStandardTime (GMT+10:00) Brisbane 

TimeZone.WestPacificStandardTime (GMT+10:00) Guam, Port Moresby 

TimeZone.TasmaniaStandardTime (GMT+10:00) Hobart 

TimeZone.VladivostokStandardTime (GMT+10:00) Vladivostok 

TimeZone.CentralPacificStandardTime (GMT+11:00) Magadan, Solomon Is., New 
Caledonia 

TimeZone.NewZealandStandardTime (GMT+12:00) Auckland, Wellington 

TimeZone.FijiStandardTime (GMT+12:00) Fiji, Kamchatka, Marshall Is. 

TimeZone.TongaStandardTime (GMT+13:00) Nuku'alofa 

*  If you are typing a constant directly in the Rules Editor, use the constant as it is given in the first 
column. 

**  The descriptive name is displayed in the drop-down list in the Rules Editor. 

User Active Directory (AD) Name 

UserADName [comparison operator] ["Domain/Organizational Unit/user name"] 

Active Directory (AD) name of the current user. The name must be written in canonical format, for 
example: 

UserADName = "NewBoundary.local/marketing/val" 

Variable Type 

String 
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User Base Language 

UserBaseLanguage [comparison operator] [Constant] 

The base language identifier (LANGID) for the current user. 

Variable Type 

String 

Constants 

See the list of constants for System Base Language 

User Domain 

UserDomain [comparison operator] ["Value"] 

The domain or workgroup of the current user. 

Variable Type 

String 

User Full Language 

UserFullLanguage [comparison operator] [Constant"] 

The full language identifier (LANGID) for the current user. 

Variable Type 

String 

Constants 

See the list of constants for System Full Language 

User Name 

UserName [comparison operator] ["Name"] 

The name of the user currently logged on to the computer. If no one is logged on, Username is 
<unattended>. For example, create a new user-defined group and type UserName = "Julie", then 
assign a Task to this subgroup. The subgroup is populated with a new member each time Julie 
logs on to a computer that is on the network. From one Task assignment, Julie receives the Task 
on each computer she logs on to, without taking time to identify each computer and assigning the 
Task to each of these computers. 

This variable resolves to %username%. 

Variable Type 

String 



Policy Commander 

114 

Group Properties 

General tab (Group Properties) 

 

The Group Properties | General tab displays information about the group currently highlighted in 
the main window. 

The Group Properties | General tab is displayed when you right-click on the name of a group and 
choose Properties from the pop-up menu. 

The information includes: 

 Descriptive name for the group. 

 Type: The type of group. 

 Rule: If the group is a user-defined subgroup, the tab shows the text of the rule and 
includes an Edit Rule button. This button is not available for other types of groups.  
 
Edit Rule: Open the Rule Editor, where you can edit or change the rule that defines the 
group. After making changes to the rule, the group is re-populated, based on the criteria 
set with the new rule. 
 
(See Editing an Existing Rule.) 
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Role Security tab (Group Properties) 

 

The Group Properties | Role Security tab displays information about the roles that are allowed 
to see the group and modify the computers within the group. 

The Group Properties dialog box is displayed when you right-click on the name of a group and 
choose Properties from the pop-up menu. Click the Role Security tab to view this tab. 

If a role is not selected, a user in that role: 

 Will not be able to see the group in the console; 

 Will not be able to modify the computers that are members of that group elsewhere in 
the console. This means, for example, that they will not be able to make assignments to 
those computers through other (visible) groups to which any of those computers belong. 
If they assign to such a group, the assignment applies only to those computers that user 
can see; the secured computers will not receive the assignment. 

The list of all secured groups in the channel can be seen from the Manage Security dialog. Also 
within that dialog, the list of groups secured from a specific role can be seen in the Role 
Properties dialog (within the Secured Groups tab). 

Note    This tab is visible only if the channel is secured and the user has permission to view 
security information. 
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Members tab (Group Properties) 

 

The Group Properties | Members tab displays information about the computers that are 
members of the selected group. On this window, you can also add additional computers as 
members or remove members from an organizational group. 

Note: Configuration groups are populated automatically. You cannot change the membership of 
configuration groups on this tab. 

The Group Properties dialog box is displayed when you right-click on the name of a group and 
choose Properties from the pop-up menu. Click the Members tab to view this tab. 

Add members to an organizational group 

1. Click Add on the Group Properties | Members tab. 

2. In the Assign Computer dialog box, highlight the name of one or more computers. 

3. Click OK to add the new member(s) to the group. 

The new member(s) will receive any policies already assigned to the group, as well as policies 
assigned to the group in the future. 

Remove members from an organizational group 

1. Highlight the name of one or more computers on the Group Properties | Members tab. 
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2. Click Remove to remove the member(s) from the group. 

This member will no longer receive policies assigned to the group. 

Note: If you only want to temporarily remove a member from the group while you troubleshoot a 
problem, disable the computer. For more information, see the Computer Properties | 
General Tab. 
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Policies 

What is a policy? 

In Policy Commander, a "policy" is formally defined as follows: 

           A policy is an electronic representation of a computer configuration. It encapsulates 
everything needed to assess and enforce the compliance state of a computer, and is 
contained within a single file. 

A policy defines conditions for applicability and compliance on a target computer. Furthermore, it 
defines the actions necessary for that policy to become enforced. Defining a policy and its 
applicability, compliance, and enforcement steps is accomplished with the Policy Editor. 

For example, a given policy may be applicable only to Windows XP machines. When assigned to 
a computer, the policy's applicability steps are evaluated to determine whether or not the policy 
applies to the computer. If it does apply, the compliance steps are evaluated to assess 
compliance. If the computer is out of compliance with the policy, the administrator may enforce 
the policy, bringing the computer into compliance. Hence there are several compliance states that 
apply to the assignment of a policy to a computer. An assigned policy is in exactly one of those 
states at one time for any given computer. 

Policy Commander helps you monitor and enforce policies on your computers. As individual 
computers fall out of compliance from time to time, use Policy Commander to enforce the security 
settings immediately, or assess the situation and enforce each one individually. 

A policy's life cycle can be summarized as follows: 

1. A policy is assigned to a computer. 

2. The policy's applicability steps are evaluated on the computer. If they are not satisfied, 
the policy assignment is called Not Applicable and no further action is taken. 

3. The policy's compliance steps are evaluated on the computer. If the computer satisfies 
those steps, the policy assignment is called Compliant and no further action is taken. 

4. For a Not Compliant policy, the administrator can apply the enforcement steps to bring 
the computer into compliance. The policy assignment is called Enforced. The 
administrator may choose to make the policy enforce automatically. 

5. For an Enforced policy, the administrator can acknowledge the enforcement. The policy 
is then called Compliant. 

Steps 2-4 are repeated every time the client evaluates policies. 

The console provides several ways to manage, apply, and monitor policies in your channel. You 
can: 

 Import policies from a local file system on your PC or network. 

 Download policies from an external server. This can be done from the New Boundary 
Technologies knowledge base (over the web) or from other external policy libraries. 

 Export policies to the file system. 

 Delete a policy from your channel. 

 Launch the Policy Editor and create and edit your own policies. 

 Create policy groups, add policies to those groups, and remove policies from those 
groups. 

 View and modify policy properties. 
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 Assign policies to computers and computer groups. 

 Enforce a policy on a computer. 

 View the policy assignments for a computer, policy, or group. 

 View policy compliance for a specific set of policy assignments. 

 View a compliance summary showing the overall state of your system's compliance from 
a computer- or policy-centric perspective. 

Managing Policies 

Importing Policies 

Follow these steps to import a policy file from the file system into your channel: 

1. Select the Policies tab. 

2. On the Policies menu, select Import Policy from File. 

3. In the Open Policy File dialog, navigate to the folder containing the policy you want to 
import. Select the file and press Open. 

4. If the policy already exists in the channel, the Confirm Policy Overwrite dialog will 
appear. 

1. If you select Overwrite, the existing policy will be replaced in the channel. 

2. If you select Add New (the default behavior), a new policy will be added. Its 
name will be the same as the original, but the current date and time will be 
appended to make the name unique. You may want to change the name(s) to 
something more meaningful. 

Now the policy is ready for use. 

Downloading Policies 

Policy Commander makes it easy to download policies from external servers, notably the New 
Boundary Technologies Knowledge Base. 

To download a policy from an external policy server: 

1. On the Policies menu, select Import Policies from Policy Server.... 

2. In the Add Policies to your Channel dialog, select the desired external server. Press 
Next. This will connect you to the external server. 

3. The Import Policies from Policy Server dialog box displays the available policies in a tree 
structure. 

4. Select the policies you want to download and press the Add button. You can repeat this 
as many times as you wish. 

5. Press Close to terminate the connection. 

The policies you downloaded can be seen on the Policies tab. The downloaded policies appear 
under both the All Policies list and under the Imported Policies folder. Note that the folder 
structure of the external policy server is reflected under the Imported Policies folder. 
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Select Policy Server Dialog 

 

Select a source for the policies that you want to import into Policy Commander. The New 
Boundary Technologies knowledge base has an extensive collection of policies available for your 
use. 

This dialog opens when you select Import Policies from Policy Server from the Policies menu. 

Note:   The following URL needs to be whitelisted in environments that block outbound traffic: 

contentstore.newboundary.com  
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Import From Policy Server 

 

This dialog allows you to select policies to download to your channel. The title bar displays the 
name of the external server. 

The upper pane in this dialog displays the server's policies in a tree structure. The policies are 
organized by groups, and the groups may be nested. 

The lower pane displays a description of the policy or folder selected. This description may 
include hyperlinks to external sites, providing additional information about the policy. 

To add policies to your channel, simply select the individual policies or groups you want to 
download, and press the Add button. 

Buttons 

Back - Returns you to the Select Policy Server page. 

Close - Closes the dialog and terminates the connection. 

Add - This causes all checked policies and folders to be downloaded into your channel. 
You may select and add policies as many times as you wish. 

Clear - Clears the checked policies. This has no impact on your channel. 

Note:   The following URL needs to be whitelisted in environments that block outbound traffic: 

contentstore.newboundary.com  
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Exporting Policies 

Before the Policy Editor can be used to modify a policy in your channel, you need to export the 
policy to your file system. To export a policy to your local file system, follow these steps: 

1. Select the Policies tab. 

2. Select the policy you wish to export. 

3. On the Policies menu, select Export Policy to File.... 

4. In the Save Policy File dialog, navigate to the destination folder and if desired, modify 
the file name. Then press Save. This saves the policy to a file. 

5. The Policy Saved dialog then appears, asking if you would like to open the file in the 
Policy Editor. Press Yes to launch the Policy Editor. 

Deleting Policies 

When a policy is no longer useful or when it has been replaced, you can delete it from the 
Console. This action changes only the view and enforcement of policies through Policy 
Commander. It does not change or remove the underlying security template (INF) that was 
originally added to create the policy. 

To delete a policy from your channel: 

1. Select the Policies tab. 

2. Select the policy you want to delete. 

3. On the Edit menu, select Delete. 

Note    This can also be done using a right-click menu or by simply pressing the Delete 
button on your keyboard. 

4. A confirmation dialog appears to confirm the action. 

Creating and Editing Policies 

Using the Policy Editor, you can create new policies and modify existing policies. You can also 
make changes to individual security templates that are part of the policy. 

To edit an existing policy in your channel, you must: 

1. Export the policy to the file system. 

2. Launch the Policy Editor on that policy. When you export the policy, the Policy Saved 
dialog appears. Pressing Yes opens the Policy Editor on that saved policy file. 

3. Make your changes in the Policy Editor. 

4. Save the file in the Policy Editor. 

5. Import the policy back in to the channel. 

Policy Properties 

The Policy Properties dialog displays information about the policy. Using this dialog, you can view 
the policy's description, view assignments, and view compliance status. 

The Policy Properties dialog opens when you right-click on a policy and select Properties, or 
when you select a policy then select Properties on the Edit menu. 

 The General tab displays the policy's description and provides control over the Auto 
Enforce and Email Notify preferences. 
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 The Assignments tab shows the policy's current assignments. 

 The Compliance tab shows the policies current compliance status. 

General Tab (Policy Properties) 

 

The Policy Properties dialog opens when you right-click on a policy and select Properties, or 
when you select a policy then select Properties on the Edit menu. 

The General tab contains the following settings: 

 Description 
Provides a description of the policy and what it does. 

 When Out of Compliance 
 Notify via email: With this option selected, Policy Commander automatically sends an 

email message to each of the people who have requested email notification when a 
computer is out of compliance with this policy. Email addresses for notification are set 
up through the Manage Channel Security dialog, which can be accessed via the 
Security menu. 

 Notify via email: With this option cleared, email is not sent if a computer is out of 
compliance with the policy. 

  

 Automatically Enforce: With this option selected, the policy is automatically enforced 
on all computers to which the policy has been assigned. When the Client on a target 
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computer detects that it is out of compliance with the policy, Policy Commander 
automatically enforces the policy. 
 
The status changes to Enforced when the policy is successfully enforced. 

 Automatically Enforce: With this option cleared, you must initiate the enforcement 
manually. This is done using the Enforce Policy menu option. Until you enforce the 
policy, Policy Commander displays the Not Compliant status when it detects a 
computer out of compliance with this policy. 
  

Note:  Do not use the Automatically Enforce setting until you have tested the policy and 
are very confident in the policy’s settings. This option can be changed at any time 
through the Policy properties. 
  

Assignments Tab (Policy Properties) 

 

The Policy Properties dialog opens when you right-click on a policy and select Properties, or 
when you select a policy then select Properties on the Edit menu. 

The Assignments tab displays the policy's current policy assignments (see Policy Assignments 
tab for details). You can delete a policy assignment by right-clicking an assignment and selecting 
Delete Policy Assignment. 
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Compliance Tab (Policy Properties) 

 

The Policy Properties dialog opens when you right-click on a policy and select Properties, or 
when you select a policy then select Properties on the Edit menu. 

The Compliance tab displays the policy's current policy compliance. You can enforce and 
acknowledge policy assignments on this tab by right-clicking an assignment. 

Policy Groups 

Creating Policy Groups 

A policy group is a collection of related policies. 

A policy group can be assigned to a computer or group of computers. Assigning a policy group to 
any target is equivalent to assigning each individual policy in the group to the target. Note in 
particular that this means a policy added to a group after the group has been assigned to a 
computer will not automatically be assigned to that same computer. 

To create a policy group: 

1. Select the Policies tab. 

2. Select the policy group under which you want to create the new group. 

3. On the Edit menu, select Create Group.... (Or you can right-click on the group). 

4. The New Policy Group dialog appears. Enter the name of the new policy group. Then 
press OK. 

Policies can easily be added to groups or removed from groups. 

Adding Policies to a Group 

To add policies to a policy group: 

1. Select the Policies tab. 

2. Select the All Policies node in the tree. 

3. On the Members tab, select the policies you want to add to the policy group. 

4. On the Edit menu, select Add To Group (or you can right-click on the selected policy). 

5. The Add Policies to Group dialog appears. Select the target policy group. Then press 
OK. 
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Removing Policies from a Group 

To remove policies from a policy group: 

1. Select the Policies tab. 

2. Select the policy group in the tree. 

3. On the Members tab, select the policies you want to remove from the policy group. 

4. On the Edit menu, select Remove From Group (or you can right-click on the selected 
policy). 

5. A confirmation dialog appears. Press Yes to remove the policies from the group. 

  

Enforcing Policies 

Assigning a Policy 

For a policy to be enforced on a computer, the policy must first be assigned to the computer. 
Policy assignment can be done in a variety of ways in the console: using the policy assignment 
wizard or drag and drop, and starting with a policy and assigning it to target computers or starting 
with a computer and selecting policies to assign to it. 

Policy Assignment Wizard 

Starting with a Policy or Policy Group 

1. Select the Policies tab. 

2. Select the desired policy or policy group in the tree. 

3. On the Policies menu, select Assign Policy... (or you can right-click on the selected 
policy or policy group). 

4. The Assign Policy wizard appears. Press Next. 

5. In the Assign Policies dialog, select the computers or computer groups you want to 
assign the policy to. Press Finish to assign the policy or policy group to the selected 
targets. 

Starting with a Computer or Computer Group 

1. Select the Managed tab or Configuration Groups tab. 

2. Select the target computer or computer group in the tree. 

3. On the Policies menu, select Assign Policy... (or you can right-click on the selected 
computer or computer group). 

4. The Assign Policy wizard appears. Press Next. 

5. In the Assign Policies dialog, select the policies you want to assign to the computer or 
group. Press Finish to assign the selected policies to your computer or computer group. 

Drag and Drop 

Starting with a Policy or Policy Group 

1. Select the Policies tab. 

2. Select the desired policy or policy group in the tree. 

3. Select the All Targets tab. 
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4. Drag the policy or policy group to the target computer. 

Starting with a Computer or Computer Group 

1. Select the Managed tab or Configuration Groups tab. 

2. Select the target computer or group in the tree. 

3. Select the All Policies tab. 

4. Drag the target to the desired policy. 

Note    Policy group to computer group assignment via drag and drop is not allowed. 

Assign Targets Dialog 

 

On this page, select the target computers to which you want to assign the selected policies. This 
list includes all of the computers and computer groups in the channel. Policies assigned to the 
group are enforced on members of the group. 

This page opens when you click Next in the Assign Policy dialog. 

Press Finish to assign the policies to your selected targets. 
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Assign Policies Dialog 

 

On this page, select the policies that should be enforced for the selected targets. This list includes 
all of the policies in Policy Commander. Policies assigned to the group are enforced on members 
of the group. 

This page opens when you click Next in the Assign Policy dialog. 

Press Finish to assign the policies to your selected target. 

Viewing Assignments 

Policy assignments are viewed through the Policy Assignments tab. Each assignment shows the 
policy's name and the computer or computer group that through which it was assigned. 

Assignments for a Computer or Computer Group 

To see the assignments for a computer or computer group: 

1. Select the Managed tab or Configuration Groups tab. 

2. Select the desired computer or computer group in the tree. 

3. Select the Policy Assignments tab. 

The assignments for the selected computer or computer group will be displayed. For a computer, 
the assignments may include both direct assignments (Assigned Through the name of the 
computer) and assignments via a group that the computer belongs to. For a computer group, only 
the assignments to that specific group are shown. 

Assignments for a Policy 

To see the assignments for a policy: 

1. Select the Policies tab. 
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2. Select the desired policy in the tree. 

3. Select the Policy Assignments tab. 

The assignments for the selected policy will be displayed. 

Deleting a Policy Assignment 

Deleting an assignment can be done easily through the Policy Assignments tab. Deleting an 
assignment does not delete the policy or the target. When an assignment is deleted, that policy 
will not longer be evaluated on the target. 

To delete an assignment: 

1. Select the Managed tab, Configuration Groups tab, or Policies tab. 

2. Select the desired computer, computer group, or policy in the tree. 

3. Select the Policy Assignments tab. 

4. Right-click on the desired assignment and select Delete Policy Assignment. You can 
select multiple assignments if desired. 

Viewing Policy Compliance 

Policy compliance is viewed through the Policy Compliance tab. Each row in this tab shows the 
compliance state of a specific policy assignment. A policy assignment to a computer can be: 

Compliant: if the computer satisfies the compliance conditions defined within the policy. 

Not Compliant: if the computer fails to satisfy the compliance conditions defined within 
the policy. This may require enforcement on the part of the administrator. 

Enforced: if the policy has recently been enforced on the computer (after having been 
Not Compliant). To become compliant, the enforcement must be acknowledged by the 
administrator. 

Pending: when the computer has not yet reported its compliance state. 

Not Applicable: if the computer properties do not satisfy the policy's applicability 
conditions. 

Error: when there is an internal error in Policy Commander, such as a communication 
failure. 

Policy Compliance for a Computer or Computer Group 

To see compliance states for a computer or computer group: 

1. Select the Managed tab or Configuration Groups tab. 

2. Select the desired computer or computer group in the tree. 

3. Select the Policy Compliance tab. 

Policy Compliance for a Policy or Policy Group 

To see compliance states for a policy or policy group: 
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1. Select the Policies tab. 

2. Select the desired policy or policy group in the tree. 

3. Select the Policy Compliance tab. 

Note    To see the most up-to-date compliance states, you may want to refresh the console using 

the  button in the tool bar. 

Compliance States 

There are several compliance states that apply to the assignment of a policy to a computer: 

Compliant: A compliance state is compliant if the computer to which the policy is 
assigned satisfies the compliance conditions defined within the policy. 

Not Compliant: A compliance state is not compliant if the computer to which the 
policy is assigned fails to satisfy the compliance conditions defined within the policy. 

Enforced: A compliance state is enforced if the policy has recently been enforced on 
the computer. Enforcement makes the computer compliant. The next section illustrates 
enforcement. 

Pending: A compliance state is pending when the computer has not yet reported its 
compliance state. 

Not Applicable: A compliance state is not applicable if the policy has been assigned to 
the computer but the computer properties do not satisfy the policy's applicability 
conditions. 

Not assigned: A compliance state is not assigned if the policy has not been 
unassigned. 

Error: A compliance state is in the error state when there is an internal error in Policy 
Commander, such as a communication failure. 

Compliance Summary 

Compliance summaries are viewed through the Compliance Summary tab. The Compliance 
Summary tab conveys a summary view of compliance that the administrator can use to quickly 
determine the current level of compliance in the system. This tab serves as a dashboard for 
monitoring policy compliance. It also allows the administrator to drill down to a specific computer 
or policy, and to a specific policy assignment of interest. 

Viewing a Compliance Summary 

Compliance Summary for a Computer or Computer Group 

To see compliance states for a computer or computer group: 

1. Select the Managed tab or Configuration Groups tab. 
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2. Select the desired computer or computer group in the tree. 

3. Select the Compliance Summary tab. 

Compliance Summary for a Policy or Policy Group 

To see compliance states for a policy or policy group: 

1. Select the Policies tab. 

2. Select the desired policy or policy group in the tree. 

3. Select the Compliance Summary tab. 

Note    To see the most up-to-date compliance states, you may want to refresh the console using 

the  button in the tool bar. 

Enforcing a Policy 

When a computer is out of compliance with a policy, you can enforce it to bring it into compliance. 
Enforcement can be done manually through the Policy Compliance tab or the Compliance 
Summary tab. Enforcement can also be configured to be done automatically. 

Manual Enforcement 

To bring a computer into compliance with a policy: 

1. From the Policy Compliance tab, select the policy assignment that is Not Compliant (
). 

2. On the Policies menu, select Enforce Policy (or you can right-click on the selected 
policy assignment). 

3. The Confirm Policy Enforcement dialog appears. Press Yes to enforce the policy. 

You can also enforce all policy assignments for a computer or policy. 

1. From the Compliance Summary tab, select the computer or policy in the middle panel 

that is Not Compliant ( ). 

2. On the Policies menu, select Enforce Policy (or you can right-click on the selected 
computer or policy). 

3. The Confirm Policy Enforcement dialog appears. Select the assignments you wish to 
enforce. Press Yes to enforce all of the selected assignments. 

The enforcement action occurs the next time the Client contacts the server. 

Note    To see the most up-to-date compliance states, you may want to refresh the console using 

the  button in the tool bar. 

Automatic Enforcement 

Automatic policy enforcement is set in the Policy Properties dialog. To enable automatic 
enforcement on a policy: 

1. Select the Policies tab. 

2. Select the desired policy. 
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3. On the Edit menu, select Properties (or you can right-click on the selected policy and 
select Properties). The Policy Properties dialog opens. 

4. Check the  next to Automatically Enforce. 

With this option selected, Policy Commander automatically enforces the policy when the Client 
finds that the computer is out of compliance with the policy. If a problem interferes with this policy 
being enforced, the policy and computer are listed with the Not compliant status in the console. 

The Client even continues to enforce its policies when it is not connected to the network (for 
example a laptop user who is traveling). Set the enforcement interval for the Client in the Policy 
Commander tab of the Client Settings dialog. 

Acknowledging an Enforcement 

To help you monitor security activity, Policy Commander uses the Enforced status to highlight 
computers that were recently brought into compliance with a policy. Acknowledging an 
enforcement changes the compliance state of an assignment from Enforced to Compliant. 

To acknowledge a policy assignment that is in the Enforced state: 

1. From the Policy Compliance tab, select the policy assignment that is Enforced ( ). 

2. Right-click and select Acknowledge Enforcement. 

Note    To see the most up-to-date compliance states, you may want to refresh the console using 

the  button in the tool bar. 

Best Practices 

Test, test, test! 

When new security settings are applied, they can interfere with the operation of existing software 
applications and other operations on the target computers. We strongly recommend testing each 
new policy thoroughly in the test environment before moving it to the production environment. 

Set a small group of computers as the test environment through the computer properties. When 
the policy has proven to be compatible with other policies and applications on the test computer, 
it can be moved to the production environment. 
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Internet Capabilities 

Policy Commander's Console and Clients can be configured to communicate with the Prism 
Server over the internet using  HTTP. This feature allows the administrator to run the Console 
from a remote location - from home, on the road, in a hotel, or anywhere that has internet access. 
It allows the channel to manage computers that are distributed across remote locations and 
behind firewalls. The Client can run on laptops disconnected from the corporate network. In fact, 
a laptop can be configured to automatically failover to HTTP/S when it does not have direct 
access to the corporate network. 

HTTP support introduces an additional component to the Policy Commander installation: the NBT 
Proxy Server. The NBT Proxy Server is a small application installed on IIS. The NBT Proxy 
Server accepts HTTP requests from the Console and/or Clients and invokes the Prism Server on 
their behalf. 

To enable Policy Commander's internet capability, follow these steps: 

1. Install the NBT Proxy Server web application on IIS on a machine that can access the 
Prism Server. You can increase security of the communication by enabling SSL (https). 

2. Configure the Console and/or Clients to use the Proxy Server. This is done on the Web 
Proxy Server tab of Console Settings and Client Settings dialogs. 

Installing the NBT Proxy Server 

The NBT Proxy Server is a small application installed on IIS that accepts HTTP requests from 
Clients and invokes the Channel Server. 

Installation steps are as follows: 

1. Identify the IIS machine where the NBT Proxy Server will be installed. 

1. Using the IIS administration console, identify the specific Site where the NBT Proxy 
Server will be installed (e.g., "Default Web Site"). Open the Site's Properties, select 
the ASP.net tab, and verify that the "ASP.NET version" is 2.0 or greater. 

2. If you wish to use HTTPS, enable SSL for the site. Consult IIS help documentation 
for more information. 

Note  It is strongly recommended that SSL be used for increased security. 

2. From the installation folder on the machine where Policy Commander is installed, copy 
the Server\NBTProxyServer.msi file from your Policy Commander installation folder to the 
IIS machine. 

3. Launch the NBTProxyServer.msi file on the IIS machine. 

4. On the Welcome dialog, press Next. 

5. On the Select Installation Address dialog, select the appropriate Site from the 
dropdown. Press Next. 

Caution Please do not change the Virtual directory setting, "NBTProxyServer". This 
value is required by Policy Commander  Clients. 

5. On the Confirm dialog, press Next. This will install NBT Proxy Server application. 

6. On the Installation Complete dialog, press Close. 
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Generating Reports 

Policy Commander reports provide detailed information on the policy status of computers and 
groups in the Channel. After generating a report, you can filter the data, group it by category, or 
set the sort order to refine and rearrange the output. Reports can be viewed on screen for a quick 
summary, exported to a file for further analysis, or formatted and printed directly from the 
Console. 

In addition to the default reports, you can create and save custom reports with the data and views 
you need most often. Your custom reports are added to the tabs on the Reports window after 
being saved. 

Types of Reports 

You can select these types of reports on the Reports menu or by clicking an icon on the toolbar: 

 Administrator Reports: Report on actions taken by the Administrator or other 
users in the Channel. Depending on the specific report you choose, the report may list 
the name of the user, actions taken (computers added, groups set up, permissions 
edited, and so on), target group or computer, and so on. 

 Computer and Group Reports: Report on the computers, servers, and groups in 
the Channel. Depending on the specific report you choose, the report may list the name 
of the computer or group, Client status, IP address of the computer, and so on. 

 Policy Commander Reports: Reports including compliance details, compliance 
history, policy group members reports, and policy properties reports. 

Generate a Report 

To generate a report: 

1. Select a report type using the Reports menu or by clicking one of the report icons in the 
toolbar. 

2. Select a specific report from the resulting menu. 

3. A report window is generated within which you can customize the results, export the 
report to a file, or print the report. 

Print Directly from the Main Window 

To print the contents of the details pane in the main window: 

1. Click in the details pane. 

2. Select one of the following: 

 Click the  icon in the toolbar to open the contents of the details pane in the Print 
Preview window. With this option, you can add a header, footer, and page number to 
the report before printing. 

 Click the  icon in the toolbar to send the contents of the details pane directly to 
your printer. 
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Generated Report Window 

 

When you generate a report, Policy Commander displays the results in a report window. From 
this window, you can update the content of the report with filters, export the report to a file, 
change the layout, or print the report. 

Note: The reports contain a wealth of information and customization options. In addition to sorting 
and filtering the results, you can add or remove fields to customize the report content. 
You can also save your customizations for future use. 

Toolbar 

Use the toolbar icons to format, print, export, or filter the report. For more information, see the 
Report Toolbar. 

Customize the Report 

You have several options for customizing, refining, or filtering the data displayed in the report 
window. For more information, see: 

 Customizing a Report 

 Filtering a Report 

 Grouping the Report Results 

Export the Report 

Export and save the report displayed on-screen in a variety of file formats. To export the report, 
click an export icon in the toolbar or select File | Export on the report window. 

For more information, see Exporting Reports. 
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Print the Report 

 Print: Click the   icon in the toolbar to print the report. 

 Preview: Click the  icon in the toolbar to preview and format the printed report. From 
the Print Preview window, you can add a header or footer to the report. 

Delete the Report 

When you no longer need a custom report, go to the tab that displays the report. Select Edit | 
Delete. 

Report Toolbar 

These icons are available in the toolbar on the main report window. 

Save the current settings for this report. 

Set margins, page orientation, and paper size for the printed report. 

Display a Print Preview. 

Print the report. 

Export to a Microsoft Excel file (.XLS). 

Export to an HTML file. 

Export to a comma-delimited text file (.TXT) 

Export to an XML file. 

Copy the highlighted text to the clipboard. 

Select all of the text in the report. 

Show the filters applied to this report. 

Add fields to the report. 

Let the text wrap in each cell. 

If the report is grouped, expand all of the groups. 

View the online help for the report window. 

Exporting a Report 

The results of any report can be exported to a file for further analysis or included in a document. 

Export formats 

 Microsoft Excel (.XLS) 
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 HTML 

 Text File (.CSV) – comma delimited 

 XML 

Export a Report 

1. After generating the report, click one of the export icons in the Report Toolbar or select 
File | Export To on the Generated Report Window. 

2. Choose a format for saving the report to a file. 

Saving a Report 

After customizing the layout, applying a filter, or making other changes, you can save the 
changes to the current report or save the changes as a new report. 

Note: When you save a report, your saved version is now available in the Channel to all users. 

Save Changes to an Existing Report 

To save changes to an existing report select File | Save. Your changes are applied to the report 
open at the time. Each time this report is opened in the Channel, your customizations are applied. 

Save a Custom Report 

To save the changes as a custom report, select File | Save As. Policy Commander asks for a 
name and description for the new report. 

Your custom report is now listed on the appropriate submenu with the other reports. 

Customizing a Report 

After generating a report, you can customize the layout and content of the report. Use filters, 
group by items, or change the sort order on the Generated Report Window to create a custom 
report. 

Add a Column 

Add columns to the report by clicking the  icon in the toolbar or selecting View | More Fields. 
Policy Commander opens a palette listing the additional fields. Drag an item from this palette onto 
the main window to place a new column. 

Remove a Column 

To remove a column from the report, right-click on the column heading. Choose Remove Field 
from the pop-up list of options. 

Filters 

Use filters to include or exclude specific types of information from the report. The filters are 
displayed in a box in the upper part of the report window. 

For more information, see Filtering a Report. 

Sort Data and Arrange the Layout 

The column headings reflect the types of data in the report. Use the column headings to 
customize the content and layout of the report: 
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 Arrange the columns - Click on a column heading and drag it to a new position. 

 Sort a column - Click on the column heading itself or click the  next to a column 
heading to change the sort order for that column. The sort order for the entire report is 
based on this column. 
 
To sort by two or more columns, right-click on each column heading and select a sort 
order. The sorting priority is based on the arrangement of the columns from left to right. 

 Categorize the data - You can limit the report to a subset of the data or group the data 

by an item: 

 Click the  next to a column heading to display a pop-up list of options for limiting 
the content of the report. For more information, see Filtering a Report. 

 Right-click on the column heading to display a pop-up list of options. From this list, 
change the sort order or group the results. 

 Group the Data - The entire report can be divided into groups based on any of the 
column headings. For more information, see Grouping the Report Results. 

Save the Report 

Your customizations can be saved to the default report or under a new name as a customized 
report. For more information, see Saving a Report. 

Grouping the Report Results 

The entire report can be divided into groups based on the items in a column. This feature is 
useful for reports that contain a large number of records, which you may not want to display all at 
once. For example, generate the Administrator Action report, then group the results by the name 
of the administrator. To view the actions taken by an individual administrator, you can expand 
only that group, without viewing all of the records. 

Group the data in a report 

 Click on a column heading and drag it into the dark-blue bar just above the column 
headings. The report is grouped by the items available in this column. 

 Right-click on a column heading. Select Group by this field from the pop-up list of 
options. 
The report is grouped by the items available in this column. 

Note: When you group the items in a report, right-click on the Group heading to display a drop-
down box that lists the items or categories available in the group. 

Expand or Collapse the Groups 

To expand or collapse all of the groups: 

 Right-click in the shaded area where the group labels are displayed. Choose the Full 
Expand or Full Collapse. 

 Click the  in the toolbar. This toggle expands or collapses all of the groups. 

To expand or collapse one group: 

 Click the + or – next to the group name. 

Clear the grouping 

If groups have been applied to the report, use one of these methods to remove the groups and 
return to simply a list of records. 
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 Right click in the shaded area just above the column headings. Select Clear Grouping 

from the pop-up menu. 

 To remove just one field from the grouping, right-click on a field in the shaded area and 
choose UnGroup. You remove the group for only that field without clearing the other 

groups. 

Filtering a Report 

The actions, items, dates, or other types of information listed in the report can be categorized or 
refined by applying a filter to the generated report. When the report opens, the default filter (if 
applicable) is displayed in the upper part of the report window. The report includes only the 
records that match the criteria you set with the filter. For example, the default Administrator Log 
uses a filter to display only actions taken during the past 60 days. 

Add a Simple Filter 

Add a filter by selecting a category within one of the columns: 

1. Click  next to the label in a column heading. 
 
A drop-down box lists the items or categories available in the column. 

2. Select an item or category to display in the report. 
 
Your selection is now displayed in the Filters box in the upper part of the report window. 
For example, select Add Computer from the list of categories in the Action Type column 
of the Administrator Action Log. The report lists only the computers added to the Channel 
and the Filters box now includes an Action Type filter. 

3. Click the  icon in the filter box to add additional criteria or modify the filter. 

The Filters box is displayed in the report main window when filters have been applied to the 
report. 

 

Change a Filter 

To change a filter, click the  icon next to an item in the filter box. On the Custom Filter dialog 
box, set the criteria for the filter. 

Delete a Filter 

To remove a filter, click the  icon next to an item in the filter box. 

Create a Custom Filter 

Create a custom filter by changing an existing filter or adding a new filter. To set up a custom 
filter: 

1. Click  next to the label in a column heading. 

2. In the drop-down box, select (Custom). 

3. On the Custom Filter dialog box, set the criteria for the filter. 
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Custom Filter dialog 

The options available in the Custom Filter dialog box depend on the type of item selected when 

you opened this dialog box. The Custom Filter dialog box opens when you click the  icon next 

to a filter or when you select (Custom) from the  pop-up list of options from a column heading 
in the report window. 

 Items in the Channel: When you filter on the computers, groups, tasks, or users in the 

Channel the Custom Filter Item dialog box opens. 

 Information related to an Item: When you filter on the date, time, status, action or other 

text, the Custom Filter Information dialog box opens. 

Custom Filter Item dialog 

 

When you filter on the computers, groups, tasks, etc. in the Channel, this dialog box lists the 
names available in the current Channel. 

The Custom Filter dialog box for an item opens when you click the  icon next to a filter or when 

you select (Custom) from the  pop-up list of options from a column heading in the report 
window. 

Show Rows Where 

Filtering can be based on either string comparison or membership by selecting the appropriate 
radio button: 

 String comparison: In the drop-down list, select "starts with", "ends with", or "contains". 
In the text box, enter the comparison text. 

 Membership: In the drop-down list, select a comparison operator. Use this comparison 
to include or exclude items from the report. In the list on the right, select the check boxes 
for items to compare. 

Item Comparison Operators 

When setting up a filter based on an item in the Channel (computer, group, Task, or user), 
choose from these comparison operators: 

 is in 

 is not in 
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 is blank 

 is not blank 

 is like 

 is not like 

Custom Filter Information dialog 

 

When you filter on the date, time, status, action, or other text, this dialog box lets you customize 
the filter based on one or two items. For example, for a date field, select Within the last 60 days 
to view only the most recent records. 

The Custom Filter dialog box opens when you click the  icon next to a filter or when you select 

(Custom) from the  pop-up list of options from a column heading in the report window. 

Category 

In the field on the left, select the data comparison operator to use when filtering the data in the 
report. In the field on the right, enter the value you want to match. 

For example, to filter on the Notepad Task, enter equals in the first field and Notepad in the 
second field. The report will only contain data related to this Task. 

Conjunction 

When setting up a filter based on information such as a date, action, status, and so on, you can 
add additional or contrasting criteria to the report filter. Select a conjunction in the middle of the 
dialog box and enter the second filter in the second row of text boxes. 

 And: The report includes the records that meet both or all sets of criteria set up on this 

dialog box. 

 Or: The report includes the records that meet either or any of the criteria set up on this 

dialog box 

Show Time 

If you are customizing a filter that is applied to a date, the dialog box includes this check box. 

 Show Time: With this option selected, the time is included with the date in the filter. 

Use this option to restrict the report to specific hours. 

 Show Time: With this option cleared, the data is filtered only based on the date. 
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Filter Comparisons for Data 

When setting up a filter based on data such as a date, time, action, status, or other text, choose 
from these comparison operators: 

 equals 

 does not equal 

 is greater than 

 is greater than or equal to 

 is less than 

 is less than or equal to 

 is blank 

 is not blank 

 within last 30 days 

 within last 60 days 

 within last 90 days 

Print Preview 

Printing a Report 

After generating a report, you can print it directly from the report window. Policy Commander also 
provides a print preview and formatting options. 

Print a report 

 Click the  icon to send the report directly to your default printer. 

 Click the  icon to preview the report before printing it. 

Format a report 

To set the page size, margins, or page orientation click the  icon on the Generated Report 
Window or select File | Page Setup. 

To add a report name, the date, page numbers, or the current username to the report header or 
footer: 

1. Click the  icon to preview the report. 

2. On the Print Preview window, click the  icon. 

3. On the Report Properties dialog box, set up the header and footer for the document. 

4. Click OK to view the changes on the print preview window. 

Print Preview 

The Print Preview window shows how the report will look when it is printed. From this window, 
you can also add a header or footer and change the page setup before printing. This window 

opens when you click the  on the generated report window. 
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Toolbar 

Use the icons in the toolbar to add a header or footer, send the report to the printer, or view the 
report. The icons include: 

Add a header or footer to the report. 

Print the report. 

Set up the page size and layout. 

  

Switch between Actual Size and Fit in Window views with a mouse click. 

Zoom out. 

Zoom in. 

Set the zoom percentage. 

  

Go to the first page of the report. 

Go to the previous page of the report. 

Go to the next page of the report. 

Go to the last page of the report. 

  

Close the Print Preview window. 
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Report Properties dialog 

 

On the Report Properties dialog box, add a header or footer to the printed report. This dialog box 

opens when you click the  icon on the print preview window. 

Toolbar 

Icons on this window include: 

Insert the page number 

Insert the number of pages in the report. 

Insert the date when the report is printed. 

Insert the time when the report is printed. 

Insert the name of the user currently logged into the Console. 

Insert the name of the report. 

Header/Footer 

Use the text boxes to place text and an image in the left, center, or right section of the header or 
footer. 

 Font: Click the Font button to change the font used for the header or footer on the report. 

 Image: Click the Image button to browse for an image file to include in the header or 

footer. 

 Report label: Click in a text box and type a report name or other text. 
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 Page number, date, and so on: Click an icon in the toolbar to insert the page number, 

date, or other information automatically. 

Show Filters 

Indicate whether to display the filters that are applied to the report. 

 Show Filters: With this option selected, the filter box from the main report window is 

printed on the first page of the report. 

 Show Filters: With this option turned off, the filter box is not included in the printed 

report. 

Printing Options dialog 

When printing from Policy Commander, you are prompted to select a default printer and set 
printing options. 

 From the drop down list to the right of the Name: field, select the printer where you wish 
to print the content. You will see a list of the installed printers available from your 
computer. Details on the printer are displayed once you select the printer. 

 Select the Properties button to define additional printing options based on the type of 
printer you selected in the Name: drop down list. 

 Select the Print to File option if you wish to have the print job directed to a file rather 
than sent to the printer. When you print to file, the file is generated using the language of 
the printer selected. Install a "Generic / Text Only" printer if you wish to be able to read 
the text written to the file. 

 Enter the number of copies you wish to print in the text box to the right of Number of 
Copies:. 

Other options displayed in this dialog box may be unavailable if they do not pertain to this printing 
request. 
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Managing the Channel Server 

Overview of the New Boundary Channel Manager 

The Channel Manager provides an interface for you to work with the New Boundary Channel 
Server. Use this application, which is available through the Windows taskbar, for these actions: 

 Secure the creation of new Channels 

 Add or remove the names of users who have permission to create Channels 

 Start or stop the Channel Server 

 Connect Channels to the Channel Server after they were disconnected by un-installing 
the Channel Server or removed through the Policy Commander Console. 

Note: The Channel Server application is used by these New Boundary Technologies products—
Prism Suite, Prism Deploy, Policy Commander, and PwrSmart. However, these products 
use separate installations of the Channel Server and separate Channels. 

Opening the Channel Manager 

The Channel Manager opens from the Windows taskbar on the computer where the Channel 
Server is installed. 

Open the Channel Manager 

To open the Channel Manager, right-click on the  icon in the Windows taskbar. 

Channel Manager Options 

These options are available on the pop-up menu: 

 Stop Channel Server: Stop or shutdown the Channel Server. 
 
Generally, you will not use this option unless there is a problem with the computer where 
the Channel Server is installed. The Channel Server must be running for Clients to 
receive changes from the Prism Console, receive security settings from Policy 
Commander, power schemes from PwrSmart, or provide updates to the Channel. 

 Start Channel Server: Start the Channel Server if it has been stopped. 

 Configure Security: Secure the creation of Channels and control the list of users who 
are permitted to create Channels. Use this option to limit the people who can create 
channels, and add names passwords to assign this privilege. 
 
When you select this option, the Channel Management Security dialog box opens. 

Note: Securing access to a specific Channel is controlled through the Console. See 
"Overview of Channel Security" in the Console Guide or Console online Help. 

 Connect Channel: Connect an existing Channel database to the Channel Server. For 
example, reconnect a Channel database that was removed through the Policy 
Commander Console. Or, reconnect a database that was managed by another Channel 
Server which has since been un-installed (referred to as an "orphaned Channel). 
 
When you select this option, the Connect to Channel dialog box opens. (See Connect to 
Channel for important notes on connecting a Channel.) 
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 Exit: Close the Channel Manager menu. This selection does not affect the Channel 

Server. 

Channel Management Security dialog 

 

On this dialog box, secure the creation of new Channels on this Channel Server. This dialog box 
opens when you select Configure Security from the Channel Manager pop-up menu. 

Options include: 

Secure this Channel Server: With this option selected, only the users listed on this dialog 
box have permission to set up new Channels on this installation of the Channel Server. 
Creation of new Channels is password protected. 
When this option is set, it cannot be reversed. 

Secure this Channel Server: With this option cleared, the creation of Channels is not 
restricted. 

Note: Securing access to a specific Channel is controlled through the Console. See 
"Channel Security" in the Console Guide or Console online Help. 

When you select the Secure this Channel Server check box, these options are available: 

Add 

Add a user to the list of people who can create Channels. Each time this user sets up a new 
Channel, they must enter the username and password assigned here. The Manage User dialog 
box opens. 

Each of the users listed is given Channel Admin privileges, which lets them create Channels, add 
or delete users from the Channel Manager, and change passwords. 
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Delete 

Delete the highlighted name from the list of users. Once deleted, this person cannot create new 
Channels. 

Password 

Change the password for the selected user. The Manage User dialog box opens. 

Manage User dialog 

 

On the Manage User dialog box: 

 Add the username or login for a person who is being given permission to create 
Channels. 

 Change a user’s password. 

This dialog box opens when you click the Add button on the Channel Management Security 
dialog box. 

The options include: 

 User Name: The username or login for the person whose information is being updated. 
The name is assigned by the administrator who is adding the name. It does not have to 
match the person’s network login or other username. 
 
This user enters their user name and password when creating a new Channel. 

 Role: The role assigned to the user. By default, everyone is assigned the Channel Admin 
role through the Channel Manager. 
 
Roles with specific permissions for accessing or modifying data, targets, or Tasks within 
a Channel are set up for a specific Channel within the Console. 

 Password: Enter the password this user will enter when creating a Channel. 

 Confirm password: Retype the new password to confirm it. 
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Channel Connection Wizard - Authentication dialog 

 

Indicate the mode you want to use when connecting to the SQL Server database that stores 
Channel information. You should select the same option you used during installation. This dialog 
box is part of the Connect Channel wizard in the Channel Server. 

The options include: 

 Windows Authentication 

 SQL Server Login 

Connect to Channel dialog 

On this dialog box, select the name of the Channel database that you want to connect to this 
Channel Server. After you select the database and complete the dialog boxes in this Wizard, the 
Channel is displayed in the list of Channels available through this Channel Server. 

This dialog box opens when you select Connect Channel from the Channel Manager pop-up 
menu. 

Connect a Channel to the Channel Server 

Click the  to select the name from a list of available Channels. 

Establish Client Connection to Channel 

In most cases, you should set the computers in this Channel to subscribe to the Channel after 
connecting it to the Channel Server. 

 Policy Commander: To set up the Client subscription, install the Client software on each 

target computer. 
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Console Error Messages 

Messages 0 to 1000 

0: The operation succeeded 

100: An unknown error occurred (Alert) 

300: The channel is corrupt. (Alert) 

800: The computer does not exist in the channel (Alert) 

1000: The task has already been performed (Ignore) 

Messages 1100 to 1900 

1100: The task has been performed after the specified time (Ignore) 

1200: The task has not been performed after the specified time (Ignore) 

1300: The time scheduled has not arrived yet (Ignore) 

1400: The task’s command or file name could not be resolved (Alert) 

1500: The task required a file in use for another operation (Alert) 

1600: The task requires a file that does not exist (Alert) 

1700: The file could not be overwritten (Alert) 

1800: A file required by the task is in use by another process (Alert) 

1900: A file required by the task is in use by another process (Alert) 

Messages 2000 to 2900 

2000: An error occurred executing the task (Alert) 

2100: The user cancelled the operation (Caution) 

2200: The user declined to execute the task (Caution) 

2300: The operating system is not correct for this task (Ignore) 

2400: There was not enough disk space to execute the task (Alert) 

2500: A variable required by the task was not in the correct format (Alert) 

2600: A variable could not be resolved to an existing file or folder name (Alert) 

2700: A variable could not be resolved (Alert) 

2800: Insufficient environment space (Alert) 

2900: The user declined to specify a required variable value (Caution) 

Messages 3000 to 3900 

3100: The computer is disabled (Caution) 

3200: The task is disabled (Caution) 

3300: The computer is not licensed (Caution) 

3600: A file required to remove the software is missing. (Alert) 

3700: There are insufficient rights to access the file. (Alert) 

3800: An invalid command was encountered. (Alert) 
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3900: An attempt was made to play a script recursively. (Alert) 

Messages 4000 to 4900 

4000: The Policy Commander service could not be installed and/or started. (Alert) 

4100: The file is not in the expected format. (Alert) 

4200: The file was created by a later version of the software than the one running. (Alert) 

4300: Installation was cancelled by the administrator. (Ignore) 

4400: An unexpected internet error occurred accessing the file. (Alert) 

4500: An internet communications error occurred accessing the file. (Alert) 

4600: The credentials passed to the server do not match the credentials required to log on to the 
server. (Alert) 

4700: The Internet server name or address could not be resolved. (Alert) 

4800: The computer does not have the required internet support. (Alert) 

4900: The format of the specified internet address is not valid (Alert) 

Messages 5000 to 5900 

5000: Logon failed. (Alert) 

5100: The task information is corrupt. (Alert) 

5200: The command could not be executed. (Alert) 

5300: "The ""Start In"" folder is invalid." (Alert) 

5400: "The task does not have an ""uninstall"" command." (Alert) 

5500: The package has a variable requiring user input in unattended mode. (Alert) 

5600: Deleted computer contacted channel. (Alert) 

5700: File installation rule conditions not met. (Alert) 

5800: Client upgrade needed to execute task. (Alert) 

5900: Package digital signature authentication failed. (Alert) 

Messages 6000 to 6200 

6000: The connection was dropped while accessing the remote package. Restart will be 
attempted. (Caution) 

6100: Distributed file does not exist. (Caution) 

6200: Windows Installer error. (Caution) 
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Glossary 

Channel 

A Channel is a hierarchical list of targets (computers and groups in your organization) and 
policies (and groups of policies) and it is a vehicle for assigning policies.  

Client 

The Client is an application that resides on target computers and provides the vehicle for 
enforcing policies. The executable file PTCLIENT.EXE is used to run the Client software. 

When used with Policy Commander, the Client provides information to the Console about the 
target computer, its users, and licensing.  

Computer 

Computers are workstations or servers with the appropriate type of Policy Commander license 
assigned and the Policy Commander Client installed. Computers are added to a Channel 
manually or automatically. Once the computers are in place, they are ready to be inventoried and 
managed. 

When a computer is disabled through the Properties | General tab, the icon is grayed. Tasks 
are not installed on a disabled computer. Use this feature when you want to temporarily remove 
an item while you solve a problem. After resolving the problem, bring the computer back on-line 
by turning off the Disable option on the Properties | General tab. 

current user 

The current user is either the person currently logged on to the computer or the default user, if no 
one is logged on. 

Group 

Groups in a Policy Commander Channel let you categorize computers with similar requirements 
or environments, and then rapidly assign policies designed specifically for the group. Rather than 
searching out and assigning policies to individual computers, set up a group of related members 
and assign a policy to the group as a whole. The policy is installed for each member of the group, 
at the same time. 
 
Networks that use Active Directory (AD) or NetWare Directory Services (NDS) use groups to 
differentiate these names. For example, two employees are named JConrad. By placing them in 
separate groups, the network and your Channel see each as a unique individual. For example, 
the identifiers in the network and in your Channel would be JConrad.Sales.US (in the Sales 
group, within the US group) and JConrad.Marketing.US (in the Marketing group, within the US 
group). With Auto-Populate options turned on for the Channel, these groups are added 
automatically. 

Organizational Groups 

Use organizational groups to reflect the structure of your organization. These groups are 
generally populated manually, except on networks that have Active Directory (AD). 



Policy Commander 

156 

Networks that have Active Directory (AD) use groups to differentiate similar names. For example, 
two employees are named JConrad. By placing them in separate groups, the network and the 
Channel see each as a unique individual. The identifiers in the network and in the Channel would 
be JConrad.Sales.local (in the Sales group, within the local group) and JConrad.Marketing.local 
(in the Marketing group, within the local group). With auto-populate enabled on the Channel 
Properties Settings tab turned on for the Channel, these groups are added . 

Task 

Tasks in a Prism Channel are Prism files, scripts, and commands that you plan to execute or 
install on target computers. To distribute the software or update settings contained within a Task, 
assign the Task to one of the targets (User, computer, Container, or Group) by dragging and 
dropping or using the scheduling feature. Set the time for distribution and you are finished. 
 
Tasks can be added at any time and scheduled for installation immediately or at a future time. 

User-defined Group 

User-defined groups offer the greatest flexibility. User-defined groups let you identify one or more 
criteria for selecting members and offer a variety of methods of comparison. 

For example, create a User-defined group to identify target computers running a specific 
operating system that do not have a specific service pack installed. After creating this group, set 
up a Task containing the service pack. Assign the Task to the new group created by your rule and 
install this missing service pack. 
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